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Introduction to Computer 
 

Definition 

 Computer is an electronic device that can receive a set of instructions or program or any 

other information.  It stores and processes the data, and produces the output.  It works under the 

direction of a detailed stored program of instruction. 
 
History of Computer 
 

Name of Device / 
Machine invented 

Year of invention 
Name of the 

Inventor 
Specialty 

Abacus 5000 years ago Ancient Babylonians 
First manual device for 
adding numbers 

Slide Rule 1620 William Oughtred 
A device used by engineers 
to perform arithmetic 
operations upto 1970‘s  

Arithmetic Engine 1642 Blaise Pascal 

First mechanical device to 
do arithmetic operations 
made with gears, wheels 
and dials 

Difference Engine 1822 Charles Babbage 

A machine which calculated 
successive difference of 
expressions and evaluated 
expressions like X

2
+5X+3 

Analytical Engine 1833 Charles Babbage 

The arrangement of units in 
this machine (store, mill 
control, input, output) is 
much similar to the 
arrangement of units in 
modern computers. But this 
machine had failed to work. 

Tabulating 
Machine 

1880 Herman Hollerith 

Designed to process 
census data of US 
Government. It has read the 
data stored on punched 
cards. 

Electronic 
Computer ENIAC 
(Electronic 
Numeric Integrator 
And Calculator) 

1946 

Prof. J.P. Eckert,            
Prof. J.W. Mauchly, 
University of 
Pennsylvania 

It is designed by large 
number of Vacuum Tubes. 
The speed of calculation 
was 300 times faster than 
previous machines. But it 
was unreliable 
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Contributions of Pascal, Charles Babbage, Lady Ada Lovelace and John Von Neumann  

Blaise Pascal  

He was a French Mathematician. He invented the arithmetic engine, 

which is a basis for calculators. He used gear wheels and suitable dialing 

system to operate the gear wheels in his calculators. 

 

      

    Abacus       Arithmetic Engine 

          

Difference Engine   ENIAC Computer 

 

Charles Babbage 

 Charles Babbage, Father of Computer Science, invented the Difference 

Engine and Analytical Engine.  He introduced the concept of Block Diagram which 

we are using now. 
 

Lady Ada Lovelace 

 She was a Mathematician. She was the first lady who told that 

computers can be programmed so, she is called as the First Programmer. A 

programming language ADA is widely used in Americans defense Computers. 

 

John Von Neumann 

 He was a Hungarian Mathematician. He introduced the concept of stored 

program. The instructions given to the computer are first stored in memory they 

are then extracted from memory and executed one by one. 
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Generations of Computer 

Generation Components Used Period 

First Generation Vacuum Tubes 1946 – 55 

Second Generation Transistors 1956 – 65 

Third Generation Integrated Circuits 1966 – 75 

Fourth Generation Very Large Scale Integrated Circuits 1976 – 85 

Fifth Generation Very Large Scale Integrated Circuits 1986 – till date 

              

 Vacuum Tubes Transistors     Integrated Chips  Processor 

 

Applications of Computer 

 A computer has high speed of calculation, diligence, accuracy, reliability or versatility 

which made it an integrated part in all activities.  The speed of the computer varies based on the 

various field of work like, Education, Hospitals, Telecommunication, Defense, Satellite & 

Research, Military, Business, Banking, Insurance, Government and Private Organisations. 

 

Advantages of Computer 

 The Modern world is more dependent on Computer because of the following reasons:              

1. saves the time by quick performance; 2. reduces the intellectual strain; 3. avoids Mistakes;                 

4. gets the output in a neat printed form; 5. stores data easily; and 6. for easy communication. 

 

Terms related to Computer 

BIOS (Basic Input and Output System): Responsible for handling particulars of input / 

output operations. 

 ASCII (American Standard Code for Information Interchange): A standard coding system 

for computers. 

 Binary: A selection, choice or condition involving two possibilities.  The Computer 

functions on binary basis (0, 1) 

 BIT (Binary digIT): It is the smallest unit of data in a computer.  It stands for either 0 or 1.   
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 Boot: The initial loading of an Operating System / Programs into a computer.   

 Buffer: A device or storage area where data are temporarily stored. 

 Backup: Alternate facilities of programs, data files, etc. used in case the original one is 

destroyed, lost, or failed to operate. 

 CRT (Cathode Ray Tube): An electronic tube with a TV like screen upon which 

information may be displayed. 

 LCD (Liquid Crystal Display):  It is a flat panel electronic video display that uses the light 

modulating properties of liquid crystals. 

 LED (Light Emitting Diode): It is same as LCD but which uses an array of light-emitting 

diodes as pixels for a video display. 

 Data: A collection of fact in raw form that become information after proper processing. 

 

Characteristics of Computers 

Speed  

 Computer is an Electronic Machine, so we can compare its speed with the speed of 

electrons. The time required to execute a basic operation (like addition, subtraction, etc.) is 

known as the speed. Small computers take a few microseconds (10
-6

 seconds) to execute a 

basic operation. Large computers take only a few nanoseconds (10
-9

 seconds) for the same.  
 

Storage 

 We store data, instructions and computer programs in memory. Instructions in a program 

are executed one by one at a very great speed. The results are also stored in memory. The data 

instructions and programs stored in memory can be got back any time we want. Computers also 

support storing of data and instructions in secondary memories like floppy or hard disks.  
 

Versatility 

 Computer is a versatile tool. It means that we can use the computers for business, 

scientific or any other applications. A computer does a lot of wonderful works with its basic 

capabilities (like arithmetic, logical comparisons, move data). Hence, we call it a versatile tool. 
 

Diligence 

 Computers can work for long hours without getting tired. If a computer has to do 10 

million calculations, it will do all of them with the same speed and accuracy. 
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Automation 

 The ability of the computers to automatically do the given work (without human help) is 

called automation.  
 

Accuracy 

 Computers are 100% accurate. They do not make mistakes. If the result is wrong then it 

will be only because of the programmer or user.  

 
Hardware and Software 

 Hardware refers to the physical parts of the computer. Hardware are the parts of 

computer itself, including the Central Processing Unit (CPU), Memory, Keyboard, Monitor, Case 

and Drives (Floppy, Hard disk, CD, DVD, optical, tape, etc.). Other extra parts, called peripheral 

components or devices; include printers, modems, scanners, digital cameras and card (sound, 

color, and video) etc. 

 Software refers to the computer programs. These programs are used to run and control 

the hardware. Programs are also called Software. These programming instructions cause the 

computer to perform arithmetic and logical operations or comparisons. Example: All user 

programs and programs supplied by software agencies. 
 

Relationship between Hardware and software 

 To use a computer, we must have both hardware and software. Software is to hardware 

as what fuel is to a motor car. Hardware without software is powerless. Software without 

hardware is useless. 
 
Block diagram of a digital computer 

Input Unit 

 The purpose of the input unit is to get data and instructions from the user and transmit 

them into computer memory. Examples:  Keyboard, Mouse, Scanner, Joystick 

Central Processing Unit (CPU) 

 The CPU is the heart of a computer. It consists of Memory unit, Arithmetic and Logic Unit 

and Control Unit. 
 

Memory Unit 

 This unit stores the data and instructions. The intermediate and final results of a program 

are also stored in memory. A program can be executed (run) only when it is brought to main 

memory. 
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Arithmetic Logic Unit (ALU) 

 It does all arithmetic (addition, subtraction, multiplication, division) and logical operations 

(comparison of data). It also stores the results of intermediate calculations. 

 

 

Control Unit (CU) 

It is the supervisor of all the other units. The main functions are  

1. Give commands to transfer data from the input device to the memory and from 

memory to the ALU. 

2. Transfer the results from memory to the output device. 

3. Store the program in memory. Take instructions one by one from memory, 

understand and give commands to other units. 

Output Unit 

 The purpose of the output unit is to get the output results from the memory, and give it to 

the user in human readable form. 

Examples: Monitor, Printers, Plotters, VDU (Visual Display Unit) 

 

 

Auxiliary Memory 

Main Memory 

Arithmetic and 

Logic Unit 

Control Unit 

Input      

Unit 

Output  

Unit 

Data Flow 

Control Flow 

Fig. Block diagram of a Digital Computer 
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Working Principles of Computer 

Computer Types 

 Computers are classified on the basis of working and size. 

  

Classification of computers based on the basis of working 

Analog Computer  

 A computer that operates by measuring continuously varying quantities like voltage and 

current is called Analog Computer. 

Examples: Thermometer, Slide rule, Dial gauge 

Digital Computers 

 A computer that operates by counting is called a Digital Computer. 

Examples: Digital Watches, Personal Computers. 

Hybrid Computers 

 They are a combination of both analog and digital computers. 

Examples: Computers used for process controls. 

1. Computers used for control of space vehicles. 

2. Fighter aircrafts. 
 

Difference between Analog and Digital Computers 

 

Sl. 
No. 

Analog Computers Digital Computers 

1. Operates by measuring continuously  
varying quantities like voltage and 
current 

Operates by counting 

2. Less accuracy More accuracy 

3. Limited Applications Vast applications 

4. Limited memory Vast memory 

5. Gives results in graphical form  Gives results in discrete from  

6. Cannot process alpha-numeric 
information 

Can process alpha-numeric information 
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Classification of Computers on the basis of Size 

Micro Computer (PC – Personal Computer) 

 It is a single user computer system having moderately powerful, small, inexpensive 

microprocessor designed for an individual user. Businesses use personal computers for word 

processing, accounting, and desktop publishing and for running spreadsheet and database 

management applications. At home, the most popular use for personal computers is playing 

games and surfing internet. 

 
Workstation 

 It is also a single user computer system which is similar to personal computer but have 

more powerful microprocessor. This is used for engineering applications (CAD / CAM), Desktop 

Publishing, Software Development and other such types of applications which require a 

moderate amount computing power and relatively high quality graphics capabilities. 

 
Mini Computer 

 Minicomputer is a multiuser computer system which is capable of supporting upto 250 

users simultaneously.  

 
Mainframe Computer 

 Mainframe is very large in size and is an expensive computer capable of supporting 

hundreds or even thousands of users simultaneously.  Mainframe executes many programs 

concurrently and supports many simultaneous execution of program. 

 
Super Computer 

 Super Computer is an extremely fast computer which can execute hundreds of millions 

of instructions per second. This is one of the fastest computers currently available.  

Supercomputers are very expensive and are employed for specialized applications that require 

immense amount of mathematical calculations.  Example: Weather Forecasting, Scientific 

Research, Electronic Design and analysis of Geological data. 

 
Desktop Computer 

A desktop computer is same as a personal computer but the computer is located on a 

desk / table due to its size and power requirements. This is used for Desktop Publishing works, 

Official and Commercial works, etc. 
 
 

https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Mains_electricity
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Laptop Computer  

 Laptop computers have an L-shape design and the screen can be lowered and closed to 

allow easy transportation of the machine.  The primary feature that attracts users to laptops over 

desktops is their portability.  Laptop computers provide users the ability to run the machine using 

an internal battery or an outside power adaptor. 
 

Palmtop Computer  

 A computer which is small enough to hold in one hand and operate with other is called 

as ―handtop‖ or ―palmtop‖ which has small keyboards or specialized keypads tailored to specific 

industries. Example: Tablet. 

 

Basic ideas of Personal Computers 

Personal Computers (PC) 

PC means Personal Computers. The I/O devices connected to a PC are normally a 

keyboard, Visual Display Unit, Mouse and a Printer. PCs are used in banks, offices, homes, 

business and other organizations. 
 

PC-XT 

PC-XT means Personal Computer – Extended Technology 

1. The Processor is 8088. 

2. Floppy Disk Drive – 1 No. 

3. RAM size is 640 KB. 

4. Hard Disk Drive – 1 No. 

PC-XTs are used in banks, offices, homes, business and other organizations. 
 

PC-AT 

PC-AT means Personal Computer – Advanced Technology 

1. The Processors are: 80286, 80386, 80486, Pentium-I, Pentium-II, Pentium-III,                

Pentium-IV, Dual Core, Core2Duo, i3, i5, i7, etc. 

2. RAM size varies from 16 MB to 8GB depending upon the processor.  

3. It supports both Floppy and Hard Disk Drive. 

4. Speed is higher than that of PC-XT.  

Most of the computers used in homes, banks, offices, industries, business and other 

organizations today are PC-ATs only. 
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MEMORY 

Units of Measurements of Memory  

Bit 

 Bit means Binary digit. It is either the digit 0 (OFF state) or the digit 1 (ON state). Data 

and instructions are stored in memory as a combination of 0‘s and 1‘s. 
 

Byte 

 A byte is a group of 8 bits. 

Example  

1) 1000 1001 is a byte. 

2) 0011 0011 is a byte. 
 
Word 

 A word is a group of bytes. Small computers use a word length of 8, 16, 32 or 48 bits. 

High speed computers use a word length of 64 bits or more. 
 

1 character   = 2 bit 

4 bits    = Nipple 

8 bits   = 1 byte 

1024 bytes  = 1 Kilobyte (KB) 

1024 Kilobytes  = 1 Megabyte (MB) 

1024 Megabytes = 1 Gigabyte (GB) 

1024 Gigabytes  = 1 Terabyte (TB) 

1024 Terabytes  = 1 Petabyte (PB) 

 

Memory Types 

Primary Memory/Main Memory 

 The memory unit of a computer is called primary memory or main memory. Data, 

instructions and programs are stored in this memory in binary form. Information stored in this 

memory can be erased and rewritten. Information stored in main memory is directly processed by 

the computer at a very great speed. It is a volatile memory. The memory capacity is limited. 
 
RAM 

 RAM means Random Access Memory. It is also known as read and write memory. 

Information stored in this memory can be erased and rewritten. It is a volatile memory i.e., 

Information stored in this memory is lost when the power goes off. 
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ROM  

 ROM means Read Only Memory. It is a non-volatile memory i.e., Information stored in 

the memory is not lost when the power goes off. Writing into ROM is done only once (at the time 

of manufacturing). We cannot write information in this memory. 

PROM  

 PROM means Programmable Read Only Memory. ROM is programmed by the 

manufacturer. But, PROM can be programmed by any user using ―PROM Programmer‖ device. 

After PROM is programmed, we can only read information. 

EPROM  

 EPROM means Erasable Programmable Read Only Memory. Unlike ROM and PROM 

information stored in this memory can be erased and rewritten. Erasing is done by exposing to 

ultra violet light for about 20 minutes. After EPROM is programmed, we can only read 

information. 

EEPROM 

 EEPROM means Electrically Erasable Programmable Read Only Memory. Information 

stored in this memory can be erased electrically and rewritten. After EEPROM is programmed, 

we can only read information. 

DDR 

Double data rate synchronous dynamic random-access memory is a class of memory 

integrated circuits used in computers. DDR SDRAM, also called DDR1 SDRAM, has been 

superseded by DDR2 SDRAM, DDR3 SDRAM and DDR4 SDRAM. 
 
Secondary Memory 

 The primary memory of a computer is limited and also volatile. So, we need secondary 

memories like floppy disk or hard disk. We can store large amount of information in secondary 

memory. Information stored in this memory is permanent. They can be got back any time. 

Differences between Primary and Secondary memory 

SI.No Primary Memory Secondary Memory 

1. Limited Memory Vast/Large memory 

2. 
Volatile (Information are lost when 
the power goes off) 

Non-volatile (Information are not lost 
when the power goes off) 

3. Made from semi-conductor memories Made from magnetic materials 

4. Cost is high Cost is low 
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Hard Disks 

A hard disk is a fixed disk completely sealed in an air-tight, dust free container. A hard 

disk consists of a number of disks packed together and mounted on a common shaft. Disks are 

coated on both sides with magnetic material. A disk pack having 6 plates will have 10 recording 

surfaces. (The top surface of the top disk and bottom surface of the bottom disk are not used. 

There are movable read/ write heads for each surface). 

Reading/Writing Operation 

 The common shaft is rotated at the speed of 4,000 to 15,000 revolutions (or more) per 

minute. The read/write heads are positioned over a particular track on all surfaces. A set of 

corresponding tracks in all the sides form a cylinder. When an information is stored, the cylinder 

number, the surface number are noted. 

Typical hard disk storage capacities 

  1.2 GB  2.1 GB 

  4 GB  8 GB 

  10 GB  13 GB 

  17 GB  20 GB 

  40 GB  80 GB 

  160 GB  250 GB 

  500 GB  1 TB 

 
 

SURFACE 0 

SURFACE 1 

SURFACE 4 

SURFACE 6 

SURFACE 8 

Lower surface Not used 

SURFACE 2 

SURFACE 3 

SURFACE 5 

SURFACE 7 

SURFACE 9 

CENTRAL SHAFT 

ONE READ/WRITE 
HEAD PER SURFACE 

DIRECTION OF ARM 
MOVEMENT 

MOVABLE 
ACCESS 

ARMS 
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Advantages of Hard disks 

1. We can store large amount of information. 

2. Access speed is high. 

3. Storage is permanent. 

4. Cost is low. 
 

Floppy Disk 

 Floppy disks are flexible plastic diskettes coated with magnetic oxides. A floppy disk is 

kept inside a jacket (cover). The cover protects the floppy from any dust particles. A floppy is 

divided into a number of concentric circles called tracks. Each track is divided into equal number 

of sectors. 

 

Reading from/Writing into a floppy 

 This is done through the read-write slot. The floppy is inserted into a disk drive. The drive 

rotates the floppy at a very great speed (200 to 300 revolutions per second). During rotation, 

information is stored in tracks as magnetic spots. A read/write head in contact with the floppy 

senses the information and sends it to the computer as pulses. 

Index-hole 

 It tells the beginning address of the first sector of a track. 

Write- protect notch 

 When it is covered, we cannot write information on a floppy. 
 

Advantages of Floppy disks 

1. We can store large amount of information. 

2. Information can be got back any time. 

3. Portable (we can take a floppy from one place to another place). 
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CD-ROM 

 CD-ROM means Compact Disk Read Only Memory. The 

disk is compact so that we can store as much of information as can 

be stored in 450 Micro floppies. The storage capacity of a CD-ROM 

is 700 MB. The thickness of the disk is 1.2 mm and diameter is 120 

mm. Today, games and software programs are supplied in CDs 

only. We can also use CDs for audio-recording. 

 
Organization 

 The disk is made up of a resin such as polycarbonate. It is coated with a material like 

aluminum. 

 Information is written into a CD-ROM by using a high power laser beam. The laser beam 

is used to burn tiny holes called bits on a spinning disk. The tiny pit represents ―l ―and the surface 

without a pit ―0‖ is known as land. 

 Information is read from a CD-ROM using a low power laser beam. The reflected light 

from pits and lands (which will be different) is sensed by a ―photo diode‖ for converting into 

electrical signals. 

 
DVD (Digital Video Disk) 

 DVD is a type of compact disc that can store large amounts of data, especially high-

resolution audio visual material. Its storage capacity is 4.7GB.  

Blu-ray disc 

Blu-ray disc is a digital optical disc data storage format. Blu-ray discs have an advantage 

over DVDs of storing high definition video resolution. The Blu-ray discs are named so because of 

their underlying technology, which uses a blue-violet laser to read and write data.  Blu-ray discs 

have a wide range of formats which include the following  

 BD-ROM: Read only format of Blu-ray. 

 BD-R  : Recordable format of Blu-ray. 

 BD-RE  : Rewritable format of Blu-ray.  

Recording capability of a DVD or CD on a Blu-ray disc is dependent on the 

manufacturer‘s choice. A DVD player cannot read a Blu-ray disc, since it uses red laser to read 

the information from the disc, rather than a blue laser.  
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Pen Drive 

A pen drive or a USB flash drive is a portable data-storage device which replaced the 

floppy drives. And now it is the most popular data-storage devices among consumers. This can 

be easily carried from place to place by students, professionals, etc. Its storage capacities vary 

from 2GB to 32GB and using this we can store large documents, photos, music files and video 

clips. 
 

Zip disk 

Zip drive is a medium-capacity floppy disk drive developed by 

Lomega Corporation. At first zip disks had capacities of MB, but later 

versions were increased to first 250MB and then to 750MB.  This 

portable disk drive is primarily used for backing up and archiving 

personal computer files.  
 

 
CENTRAL PROCESSING UNIT (CPU) 

Components of CPU 

 Of all the devices, CPU is an important device that is responsible for the computer to 

perform various tasks.  It is to be mentioned that CPU is not a single device rather the following 

components, when assembled perfectly, build up CPU: 

Motherboard, Hard disk, RAM, ROM, Processor, SMPS, Connecting Wire, Graphics 

Card, Sound Card, Network Card and Modem.  

Input & Output Devices 

Input Devices 

 Input Devices are used to get data, instruction and programs from the user and store 

them in computer memory in binary form. 
 

Keyboard  

 It is an input device. It gets data, instruction from the 

user and stores them in computer memory. When a key is 

pressed, it generates an ASCII code (American Standard 

Code for Information Interchange). This code is transmitted 

into the computer.      

 It looks like a typewriter. It has alphabet keys, numeric keys, special character keys, 

function keys and control keys. It usually has 101 keys. Using keyboard, we can enter data and 

instructions quickly into the computer. 
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Joystick 

 
Pendrive 

 
Mouse 

Mouse 

 It is an input device. It has two or three buttons. It usually rolls 

on a bearing. When it is moved across a flat surface, the cursor on the 

VDU moves. It is easier for non-typists. 

 When the mouse is moved, the small ball kept under the 

mouse is rolled. The movement of the ball is converted into electrical 

signals and sent to the computer. Mouse is very important for Windows 

and other GUI (Graphical User Interface) applications. Nowadays optical mouse is used.                          
  

Scanner 

Scanners allow us to transfer pictures and photographs to our 

computer.  A scanner ‗scans‘ the image from the top to the bottom, 

one line at a time, and transfers it to the computer as a series of bits 

or a bitmap. 

 
Digital Camera 

A digital camera records and it stores photos in digital form. The 

images are stored on a memory chop or disk that can be transferred to our 

computer. Many current models are also able to capture sound or video, in 

addition to still images.  
 

Joystick 

 Joystick is an Input device which is used as a navigation control 

while playing games.  

 

Pen drive 

 Pen drive is a portable storage device which is available at 

various sizes.  

 
 

Output Devices 

 Output Devices are used to get the output from the computer memory and give them to 

the user in human readable form. 
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 
 
 
 
 
 
                     

 

Laser Printer 

Monitor 

 Monitor is an output device which provides visual display of data.  

This helps to correct wrong entries. It also shows the results of programs. In 

olden times we used monitors with Cathode Ray Tube (CRT). But now we are 

using LCD (Liquid Crystal Display) and LED (Light Emitting Diode) Monitors.  

 Though, CRT monitors were used initially around 1950s, power consumption by CRT 

monitors was relatively higher, than by the monitors that we are using today.  Considering this, 

various developments were made on monitors, which led to the birth of LCD & LED monitors, 

both of which consume less power than CRT monitors & LED being the least consuming. 
 

Printers 

 Printer is an output device which is mainly used to take text or images in the paper. 

Various types of printers are available they are: Dot Matrix Printer, Laser Printer and Inkjet 

Printer.   

Dot Matrix Printer 

 It prints characters as a 7 X 5 matrix. That is, each character is 

printed in 7 rows and 5 columns. For example, ―L‖ is printed as 

The dots are produced by wires fixed to a print-head. The wires 

are operated by a solenoid [a coil producing magnetic field when current 

is passed through] operated by signals from CPU. When operated, they 

protrude [come out of the head], strike the ribbon against the paper 

producing dots and go back in to the head. 

Advantages 

1. Cost is low. 

2. Easy to operate 

3. Prints 30 to 300 characters per second 
 

Laser Printers 

 They are high speed non-impact printers. The printing quality 

is high. The printing speed is from 10 to 20 pages per minute. 

Because of the quality and speed, today we use them in place of the 

offset printing machines. 

 A static charge is applied to a photoreceptive drum which is 

made up of selenium. A photoreceptive surface is one that is 

conductive when the light hits it. 
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 Next, a laser beam exposes the area not to be printed. The areas to be printed will be 

charged. A dry toner is applied on the drum surface. The toner sticks to the charged areas of the 

drum. The image of the drum is then transferred electro statically to the paper. Finally, the image 

is fused with heat, pressure or both. 

Advantages 

1. Printing quality is high 

2. Printing speed is high 

3. A replacement for offset machine 

Ink-Jet Printers 

 Characters and images are formed from dots. The dots are 

produced by tiny droplets of ink on the paper. Actually, this printer contains 

an ink tank from which ink can be pumped through a nibble. The droplets 

are then guided to proper position on the paper by electrically charged 

deflection plates. The printing quality is good because a character is 

formed by dozens of ink dots. If a droplet is not needed for a particular character, it is recycled 

back to the ink tank. 

Advantages 

1. Cost is low when compared to laser printers.  

2. Printing quality is high. 

3. Less noise. 

X-Y Plotters/Flat-bed Plotters 

 It is an output device. It is used to plot drawings. It basically consists of fixed flat surface 

and a pen carriage which can move in either X or Y direction. The paper is fixed on the flat 

surface and the pen fixed on the carriage is moved on the paper to draw figures. The pen can 

also be moved up or down. Drawing a line is done by specifying two points in a fixed X-Y 

coordinate system and issuing a command to draw a line between them. The position to which 

the pen should move is specified by digital signal. Hence, this plotter is also called a digital 

plotter. The resolution of the coordinate system ranges from 1024x 1024 points to 4096x4096 

points. Three to eight colour pens are normally provided. 

Advantages 

1. Cost is low. 

2. Colour drawing is possible. 

3. Can plot Civil Engineering and 

Machine drawings. 

4. Used in Computer Aided Design.  

PEN 
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Connecting Port 

A port is a physical docking point using which an external device can be connected 

to the computer. External devices are connected to a computer using cables and ports. 

Ports are slots on the motherboard into which a 

cable of external device is plugged in. Examples of 

external devices attached via ports are mouse, 

keyboard, monitor, microphone, speakers etc. 

Types of Ports 

There are various types of ports like Serial 

Port, Parallel Port, PS/2 Port, Universal Serial Bus 

Port (USB Port), VGA Port, etc. Ports are shown in 

the figure.  

 

Data Communications 

Data communications refers to the transmission of this digital data between two or more 

computers and a computer network or data network is a telecommunications network that allows 

computers to exchange data. 
 

Types of Computer Networks 

Local Area Network 

 The connection between two or more computers within an organization is called LAN. By 

this connection one can exchange the data between a single or group of computers. LAN can be 

either wireless or wired.  

Wide Area Network 

 A wide area network (WAN) is a telecommunications network or computer network that 

extends over a large geographical distance. Wide area networks often are established with 

leased telecommunication circuits. 
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QUESTIONS AND ANSWERS 

 
I. Fill in the blanks 

1. Arithmetic Engine was invented by Blaise Pascal. 

2. Charles Babbage is called father of computer. 

3. The world first programmer is Lady Ada Love Lace. 

4. Expansion of ASCII is American Standard Code for Information Interchange. 

5. Components used in Second Generation were Transistor. 

6. A byte consists of 8 (eight) bits. 

7. Expansion of RAM is Random Access Memory. 

8. OCR stands for Optical Character Reader. 

9. VDU means Visual Display Unit.  

10. Pentium i5 refers Processor of a Computer. 

11. EEPROM means Electrically Erasable Programmable Read Only Memory. 

12. SMPS is the abbreviation of Switch Mode Power Supply. 

13. Modem is a device used for Internet Connection.  

14. Graphics Card is a device used to enhance the clarity of the display. 

15. Sound Card is a device, which connects the audio components for multimedia applications. 
 

II. Match the following  

1. ROM   a. First Generation   ( j ) 

2. Vacuum Tube  b. Secondary Memory   ( a ) 

3. Hard Disk   c. Local Area Network   ( b ) 

4. Binary Digit   d. one of characteristics of computer  ( f ) 

5. Memory   e. Liquid Crystal Display   ( d ) 

6. Analytical  Engine  f. 1 and 0          ( h ) 

7. Printer   g. Input  Unit         ( i ) 

8. LCD   h. Charles Babbage   ( e ) 

9. Joystick   i. Output Device    ( g ) 

10. LAN   j. Read Only Memory   ( c ) 
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III. Choose the best answer 

1. IC means 

a)  Integrated Circuit  b) Industrial Circuit 

c)  Integrated Components    d) Institute Circle 

2. The storage capacity of Compact Disc (CD) is  

a) 1.44 mb   b) 700 mb  c) 600 mb  d) 4.7 GB 

3. The period of the Third Generation computer is  

a) 1946-1955  b) 1956-1965  c) 1966-1975      d) 1976-1985 

4. Which of the following is a digital device? 

a) Thermometer  b) Slide Rule  c) Dial gauge   d) PC 

5.                      Unit is present in the CPU. 

a) Input unit   b) Output Unit  c) Control Unit   d) ALU 

6. Which of the following is Read and Write Memory? 

a) ROM   b) RAM   c) EPROM  d) EEPROM 

IV. Say True or False 

1. LED is the abbreviation of Liquid Emitting Display.     (F) 

2. Digital Camera is an Output Unit.       (F) 

3. Primary memory is a volatile memory.      (T) 

4. Word in the computer consists of 13 bits.     (F) 

5. It is possible that computers can do mistake by its own.   (F) 

6. The plotter is used in the CAD applications.     (T) 

7. Von Newman designed the architecture of today‘s computer.   (F) 

8. Today, we are using super computers in homes.    (F) 

9. Peripheral devices are not part of Central Processing Unit.   (T) 

10. Peripheral devices are not part of Central Processing Unit.   (T) 

 
V. Write answer in two or three lines 

1. Write the components used in the various generations of the computer.  

2. Draw the block diagram of the computer. 

3. What are the differences between analog and digital computer? 

4. What are the various units of measurements of memory? 

5. What is Primary Memory? 

6. Write the advantages of Hard Disk. 

7. What are the types of printers?  

8. What are the types of ports? 

9. What are the components of CPU? 

10. Give examples for Storage Devices. 
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VI. Write answer in brief 

1. What are the characteristics of the computer? Explain. 

2. Explain and draw the block diagram of a digital computer. 

3. Explain the various memory types.  

4. Differentiate Primary and Secondary Memory. 

5. Write about Input and Output Devices. 

6. Explain about the types of Computer Networks. 

7. Differentiate PC-XT and PC-AT. 
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WINDOWS 
 

OPERATING SYSTEM 

An Operating System (OS) is important software of a computer system which controls all 

the activities of the computer. It is stored in the hard disk. It is a communicating bridge between 

Hardware and Software. Hardware components are those components which can be touched 

physically, like the Central Processing Unit (CPU), Memory, Keyboard, Hard Disk, Printer and so 

on.  The Software are set of instructions also referred as programs, to the hardware to perform 

certain operations to bring out specific results like play a game, prepare a letter, send electronic 

mail, etc.  

Examples: DOS, UNIX, LINUX, SOLARIS, MACINTOSH, WINDOWS-NT,                 

WINDOWS XP, WINDOWS 7, WINDOWS 8. 
 

Functions of Operating System 

There are many functions performed by the Operating System but the main function is, 

to provide an interface between the user and hardware. The Operating System also controls the 

file management by creation of files, creation of directories and reading & writing the data from 

Files to Directories and also Copy the contents of the Files and/or the Directories from one place 

to another place. 
  

Types of Operating System 

Single User, Single Task 

 As per the name of this type, the computer can do only one task at a time.  Palm OS for 

palm handheld computers is an example for Single-user, Single-task operating system.  

 Example: Bus ticket, time tracking, etc. 
 

Single User, Multitasking 

 This is the type of operating system which most of the people use on their Laptop and 

Desktop computers today.  Microsoft Windows, Macintosh are examples of operating system that 

will let a single user have multi programs in operation at the same time. 
 

Multi-user 

 Multi-user is a term that defines an operating system or application software that allows 

concurrent access by multiple users of a computer.  A multi-user operating system allows many 

different users to take advantage of the computer‘s resources simultaneously.  The operating 

system must make sure that the requirements of the various users are balanced, and that each 
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of the programs they are using has sufficient and separate resources so that a problem with one 

user doesn‘t affect the entire community of users.  Examples: UNIX, Linux, MVS, VM. 
 

Real time processing 

A Real-Time Operating System (RTOS) is an operating system that guarantees a certain 

capability within a specified time constraint. 

Examples: Manufacture of steel, Manufacture of Chemicals and Robot based process. 
 

WINDOWS OPERATING SYSTEM 

Windows is a series of systems developed by Microsoft. Each version of Windows 

includes a Graphical User Interface, with a desktop that allows users to view files, folders and 

other applications in windows.  Windows has been the most widely used operating system for 

personal computers. It provides Plug and Play facility.  
 

Versions of Windows 

Windows 3.0, Windows 3.1, Windows 95, Windows 98, Windows ME, Windows XP, 

Windows Vista, Windows 7 and now Windows 8.   
 

Booting  

Booting is a startup sequence that starts the operating system of a computer when it is 

turned on. 
 
Desktop 

The GUI screen is the desktop. Windows objects like icons, windows and dialog boxes 

appear on the desktop.  These objects help the users to do their tasks easily and quickly. 
 

Graphical User Interface (GUI) 

 In Graphical User Interface, commands are available in graphical formats.  Users can 

select their choice by mouse with the following actions. 
 

Mouse actions Purpose 

Click To select an item.  

Double click To run an application 

Right click To view the properties of a selected item. 

Drag To move an item from one location to another. This can be done by 
pressing the left mouse button, holding it and moving it to the destination 
and then releasing the button.   

 

http://techterms.com/definition/gui
http://techterms.com/definition/desktop
http://techterms.com/definition/window
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Cursors / Pointers 

The insertion point or Cursor is usually represented by a blinking vertical line. User can 

reposition the insertion point by pressing arrow keys or by moving the I-beam pointer. 
 

Icons 

An icon is a small graphical representation of a program or file that, when clicked will be 

run or opened. Icons are used with Graphical User Interface (GUI) operating systems. 

Microsoft Windows helps to identify a type of file or program associated with the icon. By default 

there are some icons present in the desktop. They are: MyComputer, MyDocuments,                          

My Network Places, Recycle Bin and Internet Explorer, etc. Some other icons will be added 

based on the software which we have installed later.  
 

My Computer 

The resources in the system, both hardware and software, can be accessed through My 

Computer.  My Computer window displays the Drive Icons (Hard disk drives, Removable Storage 

Drives, etc.,), Control Panel icon, etc. By using the drive icons users can view, copy, move or 

delete the files or folders from the drives.  Also that user can change or view the settings of 

various components, either hardware or software, using the Control Panel. 
 

My Documents 

My Documents is a folder in Windows Operating System to store documents, graphics, 

or other files. Most of the application program such as Microsoft Word, Microsoft Excel, WordPad 

or Paint, automatically saves the file in My Documents, unless the user specifies the place to 

store. 
 

Microsoft Network 

    My Network Places or Network is an icon found in the desktop or in My Computer that 

allows the user to access or view the system(s) which are connected in the network of user‘s 

system.   
 

Recycle Bin 

 Whenever the user deletes a file in the computer, it does not physically delete 

immediately form the disk. All the deleted files are temporarily stored in Recycle bin.  User can 

retrieve the deleted files from the Recycle bin later if needed. If any file is deleted in recycle bin, 

the deleted file can‘t be got back. 
 
 

http://www.computerhope.com/jargon/g/gui.htm
http://www.computerhope.com/comp/msoft.htm
http://www.computerhope.com/jargon/w/windows.htm
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Quick Launch Toolbar  

 The Quick Launch toolbar is a section of taskbar near the Start menu where user can 

add shortcuts to programs. The Quick Launch toolbar always stays visible, even when user has a 

window open, for easy access to user shortcuts. 
 
System Tray 

 System Tray is a section of taskbar near the Clock that contains small icons for easy 

access to system functions like printer, volume control, network, etc.  User can access and get 

the details by single, double or right clicking on the icons. 
 
Start Menu 

 Start menu is found at the left corner of the Taskbar.  This is the main user interface area 

in Microsoft Windows. This start menu locates the installed programs, Control panel, recently 

accessed files, Printers, etc. User can search a file / folder / installed program using search 

option found in start menu. Restart, Shutdown, Logoff options are also found in start menu. 
 
Taskbar 

It appears at the bottom of the screen from left to right end. The icons or tabs on the 

taskbar represent programs that are currently open.  It will also display the current date and time 

icons, settings for sound card, mouse and memory resident programs. It is also used to switch 

between open programs. It contains start button, which is the starting point to the Windows 

operating system.  

The start button appears in the lower-left corner of the screen in the task bar.  When it is 

clicked, the start menu will appear.  Each option in the start menu contains submenus which will 

be displayed when the corresponding option is selected.   
 
Windows Explorer 

 Windows is a listed File Manager which contains the hierarchy in window and folders and 

files in another window.  Copying, moving, renaming, deleting files between folders and drives 

shall be done. It shall be launched in two different ways, either by right clicking on the start button 

and clicking Open Windows Explorer or by clicking Windows Explorer found in Accessories of 

Start Menu’s Programs. 
 
Control Panel 

The Control Panel is a section of Microsoft Windows that enables a user to change 

various computer hardware and software features like settings for the mouse, display, 

sound, network, and keyboard. 

 
 

http://www.computerhope.com/jargon/w/windows.htm
http://www.computerhope.com/jargon/m/mouse.htm
http://www.computerhope.com/jargon/d/display.htm
http://www.computerhope.com/jargon/s/sound.htm
http://www.computerhope.com/jargon/network.htm
http://www.computerhope.com/jargon/k/keyboard.htm
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Installing Font 

 A new font can be installed in two ways.  One is to install a font and another method is 

just to copy and paste the font. 
 

(i) Installing method 

1. Go to Control panel found in the Start and click it. 

2. Control panel window appears. 

3. Now click on the Fonts Icon which is in the Appearance and Personalization option. 

       (After you click, list of the fonts that are already installed in the computer will be shown.) 

4. Click on Install Font to 

install a new font. 
 

(ii) Copy & Paste method 

1. Do the first three 

steps as it is in 

installing method. 

2. Copy the necessary 

font to be installed in 

the computer and 

Paste it in the Font 

folder in the Control 

Panel. 
 

 

Installation of a Printer 

1. Go to Devices and Printers found in the Start and click it. 

2. After Devices and Printers window appears, click Add a Printer. 

(A printer can be installed to a computer in two ways.  One is to install through a network 

and the other is to install the printer locally to a computer alone.) 

3. Click Add a local printer, if the printer is to be installed only in the currently used computer 

or else click Add a network, wireless or Bluetooth printer, if the printer is to be installed 

through a network. 
 

(i) Adding a printer locally 

1. Click Add a local printer 

2. Now enter the appropriate port. 

3. A list of pre-installed printers will be shown.  If the required printer is already present, select 

it and click Next. 
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(ii) Adding a printer through network  

i) Click Add a network, wireless or Bluetooth printer. 

ii) Now the network will be scanned and printers in the network will be listed out. 

iii) Select the required printer. 
 
Backup  

 Backup is a process of preserving the copy of files installed, to restore them when 

problem occurs in the computer.  
 
Restore 

 Bringing back the backed up files for use under a problematic circumstance is called 

Restoring. The point of backing up files is to restore them when required. 
 
 
BOXES AND BUTTONS 
 
Dialog Boxes 

 A dialog box is a 

temporary window, 

designed to retrieve user 

input. An application uses 

dialog boxes to prompt the 

user for additional 

information.  A dialog box 

usually contains one or 

more controls, using this 

user can enter text, choose 

options, or direct the action. 

The dialog box is designed 

with different controls like 

List Box, Spin Control Box, 

Slide, Dropdown list, Radio 

Button, Check box, Text 

box, etc. 
 
 

Spin Control Box 

A control which is the combination of textbox with up and down arrow is called Spin 

Control Box. User can increase or decrease the value in the textbox using the up and down 

arrows respectively.   

   

Checkbox 

Radiobutton 

Dropdown List 

Scrollbar 

Listbox 

Spin Control Box 

Progress Bar 

Slider Control 
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List Box 

List box is a windows control, which helps the user to display a list of items in a box from 

which user can select any one option. 
 
Slider 

A slider control is a Graphical control element with minimum and maximum value. Using 

the arrow in the slider control user may change the range of values.  
 

Drop-down List 

       Dropdown list control enables users to select an item from a predefined list. It differs from 

the List Box control in that the list of items remains hidden until users click the drop-down button. 

In addition, the Drop-Down List control differs from the List Box control because it does not 

support multi-selection mode. 
 

Radio Button 

 Radio Button control is a small circle that has the given text displayed next to it and 

which is typically to its right.   
 

Checkbox 

 The Check Box control is a commonly used graphical control, which has a specific type 

of two states button that can be either checked or unchecked. 
 

Textbox 

Text box control allows the user to enter text, by default; it takes a single line of text.  
 

PARTS OF WINDOWS 

Title bar: The title bar is at the top of the window, and it shows the name of the currently active 

document.  

Menu bar: It contains menus.  Each menu contains a list of commands. 

Scroll bar: It has arrow buttons to move through a document left or right, up or down. 

Status Bar: Status Bar is a horizontal bar at the bottom of the window, showing information 

about a document being edited or a program running. 

Minimize button: Reduces the window to an icon and arranges it on the desktop. 

Maximize button: It enlarges the active window to fit the screen. 

Close Button:  The close button is at the right corner of the title bar.  Once the button is 

pressed, the window is closed immediately. 

http://help.adobe.com/en_US/FlashPlatform/reference/actionscript/3/spark/components/CheckBox.html
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Restore button: It is same as maximize button.  When this button is clicked, it restores the 

window to its previous size. 

 
Moving a Window 

To move a window, click on the title bar and drag to the place where the user needs. 
 

Windows – Menus 

 There are various menus used in Windows Operating System.  Some of them are Start 

Menu, Help Menu and Preview Menu; 
 

Logoff & Shutdown  
 

Log off 
Closes all user files and programs and logs the user off from Windows 

without turning off the computer. 

Shutdown 
Shutting down the computer basically means that Windows closes all 

running programs and completely turns off the machine.  

 

Keyboard Accelerators 

Keyboard short keys or hotkeys 

 + Up    – Maximize the current Window 

 + Down    – Restore down or minimize current Windows  

 + Left    – Dock the current Window to the left half of the screen 

 + Right    – Dock the current Window to the right half of the screen 

 + Home    – Minimize all windows, except the current Window 

 + Space    – Makes all Windows transparent to see through to the desktop 

 + Pause  or Break   – Open System Properties 

 + D    – Show/Hide desktop  

 + E    – Windows Explorer is launched 

 + F    – Search 

 + L     – Lock Computer 

 + M    – Minimize all Windows 

 + P    – used to connect laptop with projector 

Win  + R    – Run Command is launched. 

Win  + S    – OneNote Screen Clipping Tool 

++Win  + =    – Magnifier 

Win  + +  or –   – Enables the magnifier and zooms in/out 
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Win  + Shift  + M  – Undo all Window minimization 

Ctrl  + Right    – Move the cursor to the beginning of the next word 

Ctrl  + Left    – Move the cursor to the beginning of the previous word 

Ctrl  + Up    – Move the cursor to the beginning of the previous paragraph 

Ctrl  + Down    – Move the cursor to the beginning of the next paragraph 

Ctrl  + Shift +arrow key – Select a block of text 

Ctrl  + Shift  + Esc   – Open Task Manager directly 

Ctrl  + Shift  + N  – Create new folder 

 

Windows Explorer  

Alt  + Left    – Go back 

Alt  + Right    – Go forward 

Alt  + Up    – Go up a directory 

Alt  + Enter    – Open the Properties Window of the current selection 

Alt  + Space bar  – Open the shortcut menu for the active Window 

Alt  + F4    – Close the active Window 

Alt  + Tab    – Switch to previous active Window 

Alt  + Esc    – Cycle through all open Windows 

Alt  + D    – Move focus to address bar 

Alt  + P   – Show/hide the preview panel 

Ctrl  + N   – Open a new Window 

Ctrl  + Mouse wheel  – Change the view type (extra-large, small, list view, detail, etc.) 

 
Logging In / Out  

Win  + Right  + Enter    – Shutdown 

Win  + Right  + Right  + R   – Restart 

Win  + Right  + Right  + S   – Sleep 

Win  + Right  + Right  + W   – Switch users 

 

ACCESSORIES 

Microsoft Paint 

It is an application that gets installed along with windows. Microsoft paint is exclusively 

used for paintings or drawings. To use Microsoft Paint, press start button, then go to accessories 

and then select Paint. 
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Calculator 

 Calculator is used to perform simple calculations such as addition, subtraction, 

multiplication, and division. Calculator also offers the advanced capabilities of a programming, 

scientific, and statistical calculator. 
 

Working with Notepad / WordPad 

 Notepad is a generic text editor included with all versions of Windows that allows user to 

open and read plaintext files. If the file contains special formatting or is not a plaintext file, it will 

not be able to be read in Notepad. 

WordPad is also a text editing program available in Windows. But it allows the user to 

format the text, insert the picture and objects. 
 
Opening Notepad / WordPad 

Users who are using Microsoft Windows can run Microsoft Notepad / WordPad by 

following the steps below. 
 

In all Windows versions 

1. Click Start 

2. Click Programs and then Accessories 

3. Click the Notepad / WordPad icon. 
 

In Windows 7 or later 

1. Click Start 

2. Windows Start Screen type Notepad/Wordpad and press Enter. 
 
Opening a File using Notepad / WordPad  

 Click Open button on the Word toolbar or Select the File menu, then Open or press 

Ctrl+o. The Open dialog box appears. 

 Click the Look In drop-down arrow to select the drive on which the file is located. The 

folders on the drive appear. 

 Double-click the folder that contains the file. The files in that folder are listed. 

 To open the file, click the file then click Open button. The file appears in its 

corresponding window. 
 

Saving a file 

 Saving the content is one of the most important aspects of working with any software 

application so as to preserve them.  

http://www.computerhope.com/jargon/w/windows.htm
http://www.computerhope.com/jargon/p/plaintex.htm
http://www.computerhope.com/jargon/s/start.htm
http://www.computerhope.com/jargon/w/windows8.htm
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 Click Save on the File menu or press Ctrl+s.  While saving the document for the first time, 

the Save as dialog box will appear. 

 Type a filename into the File Name box.  

 Double-click any folder in the Save In box to open the folder. 

 After you have specified a name and a location for the new file, click Save button to save 

the file.   

To save changes to a document that has been saved under a filename, just click the 

Save button from the file Menu or press Ctrl+s. 
 

Formatting  

 In Notepad, font, font size, style and script can be changed for whole document only, not 

a part of text in the file. 

In WordPad, it is possible to format only a selected content. User can click and drag to 

select the text and adjust the settings for Font, Font Style, or Size at the formatting area in the 

Home Tab. User can apply strikeout or underline effects and also can use various other tools, 

such as the alignment buttons or the Bullets button. 

 The following tasks can be done only in WordPad.  

Insert an object  

User can insert an object by choosing Insert Object from the Insert Group in the Home 

Tab.  Select the Create New option, click an object type, and then click OK in the Object dialog 

box. User can modify the inserted object however they want (moving it, resizing it, and so on). 
 

Replacing text with WordPad 

The Replace command allows you to search for information in a document and replace it 

with text and formatting you specify. To replace a text, follow these steps. 

1. Click Replace link in the Home Tab, the Find and Replace dialog box opens. 

2. Type the text you want to find in the Find What text box. 

3. Type the text you want to replace in the Replace With text box. 

4. Click the Find Next button to move to the next matching instance in your document. 

5. Click Replace button to replace the found text with the replacement text. 

6. Repeat steps 4 & 5 as desired. 

7. Click the Replace All button to automatically replace all instances of matching text with 

replacement text. 

8. When finished, click the Cancel button. 

Press the keyboard shortcut key Ctrl + h to open the Replace window. The Replace 

feature in WordPad is limited; if you need more than just replacing words consider a different 

editor. 
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Print documents 

To get the hardcopy of the wordpad document, Click the WordPad menu button, 

click Print, and then select the options. User can look the document before print by using the 

print preview option in the print. After that, user can close the print preview by clicking Close print 

preview. 
 

PERSONALIZING WINDOWS 

 Windows 7 makes it easy to customize the look and feel of the Desktop view. 

Personalization pane allows user to customize the theme, background image and color of the 

Desktop. Any changes which makes to the appearance of the Desktop will not affect the Start 

screen.  

To access the Personalization pane, right-click anywhere on the Desktop, and then 

select Personalize from the drop-down menu. The Personalization pane will appear as shown 

below. 
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WRITING ON THE CD / DVD 

 Writing into the CD can be done either by Windows or by Nero Software. Both the 

methods are given below. 
 
Steps to write CD / DVD using Windows  

1. Place an empty disc into your CD/DVD writable drive. 

2. In the Blank CD/DVD-R Disc notification that pops up at the bottom of the screen, select 

Open with CD/DVD Creator. ... 

3. In the Disc Name field, type a name for the disc. 

4. Drag or copy the desired files into the window. 

5. Click Write to Disc. 
 
Steps to write CD / DVD using Nero Software 

Nero is an application specially designed for writing the data into CD or DVD. Using this 

Software, Data, Audio, and Video files can be added to CDs and DVDs. Some other features 

found in this software are,  

 Copy content from one disk to another;  

 Copying audio CD tracks in a choice of audio formats;  

 Erasing rewritable discs; 

 Converting audio files to other audio file formats;  

 Creating discs from ISO images; 

 Creating bootable CDs 
 

 
 

https://en.wikipedia.org/wiki/CD-RW
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Step to write any file in data CD format is given below: 

1. Click Programs, Nero, Nero OEM, NeroExpress. 

2. This will bring up the Nero Express main window. Click Data, Data Disc. 

3. This brings up the Nero Express Disc Content window. To add data to be written to CD, 

click Add or drag and drop data into the Disc Content window. 

4. This brings up the Select Files and Folders window. Highlight those files and folders you 

wish to add, and click Add.  

5. Click Finished button once all the Files and Folders have been selected. 

6. This will bring back the "Disc Content" window. This window will show how much space 

write operation will use. Click Next to move on to the next step. 

7. Click Next to continue the burn process after having made the adjustments. 

 

 

 

8. This brings up the Final Burn Settings window. Some choices have to made here 

 Select the Recording device. 

 Provide the Disc you are about to create with a name. 

 Set the Write Speed. 

 Decide if the CD will be Multisession enable this feature to allow all data that will be 

written to this CD, now and later, to be seen. If it's not enabled, only the data last 

written to the CD will be seen when mounted. 

 Choosing Verify data on disc after burning verifies data was written to CD correctly. 

Always enable this aspect for critical data that you cannot afford to loose.  

 Click More after selections have been made for additional advanced configuration 

capabilities. Or click Burn to begin the Write operation to the CD. 



 Venus Computers   Unit-2: Microsoft Windows 

 

41 

 

9. Selecting "Burn", will go to the final step. Selecting "More" option, will bring a drop down 

window for more added control of the write method used. 

 Write Method: If you have the option for "Allow files to be added later" enabled, as 

shown earlier in this document, will be pre-set to Track-At-Once mode and you will 

not be able to select any other option. 

 Finalize Disc: Selecting this feature will close the disc to any future writing. 

 Determine maximum speed: The speed test determines how quickly the compiled 

files can be accessed. 

 Simulation: The simulation runs all the steps involved in burning a disc apart from 

activating the laser, so that you can assume that if the simulation is successful, the 

burning process will also be successful. And avoid the possibility of wasting media if it 

were to fail. 

 Write: This checkbox enables the actual physical burning process. 
 
 

ANTIVIRUS SOFTWARE 

Antivirus software is a program that is designed to find and neutralize malware and 

viruses. These programs are able to scan your computer‘s hard drive and identify files that are 
malicious or suspicious. The antivirus software can attempt to delete, quarantine, or trigger an 

alert when it detects files that are harmful. Additionally, many antivirus software suites also have 

settings that can prevent your computer from downloading or executing harmful files in the first 

place. 
 
Some of the Antivirus Software 

 Avast 

 Kaspersky 

 Avira 

 AVG 

 360 Internet Security 

 Norton 
 
Prevention and cure:    

The following points have to be considered for preventing virus:  

1. Restriction of floppy disk and USB device usage 

2. Checking the files before copying into the system. 

3. Using original legal software 

4. Attachment files received in the email should be scanned for virus affection.      

5. The antivirus programs should be updated and scheduled regularly.  
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List of Files and their extensions 

 

Extension Applications 

.doc Upto Microsoft Word 2000 XP 

.docx Microsoft Word 2007 and above 

.ppt Upto Microsoft PowerPoint 2000 XP 

.pptx Microsoft PowerPoint 2007 and above 

.xls Upto Microsoft Excel 2000 XP 

.xlsx Microsoft Excel 2007 and above 

.mdb Upto Microsoft Access 2000 XP 

.accdb Microsoft Access 2007 and above 

.odt Open Office Writer  

.ods Open Office Spreadsheet 

.odp Open Office Impress 

.odb Open Office Base 

.psd Adobe Photoshop 

.cdr Corel Draw 

.pdf Portable Document File 

.tiff  

 

 

 Image (Picture) Files 

.bmp 

.pcx 

.gif 

.png 

.jpeg 

.mp3  Audio Files 

.wav 

.mp4  

 Video Files .mov 

.avi 

.rar 

.zip 

.7Z 

 Compressed File 

 



 Venus Computers   Unit-2: Linux 

 

43 

 

LINUX 
 
INTRODUCTION 

Linux is an UNIX based operating system. It was created by a student, Linus Torvalds in 

1991. It is an Open Source Software ie. it belongs to nobody, free to download and use. Any 

changes to it are open for all to adopt, and as a result it has developed into a very powerful OS 

that is rapidly gaining in popularity worldwide, particularly among those seeking an alternative to 

Windows. 
 
Features of Linux 

 Linux is a comprehensive OS with a number of features and capabilities.  Several 

reasons were identified for the popularity and success of the LINUX Operating System is written 

in ―C‖ Language, which makes it easy to read, understand, update and port to other machines. 

 Linux is a Multi-User Operating System which allows multiple users to use the system 

simultaneously.  

 Since it has no owner user can debug the source without license. 

 It is also a Multitasking Operating System which means an Operating which is capable of 

handling large number of processes at the same time.  

 Linux is a highly portable. 

 Job control facility in Linux helps the user to move processes between the foreground 

and background, suspend (pause) them and display their status like job, job number, job 

table etc.  

 Linux Shell is a very powerful and dynamic LINUX utility.  It is the primary interface to the 

OS (kernel).  It can be used to write scripts to solve simple and complex problems. 

 Being a Multiuser OS, Linux offers protection to the user‘s data from other users 

 Using Linux OS, user can communicate and transfer the files across same and different 

Operating Systems. 

 Linux supports a wide range of hardware types, including PCs, Macs, mainframes, 

supercomputers and robots.  
 

Components of Linux 

The Linux Operating system has three main components. 

Kernel 

A kernel is the core component of an operating system. Using inter-process 

communication and system calls, it acts as a bridge between applications and the data 

processing performed at the hardware level. 

http://en.wikipedia.org/wiki/Linus_Torvalds
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When an operating system is loaded into memory, the kernel loads first and remains in 

memory until the operating system is shut down again. The kernel is responsible for low-level 

tasks such as disk management, task management and memory management. 
 

System Libraries 

"The System Libraries" describe a typical set of functions through which applications can 

interrelate through the kernel. And which apply much of the operating system functionality that 

does not require the full rights or privileges of kernel code.  
 

   

System Utility 

 The system utilities are the programs that execute individual, particular and specialized 

managing tasks. Some of the system utilities may be invoked just once to initialize and configure 

some features of the system. 
 

Linux Process and Thread Management 

Process management is the process by which operating systems manage processes, 

threads, enable processes to share information, protect process resources and allocate system 

resources to processes that request them in a safe manner.  
 

Thread Management 

A thread is a flow of execution through the process code, with its own program counter, 

system registers and stack. A thread is also called a light weight process. Each thread belongs to 

exactly one process and no thread can exist outside a process. Each thread represents a 

separate flow of control. Threads have been successfully used in implementing network servers 

and web server.  
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They also provide a suitable foundation for parallel execution of applications on shared 

memory multiprocessors. If one thread is blocked and waiting second thread in the same process 

can run.  

Threads are implemented on the basis of user level and kernel level. 
 

File Management System 

A central part of the desktop environment is a file manager application, enabling user to 

create, access, and manage all files on the system. Traditional file management in Linux would 

have been done via the command line, requiring some deeper knowledge of several commands 

to list, create, delete, or edit files and their properties. A file manager provides a graphical and 

more intuitive way to handle these tasks. 

Linux does not use drive letters. In Linux, all files and directories are located in a tree-like 

structure. The topmost directory is referred to as the file system root or just /. All other directories 

can be accessed from here. 
 

/home/<username> 

/home holds the private data of every user who has an account on the system. The files 

located here can only be modified by their owner or the system administrator.  
 

/media 

/media generally holds any type of drive except the hard drive of the system. CD, DVD, 

USB flash drive or digital camera appears under /media.  
 

/windows 

If users have both MS Windows and Linux installed on the system, then the windows 

data can be seen in this directory. 

 
Files and Directories 

A file is a collection of related information like data, programs, text, etc. At the end of the 

file name, an extension in included with the period followed three more alpha numeric characters.  

These files are organized in directories. A directory contains a group of related files. Directories 

can have subdirectories along with other files. In Linux the directories are also maintained as 

files.  
 

Linux Commands 

User can interact with the computer by the help of the shell commands provided by the 

Linux which are similar to the DOS Commands. 
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Steps to start Terminal 

In the Applications Menu, choose Accessories, Select Terminal. The application opens a 

terminal window with a group of default settings. The terminal window displays a command 

prompt where you can type UNIX commands. User can create a new profile and apply the profile 

to the Terminal.  

Like DOS commands user needs to press Enter Key () after typing the command.  User 

can type the options to the command by suffixing the ' -' (space and -) after the command. 
 

 
 

Example 

ls -l 

Some commands can be complex and take some more time to execute, at that time user 

can interrupt and stop the command using the Key Ctrl+C.  

User can enter more than one commands on the same line by separating them with a 

semicolon.  

Example: pwd ; date 

 Linux is case sensitive (differentiating upper and lower case letters). So user needs to 

type the commands carefully. 

date  

 Linux maintains a calendar clock such that the current date and time is always available.  

Syntax : date 

Output : Mon Sep 14 07:03:09 IST 2015 
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pwd (Print Working Directory)  

 This pwd command in Linux is used to print the name of current working directory.  

Command : pwd 

Output : /venus/sys14 
mkdir 
 
 This command is used to make directory in various methods as user needs. 
 

Syntax Example  Description 

mkdir <dir> mkdir  India creates a new directory  

mkdir <dir1> <dir2> <dir3> mkdir  PM  President creates more than one 
directory in same location 
with one command 

mkdir –p <dir1>/<dir2>/<dir3> mkdir –p India/President/Kalam creates multiple levels of 
subdirectories with one 
command 

 
rmdir 

 rmdir command is used to remove the single or multiple directories from the working 

directory.   

Syntax Example  Description 

rmdir <dir> rmdir  Deletes the directory 

rmdir <dir1> <dir2> <dir3> rmdir PM President Deletes more than one 
directory in same location 
with one command 

rmdir <dir1>/<dir2>/<dir3> rmdir India/President/Kalam Deletes multiple levels of 
subdirectories with one 
command 

cd  

The cd command is one of the commands users use the most at the command line in 

Linux. It allows the user to change their working directory as per user needs.  
 

Syntax Example  Output Description 

cd / user1@sys14[India]$ cd / user1@sys14[/]$  Change the working 
directory to root  

cd ~ user1@sys14[India]$ cd ~ user1@sys14[~]$ Change the working 
directory to user home  

cd <dir> user1@sys14[~]$ cd India user1@sys14[India]$ Change the working 
directory to user specified 
directory [Confirm the 
directory is in that location] 

cd /<dir1>/<dir2> user1@sys14[/]$ cd /home/user1/India user1@sys14[India]$ 

cd .. user1@sys14[India]$ cd .. user1@sys14[~]$ Change working directory to 
parent directory 

cd - user1@sys14[India]$ cd - /home/user1 

user1@sys14[~]$ 

Change directory to previous 
working directory 

http://www.computerhope.com/jargon/c/commandi.htm
http://www.computerhope.com/jargon/c/currentd.htm
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ls    

 User can display the list of files in the working directory using ls command. It is used to 

list the details in the order of file permissions, owner, group, size of the files (in bytes), 

modification date and time, file name.  
 

Syntax Example Output Explanation 

ls user1@sys14[India]$ ls PM President It lists the files of the working 
directory 

ls directory1 
/directory2 

user1@sys14[~]$ ls India/PM Nehru Rajendraprasad List the files of two different 
directories in long format 

 
who 

 who command prints the list of users currently logged in, their terminal, the time they 

have been logged in, and the name of the host from which they have logged in. Syntax is: 

       who [options] [file]  

 

Command Output Description 

user1@sys14[~]$ who user1 tty8 2015-09-15 08:49 (:0) 

user1 tty8 2015-09-15 08:49 (:0) 

Prints details about users who are 
currently logged in. 

user1@sys14[~]$ who -b system boot 2015-09-15 08:40 Prints time of last system boot. 

user1@sys14[~]$ who -d 2015-09-15 08:40    220 id=si term=0  exit =0 

2015-09-15 08:40  2221 id=l2 term=0  exit =0 

Print dead processes. 

user1@sys14[~]$ who -H NAME   LINE     TIME           COMMENT 

user1     tty8      2015-09-15 08:49   (:0) 

user1     tty8      2015-09-15 08:49   (:0.0) 

Print column headings above the 
output. 

user1@sys14[~]$ who -m user1  pts/0 2015-09-15  08:53  (:0.0) Shows username with logged in time 

 
who am i / whoami 

 The Linux command whoami prints the user name associated with the currently logged 

in user ID. 

Syntax Example Output Explanation 

who am i user1@sys14[~]$ who am i user1  pts/0     2015-09-15  08:53  (:0.0) Shows username with 
logged in details  

whoami user1@sys14[~]$ whoami user1 Shows the username only 

 
cat 

cat is one of the most commonly-used commands in Linux. It can be used to create a 

text file, displays file contents, appending data into the existing file, copy files into a new 

document, append the contents of a text file to the end of another text file. 
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Syntax Example Explanation 

cat > filename user1@sys14[India]$ cat > sample.txt  

Welcome to Everybody  

^C 

Creates a new and get ready to get content, 
to stop typing press Ctrl+C  

cat file1 > file2 user1@sys14[India]$ cat Sample1.txt > Sample.txt  Here the contents of file2 replaced with file1. 

cat file1 >> file2 user1@sys14[India]$ cat Sample1.txt >> Sample.txt  appends the contents of the file1 at the end of 
the file2 

 
cp 

 To copy the files and the directories from source to destination cp command is used. 

This command has the following Syntax: 

  cp [option] source destination 

Example: 

  user1@sys14[India]$   cp   Sample.txt   President/Sample2.txt 

Option Description 

-f force copy by removing the destination file if needed 

-i interactive - ask before overwrite 

-l link files instead of copy 

-L follow symbolic links 

-n no file overwrite 

-u update - copy when source is newer than destination 

mv 

 This command is used to rename and move one or more files from source to destination.  

  mv [option] source destination 

Example: 
  user1@sys14[India]$   mv   Sample.txt   President/ 

option Description 

-b Backup the files 

-f force copy by removing the destination file if needed 

-i interactive - ask before overwrite 

-n no file overwrite 

More 

 more is a filter for paging through text one screen at a time. It filters by number of lines, 

particular text in the files,  

 more [-num lines] [+/pattern] [+linenum] [file ...] 

Example: user1@sys14[India]$   more  -3   Sample1.txt 
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tail 

This command shows the last part of files by default it prints the last 10 lines of each 

FILE. But users can the display content by means of number of lines or by bytes with the help of 

options.  
       tail [options]... [file]... 

Example:  

user1@sys14[India]$   tail -n3   Sample1.txt (shows last 3 lines only) 
 
user1@sys14[India]$   tail  -c30   Sample1.txt    (shows last 30 bytes data only) 
  

Options Description 

-c, K Output the last K bytes 

-n, K Output the last K lines 

cmp 

This command compares two files byte by byte. If a FILE is specified as '-' or not 

specified, data is read from standard input cmp's exit status is 0 if inputs are the same, 1 if 

different, or 2 if the program encounters a problem. 

Syntax   : cmp file1 file2 

 Example : user1@sys14[India]$   cmp    Sample1.txt    Sample.txt 

Output    : Sample1.txt    Sample.txt    differ:  byte 1,  line 1 

 
diff 

The diff command compares the contents of the two files from-file and to-file.  

Syntax   : diff  [options]  from-file   to-file 

 Example : user1@sys14[India]$   diff   Sample1.txt    Sample.txt 

Output    : 1c1 
   < Welcome to Everybod 
   --- 
   < Welcome to Everybody 

 

Options Description 

-a Treat all files as text and compare line-by-line 

-b Ignore changes in amount of white space. 

-B Ignore changes that just insert or delete blank lines. 

--brief Report only whether the files differ, not the details of the differences. 

-c Use the context output format. 

  
 
 

http://www.computerhope.com/jargon/b/byte.htm
http://www.computerhope.com/jargon/b/byte.htm
http://www.computerhope.com/jargon/s/stdin.htm
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wc 

wc, or "word count," prints a count of newlines, words, and bytes for each input file and 

total if more than one file is specified. The syntax is: 

Syntax   : wc [option] [file] 

 Example : user1@sys14[India]$   wc   Sample1.txt 

Output    : 2    3    21   Sample1.txt    (shows by lines, words, characters) 

 

Option Description 

-c print the byte counts. 

-m print the character counts. 

-l print the newline counts. 

-L print the length of the longest line. 

-w print the word counts. 

sort 

sort is a useful command which rearrange the lines in a text file so that they are sorted, 

numerically & alphabetically. It has three modes of operations, Sort (the default), Merge (-m  

Merge the given files by sorting them as a group), and Check (-c  Check whether the given 

files are already sorted) 

sort   [filename] 
 
adduser  

The command to create new username in Linux is : sudo adduser username 

Syntax   : sudo    adduser     [username] 

 

http://www.computerhope.com/jargon/n/newline.htm
http://www.computerhope.com/jargon/b/byte.htm
http://www.computerhope.com/jargon/f/file.htm
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chgrp 

The command to change the user group in Linux is:  

Syntax   :  sudo chgrp username /home/username 

 Example :  sudo chgrp mani /home/maha 
  
passwd 

This command is used to modify the password of the user. 

       passwd [options...]  [username] 

 Example: passwd –S user1 

  User1   P   09/15/2015    0  99999   7   -1 

Option Description 

-d Delete the password for the named account (root) 

-l Lock the named account (root) 

-u Unlock the named account (root) 

-S Password status on named account (root) 

chmod 

chmod (change mode) is used to change the permissions of files or directories. There 

are three basic modes to files and directories: readable, writable, and executable. Additionally, 

each of these modes can be applied to the user, a group, or everybody. The syntax is: 

chmod [options] [permissions] filename 
 

options Explanation 

1 "d" if a directory, "-" if a file 

2 "r" if file is readable to user, "-" if not 

3 "w" if file is writable to user, "-" if not 

4 "x" if file is executable to user, "-" if not 

5-7 same as 2-4, with reference to group 
Example: 

chmod 666 file.txt 

 chmod u=rwx,g=rx,o=r file.txt 
 
ps 

 ps command lists the currently running jobs. 

Syntax :  ps  

 Output :   

PID TTY TIME CMD 

6525 pts/0 00:00:00 bash 

6718 pts/0 00:00:00 Ps 

http://www.computerhope.com/jargon/p/permissi.htm
http://www.computerhope.com/jargon/f/file.htm
http://www.computerhope.com/jargon/d/director.htm
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 The above picture shows the list of jobs which currently running. But the PID varies. 
 
kill 

 kill command is used to terminate the processes without log out or reboot the system. A 

process, also referred to as a task, is an executing instance of a program. Each process is 

automatically assigned a unique process identification number (PID) created for use by the 

system to reference the process. The syntax for kill is 

Syntax: kill [signal or option] PID(s) 

Example: kill 6525 

 
write 

The write utility allows the user to communicate with other users, by copying lines from 

user1 to others.  

Syntax:  write [user] [terminal] 

Example: write    user1    pts/0 

 
wall 

 wall commands writes a message to other users in the network. This displays the 

contents of file or, by default, its standard input, on the terminals of all currently logged in users. 

The command will cut any lines that are over 79 characters to new lines. Only the super-user can 

write on the terminals of users who have chosen to deny messages or are using a program 

which automatically denies messages. 

 wall [-n] [-t TIMEOUT] [file] 

 Example : wall Sample.txt 
 
 

http://www.linfo.org/program.html
http://www.linfo.org/pid.html
http://www.computerhope.com/jargon/u/utility.htm
http://www.computerhope.com/jargon/s/stdin.htm
http://www.computerhope.com/jargon/t/terminal.htm
http://www.computerhope.com/jargon/l/login.htm
http://www.computerhope.com/jargon/c/charact.htm
http://www.computerhope.com/jargon/r/root.htm
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merge 

merge incorporates all changes that lead from file2 to file3 into file1. The result ordinarily 

goes into file1.  merge is useful for combining separate changes to an original. Suppose file2 is 

the original, and both file1 and file3 are modifications of file2. Then merge command combines 

both changes, it warns if conflict occurs. 

merge [ options ] file1 file2 file3 

Options Description 

A This merges all changes leading from file2 to file3 into file1 

-E, -e These options specify conflict styles that generate less information than -A.  

-p Send results to standard output instead of overwriting file1. 

-q Quiet mode. Do not warn about conflicts. 

 Example:  merge    Sample1.txt    Sample2.txt 
 
mail 

 This mail command is used to send or receive mail.   

mail [option] [address] 

-a Append given header to the message being sent. 

-e Return true if mail exists. 

-E Execute COMMAND. 

-f Operate on given mailbox URL. The default mailbox is ~/mbox. 

-F Save messages according to sender. 

-H Write a header summary and exit. 

-i Ignore interrupts. 

-p or r Print all mail to standard output. 

-s Send a message with a Subject of SUBJ. 

-t Precede message by a list of addresses. 

-u Operate on USER‘s mailbox. 
 
 Example :  mail   - s  ―Hi! ‖  sampleaccount@gmail.com 
   cc:  
   Hi,  
   How r u? 
   Bye 
    
 Note: To complete the mail press Ctrl+D 
news 
 The news command allows a user to read news items published by the system 
administrator. 

 Syntax: news [option] [address] 

 

http://www.computerhope.com/jargon/o/overwrit.htm
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Pipes (|) and Filter (grep) 

 Pipes are probably one of the most important features that are available in the Linux 

shell. Pipes are used to separate more commands, connect two programs. In some cases user 

make the output of a particular command to act as the input for another command using pipes. 

The grep program searches a file or files for lines that have a certain pattern.  

Example : user1@sys14[India]$  ls | grep P 

 This lists the files and directories those have the text ‗P‘  
Output :  PM 

   President 

 
The grep Command 

$grep patternfile(s) 

A regular expression is either some plain text (a word, for example) and/or special 

characters used for pattern matching. 

The simplest use of grep is to look for a pattern consisting of a single word. It can be 

used in a pipe so that only those lines of the input files containing a given string are sent to the 

standard output. If you don't give grep a filename to read, it reads its standard input; that's the 

way all filter programs work. 

There are various options which you can use along with grep command – 

Option Description 

-v Print all lines that do not match pattern. 

-n Print the matched line and its line number. 

-l Print only the names of files with matching lines (letter "l") 

-c Print only the count of matching lines. 

-i Match either upper- or lowercase. 
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QUESTIONS AND ANSWERS 

I. Fill in the blanks 

1. Microsoft Windows is an Operating System.  

2. Minimize button reduces the windows to an icon and arranges it on the taskbar. 

3. Press and release of the primary mouse button is called Click. 

4. Drag is moving an item across the screen with the mouse. 

5. Date modified sorts the contents of a folder by date 

6. Ctrl+p pastes the copied content. 

7. Operating System is the first program to run on a computer when the computer boots up. 

8. An easy method to start WordPad is to use the Search box on the Start menu.  

9. Terminal is found in the Accessories of Applications.     

10. Linux is a Multi User Operating System.  

11. In Linux, to display the date and time date command is used. 

12. Currently logged in users are shown by who command. 

13. Command to create an empty file in Linux is touch. 

14. More command is filter for paging through text one screen at a time.  

15. Sort Command is used to arrange the data in a file.  

16. chmod is a Linux command, used to change the permissions of files or directories. 

17. To compare two files cmp and diff commands are used.  

18. The command used to append the contents of one file to another is cat.  

19. Currently running jobs can be lists using the ps command.  

20. The process can be terminated without logout is done by kill command.  
 

III. Choose the best answer 

1. Which is not an application software 

a. Linux b. Microsoft Word c. Photoshop d. Tally 

2. Recycle Bin is used to  

a.  Store the data temporarily  b. Store the deleted files 

c.  Save the hard disk space  d. Store the unwanted files 

3. What is the function of Windows Explorer? 

a. Save file b. Copy file  c. Delete file d. All of the above 

4. The process of creating copies of installed files is called  

a. Backup b. Restore  c. Format d. Scandisk 

5. What command is used to remove files? 

a. dm  b. rm   c. delete d. erase 
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6. What command is used to count the total number of lines, words, and characters contained 
in a file? 

a. countw b. wcount c. wc   d. countp 

7. Which of the following is a program group? 

a. Ms-Word b. Paint  c. Calculator  d. Accessories 

8. Which is the core of the Linux Operating System? 

a. Kernel b. Shell  c. Commands  d. Script 

9. What command is used to remove the directory? 

a. rmdir b. wcount c. wc   d. countp 

10. The command to add user in Linux is    . 

a. useradd b. adduser c. linuxconf  d. all the above 

11. What Linus Torvalds Created? 

a. Fedora b. Slackware c. Debian  d. Linux 

12. Which of the following command can you execute to count the number of lines in a file? 

a. lc  b. wc -l  c. cl   d. count 

13. Which command changes a file‘s group owner 
a. cgrp  b. chgrp c. change  d. group 

14. What does GNU stands for 

a. GNU's not Unix   b. Greek Needed Unix   

c. General Unix    d. General Noble Unix 

15. What command is used to list contents of directories? 

a. tar  b. dir  c. lp   d. ls 

16. Where should you click to change the desktop background? 

 a. Programs and features  b. Pesonalization 

 c. Windows update   d. User account 

17. How should you click to change the screen resolution? 

 a. go to Backup and restore  b. Device manager 

 c. go to Color management  d. Right click on the desktop 

III. Write answer in two or three lines 

1. Define OS. 

2. What are the functions of Operating System? 

3. What is an icon? 

4. What are the components of Linux? 

5. What is Recycle Bin? 

6. Define Backup. 

7. What is Kernel? 

8. How do you make a directory in Linux? 

9. Differentiate who and who am i in Linux. 

10. Explain about the cat command in Linux.  



 Venus Computers   Unit-2: Microsoft Windows & Linux 

 

58 

 

IV. Write answer in brief 

1. List and explain the types of Operating System. 

2. Explain some of the applications in Accessories of Windows. 

3. Write the steps to install a font in Windows 7. 

4. What are the controls used in Windows and explain any three of them? 

5. What are the parts of Windows? 

6. What are the features of Linux? 

7. What are the components of Linux? 

8. Write any six Linux commands. 

9. Explain the differences between cmp and diff command in Linux. 

10. What is the use of kill and merge command? 
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MICROSOFT WORD 
 

Introduction  

 The name Microsoft Office is self explanatory.  As you may have heard, 2007 Office is a 

major change from previous Office Versions. It is really a crucial application in the field of 

business where we can edit the texts to our necessity.  Many commands can be used just by a 

single click.  If you are new to Microsoft Office you will find 2007 very intuitive. When you click on 

something like an image, text or spreadsheet area, special Ribbons, customized to your 

selection, will appear to assist you. 

 Microsoft Office 2007 is a set of applications designed to work together.  It typically 

includes Microsoft Word, Microsoft Excel, Microsoft Access, Microsoft Power Point, Microsoft 

Outlook, Microsoft Publisher, Microsoft OneNote, Microsoft InfoPath and Microsoft Groove. 

 Let‘s go through an introduction to some of the new features of several office 
applications.  First, we will take you through the Microsoft Office Button, the Quick Access 

Toolbar, Ribbons, Tabs and Groups – to familiarize you with these common features. Then we 

will show you some of the unique Ribbons, Tabs and Groups of each application.  

 To open an application we may use any one of the following method. 
 

Method 1:  

Double click on the application icon on the Windows Desktop 
 

Method 2:  

Click Start Button which is in the left corner of the screen, then click All Programs, move 

the cursor over Microsoft Office and Select the application you desire. 

 

MICROSOFT WORD 

Applications of Word Processing 

1. Letter, Resumes & Faxes 

2. News & Articles 

3. Memos 

4. Booklets 

5. Thesis Work 

6. Mail Merge 

7. Brochures 

8. Envelopes 

9. Web pages, etc. 
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Basic concepts of Word Processing 

 After typing the text in the document you also use various commands to format it in the 

desired manner. You can check the computer screen for errors and correct them. The word 

processing program can normally help to correct mistakes. 
 

The main concepts of word processing are 

1. Choosing the appropriate font to the text. 

2. Choosing the style bold, italic or underlined. 

3. Select appropriate alignments either left, right, center or justify depending on the necessity. 

4. Choose appropriate space in between lines, words and paragraphs. 

5. Make spelling and grammar corrections. 

6. Preview the designed document before taking printout. 

7. Finally print the document. 

Starting Word 

 To start the Word program, follow these steps: 

1. From the Windows Desktop, click Start then point at Programs.  

2. Click Microsoft Office program group. 

3. Click Microsoft Word 2007 

4. Now the Word application window is opened. 

 Microsoft Word is an efficient and full-featured word processor that provides you with all 

the tools you need to produce a tremendous variety of document types - everything from simple 

documents such as memos and outlines to complex documents such as newsletters and internet 

- ready HTML pages. You create your Word documents in the Word window which provides you 

with easy access to all the tools you need to create all your documents. 

In Microsoft Word every file is called as Document. In Microsoft Word 2007 the 

documents are saved with the extension .docx whereas in older versions it saved as .doc.  
 

Ribbon  

The Ribbon is designed to help the user to find the commands that need to complete a 

task. There are three basic components to the Ribbon.  It‘s good to know what each one is called 

so that user understands how to use it. 

The three parts of the Ribbon are tabs, groups, and commands. 

1. Tabs. There are seven basic ones across the top. Each represents an activity area. 

2. Groups. Each tab has several groups that show related items together. 

3. Commands. A command is a button, a box to enter information, or a menu. 
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By default the Home, Insert, Page Layout, References, Mailings, Review and View Tabs 

are found in the Ribbon. To reduce confusion, some tabs are shown only when needed. For 

example, the Picture Tools Tab is shown only when a picture is selected.  

1. Select the picture. 

2. The Picture Tools tab appears. Click that tab. 

3. Additional groups and commands appear for working with pictures; like the Picture 

Styles group. 

When you click away from the picture, the Picture Tools tab disappears, and the other 

groups come back. 
 

Quick Access Bar 

The Quick Access Toolbar is the small area to the upper left of the Ribbon. It contains 

the things that you use over and over every day: Save, Undo, and Repeat. You can add your 

favorite commands to it so that they are available no matter which tab you are on. 

Click Play to see an animation showing how to add, and remove, a button to the Quick 

Access Toolbar.  
 

Mini Toolbar 

When you select text and point at it, the Mini toolbar will appear faded. Some formatting 

commands are so useful that you want to have them available whatever you are doing. 

Let's say you want to quickly format some text, but you're working on the Page 

Layout tab. You could click the Home tab to see the formatting options, but here's a faster way: 

1. Select your text by dragging with your mouse, and then point at the selection. 

2. The Mini toolbar will appear in a faded fashion. If you point to the Mini toolbar, it will become 

solid, and you can see the tool. 

 

 

 

 
 

Office Button        Tabs              Title Bar   Ribbon  

             Quick Access Bar 

 
                  Group                 Ruler 

 

   

Mini Toolbar 
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 Some of the shortcut keys for Microsoft Word are listed below: 

Action Keyboard shortcut 

Bold Ctrl-B 

Bookmarks Ctrl-Shift-F5 

Break-column Ctrl-Shift-Enter 

Break-page Ctrl-Enter 

Browse next/previous item Ctrl-PgDn/PgUp 

Capatilize word Shift+f3 

Case-All Caps Ctrl-Shift-A 

Close Ctrl-F4 / Ctrl + W 

Copy Ctrl + C 

Copy formatting Ctrl-Shift-C 

Cut Ctrl-X 

Decrease font size CTRL+SHIFT+< 

Exit application Alt-F4 

Find Ctrl + F 

Font Ctrl-D 

Font Style Ctrl-Shift-F 

Font grow/shrink 1 pt Ctrl- ] or [ 

Font next/previous size Ctrl-Shift- >or < 

Font Size  Ctrl-Shift-P 

Footnote Ctrl-Alt-F 

Create a new blank document Ctrl + N 

Go Back Ctrl-Alt-Z / Shift-F5 

GoTo Ctrl-G 

GoTo Next/Previous Paragraph Ctrl-Up/Down 

GoTo Next/Previous Word Ctrl-Left/Right 

Hanging indent-decrease Ctrl-Shift-T 

Hanging Indent-increase Ctrl-T 

Help F1 

Hyperlink Ctrl-K 

CTRL+SHIFT+> Increase font size 

Indent-decrease Ctrl-Shift-M 

Indent-increase Ctrl-M 

Italics Ctrl-I 

Center Align  Ctrl-E 

Justify-Full Ctrl-J 

Left Align Ctrl-L 

Right Align Ctrl-R 
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Line-spacing Single Ctrl-1 

Line-spacing 1.5 Ctrl-5 

Line-spacing Double Ctrl-2 

Maximize window Ctrl-F10 

Menu Bar F10 

Newline within paragraph Shift-Enter 

Next window Ctrl-F6 

Open a document Ctrl-O 

Page number field Alt-Shift-P 

Paste Ctrl-V 

Print Ctrl-P 

Print Preview Ctrl-Alt-I 

Redo the last action CTRL+Y 

Remove menu item Ctrl-Alt - 

Repeat the last command Ctrl-Y 

Replace Ctrl-H 

Save As F12 

Save Ctrl-S 

Select All Ctrl-A 

Selection extended F8 

Selection reduced Shift-F8 

Small Caps Ctrl-Shift-K 

Spelling and Grammar check F7 

Split a window Ctrl-Alt-S 

Style box Ctrl-Shift-S 

Subscript Ctrl = 

Superscript Ctrl + = 

Symbol Font Ctrl-Shift-Q 

Table-remove border lines Ctrl-Alt-U 

Thesaurus Shift-F7 

To bottom of the Screen  Ctrl-Alt-PgDn 

To top of the Screen  Ctrl-Alt-PgUp 

underline CTRL+U 

Underline-double Ctrl-Shift-D 

Underline-word Ctrl-Shift-W 

Undo Ctrl-Z 

View-Normal Ctrl-Alt-N 

View-Outline Ctrl-Alt-O 

View-Page Ctrl-Alt-P 
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Office Button 

The user interface has been significantly 

redesigned in the following 2007 Microsoft Office 

system programs: Word, Excel, PowerPoint, 

Access, and Outlook. The Microsoft Office Button 

replaces the File menu and is located in the upper-

left corner of these Microsoft Office programs. 

When the user clicks the Microsoft Office 

Button  user can see the same basic commands 

available in earlier releases of Microsoft Office to 

open, save, and print your file. 

 
Starting a New Document 

 Click the Microsoft Office button. 

 Select New. The New Document dialog box 

appears. 

 Select Blank document under the Blank and recent section.  

 Click Create.  

A new blank document appears in the Word window. You can also get a new file by 

pressing Ctrl+n. To get templates that are installed on your computer or on Office Online, click 

the Microsoft Office button and select New. Then select the templates from the dialog box that 

appears. 

 
Opening (Ctrl+o) 

 Opening an existing document 

is a straightforward process.  You will 

find that the Open dialog box shares 

many of the attributes that you saw in 

the Save-As dialog box. To open an 

existing Word file, follow these steps: 

 Click Open button from the Office 

Button or press Ctrl+o.  The Open 

dialog box appears. 

 Click the Look In drop-down arrow 

to select the drive on which the file 

is located. The folders on the drive 

appear. 
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 Locate the driver and folder where the file is stored already.  

 To open the file, click the file then click Open button. The file appears in a word document 

window. 

 

 Saving (Ctrl+s) 

 Saving your work is one of the 

most important aspects of working with 

any software application.  If don‘t save 

your Word documents, you will lose all 

your hard work when you exit the Word 

application. To save a document, follow 

these steps: 

 Click Save button on the Office Button or select the File menu then Save or press Ctrl + S.  

The first time you save your document, the Save As dialog box will appear. 

 Type a filename into the File Name box. If you wish to save the file in a format other than a 

Word document, click the Save as Type drop-down arrow and select a different file type. 

 To save the file to a different location, click the Save In drop-down arrow.  After you select 

a particular drive, the folders on that drive will appear. 

 Double-click folder in which you want to save in the Save In box to open the folder. 

 After you have specified a name and a location for your new document, select Save button 

to save the file.  You will return to the Word document window. 

As you edit and enhance your new document, you will want to save changes that you 

make. To save changes to a document that has been saved under a filename, just click the Save 

button. 

 

Printing (Ctrl+p) 

Click on the Office Button, move your mouse down to the ‗Print‘ option, make your 

choice between ‗Print‘, ‗Quick Print‘, and ‗Print Preview‘. 

Clicking on Print will display the print dialog box, where you can select things like the 

printer, the number of copies, and what pages you want to print.  Once you have selected all 

your options, you can click OK, and Word will send the document to the printer. 

Quick Print will print one copy of the document with the default printing settings – so if 

you have more than one printer set up on your computer, it will print to the one you have marked 

as default. 
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 Clipboard 
 Font 
 Paragraph 
 Styles 

 Editing 
 

The above listed items are groups found in Home Tab. 

  

Print Preview will display how the document would look if you were to print it on paper.  

Print preview is a great way to check if your document will look as professional as you want it to 

look! 

 
 
HOME TAB (Alt+h) 

CLIPBOARD GROUP 

 This clipboard group is found in the Home Tab. To cut or copy or 

paste the selected text to another page or another document or another 

application, clipboard group is very useful.  Icons for Cut, Copy, Paste and 

Format Painter are in the clipboard group. 
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Copy (Ctrl+C) 

 To copy anything (text or table or image) from the word document. Select the content 

and click the copy icon  from the Clipboard or press Ctrl+C. 
  
Paste (Ctrl+V) 

To paste the content, click the cursor on the place where the user need to paste and 

click the paste icon  from the Clipboard or press Ctrl+V. 
 
Cut (Ctrl+X) 

To cut anything (text or table or image) from the word document. Select the content and 

click the cut icon  from the Clipboard or press Ctrl+V. This option deletes the content from the 

source and keeps the same in the clipboard whereas the copy command retains the contents in 

the source and clipboard. 
 

Format Painter 

User can use the Format Painter on the Home tab to apply text formatting and some 

basic graphics formatting, such as borders and fills. 

 Select the text or graphic that has the format that the user wants to copy. (Select a 

portion of a paragraph to copy text format, where select entire paragraph to copy text 

and paragraph format)  

 Click Format Painter in the Clipboard group of the Home Tab. 

 Then select the Text or graphic that the user wants to format.  

To apply the format to multiple selects in the document, user needs to double click the 

Format Painter while Selection and to stop the Formatting press ESC. 
 

FONT GROUP 

 The font group in the Home Tab has options to change font, font size, bold and italic the 

selected text. User can change their text as their choice.  
 

To change the font (Ctrl+shift+f) 

1. Select the text in the document. 

2. Click the down pointing arrow-head in the Font 

box. A drop down menu of fonts will appear. 

3. Select anyone Font from the list to change the text to 

selected font. 

 

 

 

               Font                   Font Size     Grow Font 
 

 
 
 Bold       Italic  Underline                Change  
                              Case 
                         Superscript    Subscript       Font Color            

Font Group of Home Tab 
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To change the font size (Ctrl+shift+p) 

1. Select the text in the document. 

2. Click the down pointing arrow-head in the Font Size box. A drop down menu of font size will 

appear. 

3. Select anyone Font Size from the list or type the desired size, and change the text to 

selected font. 

4. You could also change font size using the Grow Font & Shrink Font buttons in the Ribbon.  
 

Example 

Font Name 
Font Size 

8 10 12 14 16 

Arial Chennai Chennai Chennai Chennai Chennai 

Times New Roman Chennai Chennai Chennai Chennai Chennai 

 

Normal Bold Italic Underline 

Chennai Chennai Chennai Chennai 

 
Superscript (Ctrl + shift + =) and Subscript (ctrl + =) 

 Like Bold, user can add superscripts & subscripts to the text. Mostly these are used in 

the creation of Mathematical functions and  
 

Example: 

  (a+b)
2
 = a

2
 + b

2
 + 2ab 

 (NH4)2Cr2O7 

 
Change Case (Shift + F3) 

 The typed text can be modified into various cases like Upper, Lower, etc. by using the 

Change Case in Font group of Home tab.  

 Sentence Case: Capitalize the first letter of each sentence. 

 UPPER CASE : Make all the letters to capital  

 lower case: Makes all the letters to small. 

 Capitalize Each Word: Capitalize the first letter of each word to capital 

 tOGGLE cASE: Capitalize all letters of the word except first letter. 

 
PARAGRAPH GROUP 

 The paragraph group consists of 

bullets & numbering, indentation, sort, 

paragraph symbol, alignment, line spacing, 

shading and borders.  
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 Word 2007 gives you the option of 

placing the text in four different alignments.  

These are Left, Center, Right and Justify. 

The Shortcut key for left align is (Ctrl+L), 

center align is (Ctrl+E), right align is 

(Ctrl+R) and for Justify is (Ctrl+J). But the 

justify alignment can be seen only in 

Paragraph. If the text aligned with justify 

shows the text in left align format only. 
 

Line Space 

 User can set the space between 

the lines of a paragraph from the given line 

spaces of single (Ctrl+1), 1.5 lines (Ctrl+5), 

double (Ctrl+2), atleast, exact and multiple. 

 

 

 

Bullets and Numbering 

Bullets and numbering is used whenever we 

need to have texts or sentences in listed form.  Bullets 

are the symbols shown before the items listed, 

whereas in Numbering method listed items are shown 

in various styles like 1, 2, 3 . . . (or) I, II, III . . ., (or)             

a, b, c, ….  
 

Indentation 

  The beginning of a paragraph can be indented 

at any point, using increase indent and decrease 

indent.   
 

Sort 

 This option is available in Paragraph group of Home Tab. This is used to arrange the list 

of items in ascending and descending order.  
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STYLES GROUP 

Styles option in word allows the user to 

format a document with a consistent and 

professional look. User can save the style created 

by own and can be used in various documents. By 

default Microsoft word have many predefined 

styles like, Normal, Heading1, Subtitle, Title, etc. It 

is one of the most useful tool to keep various 

styles in different names to align a book, 

magazine, etc. 

 

 
 

EDITING GROUP 
 
Find & Replace  

 
 

 Find (Ctrl+F) command in Editing Group is used to find any text in the document and 

replace it with the given text.   Ctrl+H is the short cut for Find and Replace. Go To command is 

also found in Find and Replace Dialog Box, which is used to go to particular page, section, 

footnote, etc. Ctrl+G is the short cut for Go To command. 

 
INSERT TAB (Alt + n) 

 Insert tab contains seven groups which are Pages, Tables, Illustrations, Links, Header & 

Footer, Text and Symbols. These groups are used to insert things like, Table, Picture, Clip Art, 

Shapes, Page Number, Header & Footer, Word Art, Symbols, Equations, etc. 
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 Let‘s discuss about some of the above mentioned groups separately. 
 

Tables  

Creating a Table 

 To create a table, go to Insert Tab and 

click Table Icon in Tables Group. Then click 

insert table and enter the required number of 

columns and rows in the respective places and 

click OK.  

 
  

Whenever the cursor is inside the table, two new tabs (Design, Layout) appear in the 

Ribbon under the name Table Tools. With the help of these two tabs user can apply these to a 

table: Insert row, Insert column, merge cells, split table, text direction, formula, Borders, 

Shadings, Table Styles, etc. 
 

Illustrations  

Illustrations Group contains five tools which are Picture, Clip Art, Shapes, Smart Art, and 

Chart. These groups are used to insert things like, Table, Picture, Clip Art, Shapes, Page 

Number, Header & Footer, Word Art, Symbols, Equations, etc. 
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Inserting a Picture 

To insert a picture, click on the Picture icon. A dialog box appears, as shown in the 

figure.  

 

 Now user can select the picture and click Insert. 
 
Clip Art 

 Clip Art tool contains certain pictures which are available in all the Microsoft Office 

Applications. User can insert the necessary picture wherever required. 
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Shapes 
 

 Using the Shapes tool, shapes like 

rectangle, circle, arrow, line, braces, stars, block 

arrows, etc. can be drawn. 

 

Links 

 Hyperlink, Bookmark, Cross-reference 

are found in Links Group.  Hyperlink is used to 

link any files, websites, pages in the same 

document and so on.  Bookmark is used to add a 

bookmark in the document. 

 

 

Header & Footer 

 Header and footers are used in printed 

documents.  You can create headers and footers that include text or graphics – for example, 

page numbers, the date, a company logo, the document‘s title or file name, or the author‘s name. 

A header is printed in the top margin; footer is printed in the bottom margin. You can use the 

same header and footer throughout a document or change the header and footer for part of the 

document.   
 

Adding header and footer 

To add a header or footer, follow these 

steps: 

Go to Insert Tab, select Header and then 

Edit Header Tool.  You will temporarily be switched to 

the Print Layout mode and placed in the header area 

of the document.  The regular text area is dimmed 

and unavailable while you work in the header or 

footer box. To add a footer follow the same steps as 

for the header but use footer tool instead of header.  

       Note : User can switch between Header and 

Footer. 
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Text 

 The Text group includes Text Box, Quick Parts, Word Art, Drop Cap, Signature Line, 

Date & Time and Object. Text Box and WordArt Tools are used for graphical and Design works.  

 
 
 
 
 

Symbols & Equations 

 Symbols and Equations, which 

cannot be typed, can be inserted through 

Symbol & Equation Tool in Symbols group. 

 These two tools are especially used 

for Mathematical and Chemical equations and 

formulae like  

 

 

PAGE LAYOUT TAB (Alt + p) 
 

 

 There are five groups in Page Layout Tab namely Themes, Page Setup, Page 

Background, Paragraph and Arrange. Let‘s discuss some of the frequently used groups in Page 

Layout Tab.  
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Page Setup 

 The Page Setup Group includes the 

tools which are Margins, Orientation, Size, 

Columns, Breaks, Line Numbers and 

Hyphenation.  

 By clicking the small arrow at the 

bottom right corner of the Page Setup 

group, Page Setup dialog box appears.   

Using this dialog box paper size, margins 

and orientation of the currently working 

document can be set. 

Some of the paper sizes which are 

used professionally are Letter, A4 and 

Legal.  

Portrait and Landscape are the two 

orientations in Microsoft Office. Portrait sets 

the paper in vertical whereas landscape sets 

to horizontal. In a document both portrait 

and landscape orientation shall be set.  

 

 

Columns 

 Column is used to align the texts 

of the document column-wise (single, 

double or any).  Spaces can be set 

between columns as required. It can be 

set either to a part of a document or to the 

whole using the Apply to in the Column 

dialog box. This tool is effectively used in 

making notices, brouchers and 

newspapers.  

 

 

Page Background 

 Watermark, Page Color and Page Borders tools are in the Page Background Group.   
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Watermark 

Watermark is a tool that is used to add a faded text or image at the background of a 

document. 
 

Page Border 

Document can be bordered using the Page Border tool, which can even be applied to 

particular pages.  
 

 

REFERENCES TAB (Alt + s) 

 

 References Tab contains the groups namely, Table of Contents, Footnotes, Citations & 

Bibliography, Captions, Index and Table of Authorities. 

 
MAILINGS TAB (Alt + m) 

 
 

 This Tab includes Create, Start Mail Merge, Write & Insert Fields, Preview Results and 

Finish groups. 
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Mail Merge 

Mail merge is a tool which allows you to create form letters, 

mailing labels and envelopes by linking a main document to a set 

of data stored in a list, database, or spreadsheet.  
 

To use Mail Merge: 

 Select the Mailings on the Ribbon. 

 Select the Start Mail Merge command. 

 Select Step by Step Mail Merge Wizard. 

 

The Mail Merge task pane 

appears and will guide you 

through the six main steps to 

complete a merge. You will 

have several decisions to make 

during the process. The 

following is an example of how to create a letter and merge the 

letter with a data list. 

 

Steps 1-3 

 Choose the type of document you want to create. In this example, 

select Letters. 

 Click Next: Starting document to move to Step 2. 

 Select Use the current document. 

 Click Next: Select recipients to move to Step 3.  

 Select the Type a new list button. 

 Click Create to create a data source. The New Address List dialog 

box appears. 

 Enter the necessary data in the New Address List dialog box. 

 Click New Entry to enter another record. 

 Click Close when you have entered all of your data records. 

 Enter the file name you want to save the data list as. 

 Choose the location where you want to save the file. 

 Click Save. The Mail Merge Recipients dialog box appears and 

displays all of the data records in the list. 

 Confirm that the data list is correct, and click OK. 

 Click Next: Write your letter to move to Step 4. 



 Venus Computers   Unit-3: Microsoft Word 

 

80 

 

 

Step 4 

 Write a letter in the current Word document. 

 To insert recipient data from the list: 

 Place the insertion point in the document where you 

want the information to appear. 

 Select Address block, Greeting line, or Electronic 

postage from the task pane. A dialog box with options 

will appear based on your selection. 

 Click Next: Preview your letters in the task pane once 

you have completed your letter. 

 

Step 5 

 Preview the letters to make sure the information from 

the data record appears correctly in the letter. 

 Click Next: Complete the merge. 
 

Step 6 

 Click Print to print the letters. 

 Click All, to merge all the records whereas you can 

merge the letter to current record, like that you can merge selective records by 

entering from and to value. 

 Click OK in the Merge to Printer dialog box.  

 If you don‘t want print the letter immediately, you may save in a separate document  
by selecting Edit Individual Letters.  

The Mail Merge Wizard allows you to complete the merge process in a variety of 

ways. The best way to learn how to use the different functions in Mail Merge is to try to 

develop several of the different documents—letters, labels, and envelopes—using the 

different types of data sources. 

 
REVIEW TAB (Alt + r) 

 

 Review tab contains six groups namely Proofing, Comments, Tracking, Changes, 

Compare and Protect.  Let‘s discuss about some of the significant groups found in this tab. 
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Proofing 

Spelling & Grammar, Research, Thesaurus, Translate are the four tools available in 

Proofing group. 
 

Spelling & Grammar (F7) 
 

 
 

 Spelling & Grammar is used to correct the grammatical and/or spelling mistakes present 

in the document. If any unwanted mistakes are shown in the document, they can be ignored by 

using Ignore Once or Ignore Rule. You can add any word into the Microsoft Dictionary by clicking 

the button add to Dictionary. But before adding you need to verify that word is correct. 
 
VIEW TAB (Alt + w) 

 

 This tab is used to view the document in different views such as Print Layout, Full 

Screen Reading, Web Layout, Outline and Draft.   

 The next group in the View Tab that we will look at Show/Hide group.  Using this group, 

you can turn on options like the Ruler, Gridlines, Document Map and Thumbnails.  The Ruler 

displays on the left and top sides off your document and uses inches as measurement by default 

and it can be modified to various measuring units.   
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Using the Document Map in Show/Hide Group you can navigate to different areas by 

clicking on the heading in the document map. 

 Zoom option in the Zoom Group helps us to maximize or minimize the view size of the 

document content. It never changes the font size of the content.  

Window group essentially lets you work on the same document utilizing different views 

and windows.  When you select the New Window option, it will open a new window containing 

the same document.  This can be useful if you need to see two different sections of the same 

document at the same time. 

The last option under the View Tab is Macros option. Macros are useful in re-enabling a 

certain order of tasks that you may perform commonly. For example, if you add a title, heading, 

your name and date to almost every document that you put together, it makes sense to add 

these steps to a Macro and then run it every time you start a new document. 
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OPEN OFFICE - WRITER 
Introduction  

Open Office is a stable, high quality, robust, freely available software, which is developed 

by a community of very talented volunteer programmers to provide a leading multi-lingual, multi-

platform, fully functional Office for everyone.   It is developed by Sun Microsystems and available 

in many languages. It works on various Operating Systems like Windows, Solaris, Linux, 

Macintosh (Mac), etc. It is the Office Suite for Word Processing, Spreadsheets, Presentations, 

Databases and Drawings.  

Open Office files created by Writer‘s document, Calc‘s spreadsheets, Presentation of 
Impress, database of Base can be opened through Microsoft Word, Excel, PowerPoint, and 

Access respectively. 
 

Launching Open Office in Linux 
 

 

 

 Go To Office in Applications, Click Open Office. The above shown window will appear. 

Any Suites of Open Office can be opened from this Window.  

 All Open Office Suites can also be opened from Applications and All Programs of Start 

Menu in Linux and Windows respectively. 

 

 
 

Note:    Most of the commands in Open Office Writer, like Open, Save, Save As, 

Print, Spell Check, etc. are same as that used in Microsoft Office Word. 

But these commands are inside menus in Open Office Writer. 
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Applications of Open Office 

Open Office Writer 

 Writer is a useful tool for creating documents, newsletters, books, reports, letters, 

brochures, and others. In this Writer user can insert graphics and objects from other 

components. Like that user can export files to HTML, XHTML, XML, Adobe‘s Portable Document 
Format (PDF), and several versions of Microsoft Word files. 

 

File Menu (Alt + f) 

File contains commands that apply to the 

entire document such as Open, Save, Save As, Export 

as PDF, Page Preview and Print.   

 The New opens any suites of Open Office. 

Wizards contain readymade Letter, Fax, 

Agenda, Presentation and Web Page  

You can save a document by clicking save 

found in File Menu. Save As command saves the 

document in different name and / or at different place.  

 An existing file of Writer can be exported as 

XHTML, PDF, JPEG, XML and PNG formats through 

Export. Export as PDF is used only to export a 

document in PDF format. 

 Print is also found in this menu, and is used to 

print a Document.  
  

Edit Menu (Alt + e) 

 Cut, Copy, Paste, Selection Mode, Select All, 

Find & Replace, AutoText is found in Edit Menu. The 

shortcuts for these commands are same as those in 

MS Office Word and are listed below: 
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Find and Replace 

 
 

 Find command in Edit Menu is used to find any text in the document and replace it with 

the given text.  Ctrl+f is the short cut for Find and Replace.  
 

View Menu (Alt + v) 

 The Print and Web Layout commands in the 

View menu, controls the onscreen display of the 

Document. Toolbars contains the tools provided by 

the Open Office the required tools can be activated to 

show in the screen. Status Bar, Ruler, Text 

Boundaries can be activated from the View Menu so 

that they are visible in the working screen. Zoom is 

used to change the view size of the screen.  
 

 Text Boundary is an option available both in 

Microsoft Word and Open Office Writer, which is used 

to show the boundary line to the content of the 

document.  
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Insert Menu (Alt + i) 

 It is one of the most of useful Menu in Open Office that is used to insert anything that 

cannot be typed manually, like pictures, symbols, table, frames, movies, etc.  Hyperlink is used to 

link any files, websites, E-Mail and pages in the same document.  Bookmark is a mark that is 

used to move the cursor to the required page in the document instantly. 

 Header and footers are also found in this menu which is similar to that found in Microsoft 

Office Word.  Movie and Sound is an additional feature that is found in Microsoft Office Word and 

is used to insert any movie or sound in the Writer document.  
 

Format Menu (Alt+O) 

 Format is designed 

to align the content of the 

document.  Font, Font Size, 

and Style can be applied to 

the content using the 

Character Dialog Box. 

 Some of the 

commands in the Paragraph 

are discussed below. 

Alignment (settings 

like left, center, right and 

justify), Indentation (spacing 

before and after text), 

Spacing (spacing between 

paragraphs), Line spacing 

(spacing between lines), Tabs, Drop Caps, Borders, are found in the Paragraph Dialogue Box. 

 Bullets and Numbering is used to list out the contents in separate points using different 

symbols or number formats. 

 The functions of Columns and Change Case in Open Office are similar to that found in 

Microsoft Word. 

 Anchor, Wrap, Alignment, Arrange, Flip, Rotate and Group can be used only to objects.  

The Anchor in the format menu attaches the objects like image, symbols, etc. with the 

page, paragraph and character.  
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Wrap is used to wrap the objects around the text in the desired manner. Alignment, 

found in the format menu, is used to align the objects. 

 

Table Menu (Alt + a) 

 Table menu is specifically used only for creating, editing and deleting tables. Using the 

special command, Protect Cells found in the Table Menu, the cell can be made readable only.  

 Using Convert command, either a table can be converted to Text or any text can be 

converted to a table.  
 

 

 

 

 Formula is used to get the mathematical results of the data that are in the table. The 

results for the formula types will be shown in the text area. 
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Tools Menu (Alt + t) 

 Spelling and Grammar, Language, Word Count, Outline Numbering, Line Numbering, 

Gallery, Mail Merge Wizard, Macros, etc. are found in Tools Menu. Spelling and Grammar is 

used to check the grammatical errors of the content.   

 

 
 
 
 
Help Menu (Alt + h) 

 User can get any details about the tools found in the Open Officer Wirter using the Help 

Menu.  
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Some of the short cut keys for Open Office Writer 

Shortcut Keys Effect 

Ctrl+A Select All  

Ctrl+J Align Justify  

Ctrl+D Double Underline  

Ctrl+E Align Centre 

Ctrl+F Find and Replace  

Ctrl+Shift+P Superscript  

Ctrl+L Align Left  

Ctrl+R Align Right  

Ctrl+Shift+B Subscript  

Ctrl+Y Redo last action  

Ctrl+0 (zero) Apply Default paragraph style  

Ctrl+1 Apply Heading 1 paragraph style  

Ctrl+2 Apply Heading 2 paragraph style  

Ctrl+3 Apply Heading 3 paragraph style  

Ctrl+5 1.5 Line Spacing  

Ctrl+Hyphen(-) Custom hyphens; hyphenation set by you  

Shift+Enter Line break without paragraph change  

Ctrl+Enter Manual page break  

Ctrl+Shift+Enter Column break in multi-columnar texts  

Alt+Enter Inserting a new paragraph directly before or after a section or a table  

Arrow Left Move cursor to left  

Shift+Arrow Left Move cursor with selection to the left  

Ctrl+Arrow Left Go to beginning of word  

Ctrl+Shift+Arrow Left Selecting to the left word by word  

Arrow Right Move cursor to right  

Shift+Arrow Right Move cursor with selection to the right  

Ctrl+Arrow Right Go to end of word  

Ctrl+Shift+Arrow Right Selecting to the right word by word  

Arrow Up Move up one line  

Shift+Arrow Up Selecting lines in an upwards direction  

Arrow Down Move cursor down one line  

Shift+Arrow Down Selecting lines in a downward direction  

Home Go to beginning of line  

Shift+Home Go and select to the beginning of a line  
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End Go to end of line  

Shift+End Go and select to end of line  

Ctrl+Home Go to start of document  

Ctrl+Shift+Home Go and select text to start of document  

Ctrl+End Go to end of document  

Ctrl+Shift+End Go and select text to end of document  

Ctrl+PageUp Switch cursor between text and header  

Ctrl+PageDown Switch cursor between text and footer  

Insert Insert mode on/off  

PageUp Screen page up  

PageDown Move down screen page  

Shift+PageUp Move up screen page with selection  

Shift+PageDown Move down screen page with selection  

Ctrl+Backspace Delete text to beginning of word  

Ctrl+Shift+Del Delete text to end of sentence  

Ctrl+Shift+Backspace Delete text to beginning of sentence  

Ctrl+Tab Next suggestion with Automatic Word Completion  

Ctrl+Shift+Tab Use previous suggestion with Automatic Word Completion  

Alt+W Spell checker dialog: Call back the original unknown word into the text box  

Ctrl+ double-click or 
Ctrl+Shift+F10 

Dock or un-dock the Navigator, Styles and Formatting window, or other 
windows  

 



 Venus Computers   Unit-3: Open Office - Writer 

 

91 

 

QUESTIONS AND ANSWERS 
 

I. Fill in the blanks 

1. Insert mode is the default text mode in MS-WORD 

2. Page set-up command is available in Page Layout tab. 

3. The Microsoft Word 2007 documents are saved with extension .docx. 

4. Change Case command is used to change text between uppercase and lowercase. 

5. Ctrl+p in the shortcut menu to choose print option. 

6. Two types of page orientation are Portrait and Landscape 

7. When you type new text Overtype mode replacing existing text. 

8. You can use Undo to reverse more than one change 

9. Save as command is used for saving the active document with a different name. 

10. Maximum zooming in word is 500 

11. The red wave underline is MS Word document indicates Spelling Mistakes. 

12. The short cut key for pasting copied contents in a document in a Microsoft Word is Ctrl+V. 

13. The short cut to align left is Ctrl + L. 

14. The short cut Ctrl + Enter is used to break manually in Open Office Writer. 

II. Choose the best answer 

1. Which icon represents the center alignment 

a)   b)   c)   d)  

2. Document is used in  

a) PowerPoint b) Word c) Excel d) Impress 

3. This key is used to Spell Check 

a) F7  b) F5  c) F2  d) F12 

4. Current page number, section number are displayed in  

a) Title bar b) Ruler c) Menu Bar d) Status Bar 

5. This key is used to select entire document 

a) Ctrl + X b) Ctrl + U c) Ctrl + A d) None 

6. Portrait in Open office is  

a) Margin b) Paper Size c) Orientation d) None 

7. Which of the following is not a font style? 

a) Bold  b) italics c) Regular d) Superscript 
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III. Say true or false 

1. Restore command is used to copy the files.      (F) 

2. Ms-Word is used to prepare spreadsheets.      (F) 

3. Delete key deletes one character to left      (F) 

4. We can change the margins in Print Preview      (T) 

5. We can undo only the last action       (F) 

6. Header and Footer option is available in Insert Menu     (T) 

7. Borders can be applied to Cells, Paragraph and Text.    (T) 

8. The Green wave underline is MS Word document indicates Grammar Mistakes. (T) 

 

IV. Write answer in two or three lines 

1. What are the packages available in Ms-Office? 

2. Write short notes on Header and Footer. 

3. Write the procedure to copy a text from one location to another location. 

4. Define Mail Merge. 

5. Write about change case in Microsoft Word. 

6. What is the use of Print Preview? 

7. How do you create a table in Open Office Writer? 

 

V. Write answer in brief 

1. Explain the steps for creating mail merge in Microsoft Word. 

2. Explain about Home tab in Ms-Word 

3. List the packages available in Open Office and give its uses. 

4. Write the steps to find and replace a text in the word document. 

5. List and explain the options found in Microsoft Office Button. 

6. Explain Spelling and Grammar in Open Office Writer. 

7. Write the steps to change the page size and margins in Writer. 

8. Write the steps to insert a clipart in the Word document. 

9. Write in detail about the page setup of Open Office Writer. 
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MICROSOFT EXCEL 
 
Introduction 

 Microsoft Office Excel 2007 is modified Step by Step from their older versions. Now it is 

Simple, Faster and Smarter. 

Getting started with Excel 2007 you will notice that there are many similar features to 

previous versions.  You will also notice that there are many new features that you‘ll be able to 
utilize.  There are three features that you should remember as you work within Excel 2007: the 

Microsoft Office Button, the Quick Access Toolbar, and the Ribbon.  The function of these 

features will be more fully explored below. Microsoft Excel is a very powerful tool for you to use 

for numeric computations and analysis. Excel can also function as a simple database but that is 

another class.  
 

Applications of Excel 

 Budgeting 

 Annual reports of business firms. 

 Income statement and Income tax calculations. 

 Banking Calculations. 
 Cost Analysis and Production and Marketing analysis etc. 

 
Features of Excel  

 User friendly spreadsheet program. 

 Automatic number formatting, Summation, Worksheet formatting. 

 Built-in spell checking. 

 High performance Chart and Graphs. 

 Easier entry of range references in dialog boxes. 

 Row and column headings indicate the active cell. 

 Better drag-and-drop editing. 
 
Workbook 

Excel file is a Workbook, which is a collection of worksheets (spreadsheets). By default, 

Excel has 3 worksheets in a new workbook. The worksheets are designated at the bottom part of 

the window where you see the file folder-like tabs. The tabs are named Sheet1, Sheet2, and 

Sheet3. If you click on Sheet2, you will be in Sheet2 and not Sheet1 so you need to be aware of 

which worksheet you are in. 
 

Spreadsheets 

 A spreadsheet is an electronic document that stores various types of data.  There are 

vertical columns and horizontal rows.  A cell is where the column and row intersect.  A cell can 
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contain data and can be used in calculations of data within the spreadsheet.  An Excel 

spreadsheet can contain workbooks and worksheets.   

Some basic information about the Worksheet 

Rows in a worksheet 1 to 1048576 

Columns in a worksheet A to XFD (16384) 

First cell of a worksheet A1 

Last cell of a worksheet XFD1048576 

Total number of cells in a worksheet 17179869184 

Maximum characters per cell 255 

Microsoft Office Button 

The Microsoft Office Button performs many of the functions that were located in the File 

menu of older versions of Excel.  This button allows you to create a new workbook, Open an 

existing workbook, save and save as, print, send, or close. 

Office Button     Quick Access Toolbar       Tabs          Title Bar                Ribbon                 Minimize         Maximize     Close 
 

 

Columns 

Rows 

Active Cell 

Active Cell Name Formula Bar 

Scroll Bar 

Sheet Tabs 
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  Mini Toolbar 

Ribbon 

 The ribbon is the panel at the top portion of the document   It has seven tabs:  Home, 

Insert, Page Layouts, Formulas, Data, Review, and View.  Each tab is divided into groups.  The 

groups are logical collections of features designed to perform function that you will utilize in 

developing or editing your Excel spreadsheets.  

Commonly utilized features are displayed on the Ribbon.  To view additional features 

within each group, click the arrow at the bottom right corner of each group. 

Home : Clipboard, Fonts, Alignment, Number, Styles, Cells, Editing 

Insert  : Tables, Illustrations, Charts, Links, Text 

Page Layouts  : Themes, Page Setup, Scale to Fit, Sheet Options, Arrange 

Formulas : Function Library, Defined Names, Formula Auditing, Calculation 

Data : Get External Data, Connections, Sort & Filter, Data Tools, Outline 

Review : Proofing, Comments, Changes 

View  : Workbook Views, Show/Hide, Zoom, Window, Macros 

 
Quick Access Toolbar 

 The quick access toolbar is a 

customizable toolbar that contains 

commands that you may want to use.  You 

can place the quick access toolbar above or 

below the ribbon.  To change the location of 

the quick access toolbar, click on the arrow 

at the end of the toolbar and click Show 

Below the Ribbon. 

 You can also add items to the quick 

access toolbar.  Right click on any item in 

the Office Button or the Ribbon and click 

Add to Quick Access Toolbar and a shortcut 

will be added. 
 
Mini Toolbar 

 A new feature in Office 2007 is the 

Mini Toolbar.  This is a floating toolbar that 

is displayed when you select text or right-

click text.  It displays common formatting 

tools, such as Bold, Italics, Fonts, Font Size 

and Font Color. 
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 Excel 2007 offers a wide range of customizable options that allow you to make Excel 

work the best for you. To access these customizable options: 

 Click the Office Button 

 Click Excel Options 
 
Using Help in Excel 

 To get help, click on the help Icon  which is at 

the Top Right Corner of the Microsoft Excel Screen or by 

using the function key (F1).   
 

Creating a Workbook 

 To create a new Workbook: 

 Click the Microsoft Office Toolbar 

 Click New 

 Choose Blank Document 

If you want to create a new document from a template, explore the templates and 

choose one that fits your needs. 
 

Save a Workbook 

 When you save a workbook, you have two choices: Save or Save As. 

To save a document: 

 Click the Microsoft Office Button 

 Click Save 

You may need to use the Save As feature when you need to save a workbook under a 

different name or to save it for earlier versions of Excel.  Remember that older versions of Excel 

will not be able to open an Excel 2007 worksheet unless you save it as an Excel 97-2003 

Format. To use the Save As feature: 

 Click the Microsoft Office Button 

 Click Save As 

 Type in the name for the Workbook 

 In the Save as Type box, choose Excel 97-2003 Workbook 
 

Open a Workbook 
 To open an existing workbook: 

 Click the Microsoft Office Button 

 Click Open 

 Browse to the workbook 

 Click the title of the workbook 

 Click Open 
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Importing other files 

To import files other 

than excel format, execute the 

following steps. 

 From the Office Button, click 

Open. 

 Select file format from the 

dropdown list which is just 

above the Open button by 

default it shows All Files. 

 Select the file to open and 

click Open Button.  
 
 
 
Exporting  

To export excel files to other file formats, execute the following steps. 

 Open the Excel File.  

 From the Office Button, click Save As (or) press F12. 

 Select Save as type format from the dropdown list by default it shows Excel Workbook. 

 Click Save. 
 

Formatting Worksheet Tab 

You can rename a worksheet or change the color of the tabs to meet your needs. 

To rename a worksheet: 

 Open the sheet to be renamed 

 Click the Format button on the Home tab 

 Click Rename sheet 

 Type in a new name 

 Press Enter 
 

Changing the color of a worksheet tab: 

 Open the sheet to be renamed 

 Click the Format button on the Home tab 

 Click Tab Color 

 Click the color 
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Moving Worksheets in a Workbook 

 Open the workbook that contains the sheets you want to rearrange 

 Click and hold the worksheet tab that will be moved until an arrow appears in the left 

corner of the sheet 

 Drag the worksheet to the desired location 
 

Insert and Delete Worksheets 
To insert a worksheet 

 Open the workbook 

 Click the Insert button on the Cells group of the Home tab 

 Click Insert Sheet 
 

To delete a worksheet 

 Open the workbook 

 Click the Delete button on the Cells group of the Home tab 

 Click Delete Sheet 
 

To Copy and Paste Worksheets 

 Click the tab of the worksheet to be copied 

 Right click and choose Move or Copy 

 Choose the desired position of the sheet 

 Click the check box next to Create a Copy 

 Click OK 
 
Page Setup 

 Click the Page Layout tab in the Ribbon. 

 Go to the Page Setup group, and then you will find that some common used setups, 

such as margins, backgrounds and size are listed in this group. For further setup, you 

should click the little square with an arrow in the right bottom of the group.  

 Then a Page Setup box appears, and you can choose Orientation, Paper Size, Margins 

and set some other the settings based on your need. Click OK to finish it. 

 

Set Page Margins 

 To set the page margins: 

 Click the Margins button on the Page Layout tab 

 Select one of the give choices, or 

 Click Custom Margins 

 Complete the boxes to set margins 

 Click Ok 
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Change Page Orientation 

 To change the page orientation from portrait to landscape: 

 Click the Orientation button on the Page Layout tab 

 Choose Portrait or Landscape 
 
Printing the Worksheet 

1. Select the worksheet, worksheets, or worksheet data that you want to print. 

2. Click Microsoft Office Button, and then click Print. 

3. Keyboard shortcut you can also press CTRL+P. 

4. In the Print dialog box, select the options that you want, and then click Print Preview. 

5. On the Print Preview tab, in the Print group, click Page Setup. 

6. On the Page tab, under Orientation, click Portrait or Landscape. 
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NOTE   If you don't have a printer set up, the Orientation option will appear dimmed, and 

you won't be able to select it. To resolve this, you must set up a printer. The option also appears 

dimmed when you're in process of editing the contents of a cell. To resolve this, press ENTER to 

accept the changes or ESC to cancel the changes. 

7. Click OK. 

8. When you are ready to print, click Print. 
 
Entering Data 

 Various kind of entries can be made in a cell like Text, numbers, Date, Time and 

Formula.  We are going to see how to enter them one by one. 
 

To enter data in an active cell 

 Click in the cell where you want the data 

 Begin typing 

 

 

 
 
Entering the Text or Number  

1. Click the cell in which you want to enter the data, Type the data and Press ENTER to finish. 

2. The data will be displayed in the active cell as well as in formula bar. 

3. By default the text aligned to left, but the cell which has the numerical data is aligned to right.  

4. To enter the digits as text (it‘s not suitable for calculation) use an apostrophe ( ‗ ) as the first 
character.   
 

Entering the Date 

1. Click the cell in which you want to enter the Date 

2. Type your own Date in the format of DD: MM: YYYY or  DD / MM / YYYY 

3. If you want to enter the current date, press Ctrl + ; semicolon) or TODAY ().  

4. Press ENTER to finish your entry. Ex: 15:10:2015 or 15/10/2015 
 
 
 

 

Formula Bar      Active Cell Name of Active Cell 

http://office.microsoft.com/redir/HA010102890
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Entering the Time 

1. Click the cell in which cell you want to enter the Time & type your own Time in the format 
of HH : MM a/p 

2. Excel calculates the time in 12 hours method.  So you give space after your time and 
enter a for AM and p for PM.  Otherwise it takes as AM. 

3. If you want to enter the current time, press CTRL + SHIFT + : (colon).  
Example: 10:10p (or) 11:00a 

 
Entering the Formula 

1. Click the cell in which you want to enter the formula. 

2. Type = (an equal sign) where your want the result.  

3. Enter the formula and press ENTER 

4. You can enter the same formula into a range of cells by selecting the range first, typing 

the formula, and then pressing CTRL + ENTER.  You can also enter a formula into a 

range of cells by copying a formula from another cell. 
Example: (40/100*C5) (or) (60*100) 

 
 

Auto Fill 

 The Auto Fill feature fills  cell data or series of data in a 

worksheet into a selected range of cells. If you want the same 

data copied into the other cells, you only need to complete one 

cell.  If you want to have a series of data (for example, days of 

the week) fill in the first two cells in the series and then use the 

auto fill feature. To use the Auto Fill feature: 

 Click the Fill Handle 
 Drag the Fill Handle to complete the cells 

 

Example to fill days 

1. Enter MONDAY in cell A1. 

2. Drag the Autofill handle till the cell A14. 

(The whole range will be filled with days from MONDAY to SUNDAY, like this you can fill 

months also). 
 
Highlighting Values 

1. Select the range of cells which is to be highlighted. 

2. Click Conditional Formatting from the Styles Group in the Home Tab.  

3. Click the Highlight Cells Rules from the shown list. 

4. Now a list of conditions are shown from which the required condition can be chosen. 

5. A small dialog box will appear to which the necessary values are given. 
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Some Keyboard shortcuts for entering data 

Press To 

ENTER Complete a cell entry and move down in the selection 

ALT + ENTER Start a new line in the same cell 

CTRL + ENTER Fill the selected cell range with the current entry 

SHIFT + ENTER Complete a cell entry and move up in the selection 

TAB Complete a cell entry and move to the right in the selection 

SHIFT + TAB Complete a cell entry and move to the left in the selection 

ESC Cancel a cell entry 

BACKSPACE Delete the character to the left of the insertion point, or delete the 
selection. 

DELETE Delete the character to the right of the insertion point, or delete the 
selection. 

CTRL + DELETE Delete text to the end of the line 

Arrow keys Move one character up, down, left or right 
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HOME Move to the first cell of the row 

F4 or CTRL + Y Repeat the last action 

SHIFT +F2 Edit a cell comment 

CTRL + SHIFT + 
F3 

Create names from row and column labels 

CTRL + D Fill down 

CTRL + R Fill to the right 

CTRL + F3 Define a name 

 
Keys for editing data 

Press To 

F2 Edit the active cell and the insertion point goes to end of the line 

ESC Cancel an entry in the cell or formula bar 

BACKSPACE Edit the active cell and then clear it, or delete the preceding 
character in the active cell as  you edit the cell contents 

 F3 Paste a defined name into a formula 

CTRL + A Display the formula Palette after you type a function name in a 
formula 

CTRL + SHIFT + A Insert the argument names and parentheses for a function, after 
you type a function name in a formula 

F7 Display the Spelling dialog box 

 
Keys for moving and scrolling in a worksheet or workbook 

Press To 

Arrow keys Move one cell up, down, left, or right 

CTRL + arrow key Move to the edge of the current data region 

HOME Move to the beginning of the row 

CTRL + HOME Move to the beginning of the worksheet 

CTRL + END Move to the last cell on the worksheet, which is the cell at 
the intersection of the rightmost used column and the 
bottom-most used row (in the lower-right-corner), or the cell 
opposite the home cell, which is typically A1 

PAGE DOWN Move down one screen 

PAGE UP Move up one screen 

ALT + PAGE DOWN Move one screen to the right 

ALT + PAGE UP Move one screen to the left 
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CTRL + PAGE DOWN Move to the next sheet in the workbook 

CTRL + PAGE UP Move to the previous sheet in the workbook 

CTRL + F6 or CTRL + TAB Move to the next workbook or window 

CTRL + SHIFT + F6 or               
CTRL + SHIFT + TAB 

Move to the previous workbook or window 

F6 Move to the next pane in a workbook that has been split 

SHIFT + F6 Move to the previous pane in a workbook that has been split 

CTRL + BACKSPACE Scroll to display the active cell 

F5 Display to Go To dialog box 

SHIFT + F5 Display to Find dialog box 

SHIFT + F4 Repeat the last Find action (same as Find Next) 

TAB Move between unlocked cells on a protected worksheet. 

Insert Cells, Rows, and Columns 

 To insert cells, rows, and columns in Excel: 

 Place the cursor in the row below where you want the 

new row, or in the column to the left of where you want 

the new column 

 Click the Insert button on the Cells group of 

the Home tab 

 Click the appropriate choice: Cell, Row,  or Column 
 
 

Delete Cells, Rows and Columns 

 To delete cells, rows, and columns: 

 Place the cursor in the cell, row, or column that you 

want to delete 

 Click the Delete button on the Cells group of 

the Home tab 

 Click the appropriate choice:  Cell, Row, or Column 

 

Select Data 

 To select a cell or data to be copied or cut: 

 Click the cell 

 Click and drag the cursor to select many cells in a range 
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Select data using Keyboard 

To select Press 

Current cell Enter 

Entire column Ctrl + Spacebar 

Entire row Shift + Spacebar 

Entire Worksheet Ctrl + Shift + Spacebar 

Extend selection to End of Data block  End, Shift + Arrow Key 

 

Locking and Unlocking a Cell 

 By default all the cells in Excel are locked. To unlock, select the cell to unlock and right 

click on the cell, Go to Format Cells in the Popup Menu.  From the Custom Lists dialog box, 

uncheck the Locked under the Protection Tab. 
 

Adding Frame Control  

1. If the Developer tab is not available, display it by 

Display the Developer tab 

a. Click the Microsoft Office Button, and then 

click Excel Options. 

b. In the Popular category, under Top options 

for working with Excel, select the Show 

Developer tab in the Ribbon check box, and 

then click OK. 

2. On the Developer tab, in the Controls group, click Insert, and select a control 

under ActiveX Controls. 

3. Click the worksheet location where you want the upper-

left corner of the frame control to appear. 

4. To edit the ActiveX control, make sure that you are in 

design mode. On the Developer tab, in the Controls 

group, turn on Design Mode. 

5. To specify the control properties, on the Developer tab, 

in the Controls group, click Properties. 

6. Double click the button, a Visual Basic window appears 

where necessary code should be entered.  

7. Once the code is entered close the VB window and 

disable the design mode to run the command. 

 

 



 Venus Computers   Unit-4: Microsoft Excel 

 

108 

 

 

Go To Command 

 The Go To command takes you to a specific cell either by cell reference (the Column 

Letter and the Row Number) or cell name.  

 Click the Find & Select button on the Editing group of the Home tab 

 Click Go To 

 

Copy and Paste 

To copy and paste data: 

 Select the cell(s) that you wish to copy 

 On the Clipboard group of the Home tab, click Copy or press Ctrl+C 

 Select the cell(s) where you would like to copy the data 

 On the Clipboard group of the Home tab, click Paste or press Ctrl+V 

 

Cut and Paste 

To cut and paste data: 

 Select the cell(s) that you wish to copy 

 On the Clipboard group of the Home tab, click Cut or press Ctrl+X. 

 Select the cell(s) where you would like to copy the data. 

 On the Clipboard group of the Home tab, click Paste or press Ctrl+V. 
 

Undo and Redo 

To undo or redo your most recent actions: 

 On the Quick Access Toolbar 

 Click Undo  or Redo  
 

Relative, Absolute and Mixed References 

 Calling cells by just their column and row labels (such as "A1") is called relative 

referencing. When a formula contains relative referencing and it is copied from one cell to 

another, Excel does not create an exact copy of the formula. It will change cell addresses relative 

to the row and column they are moved to. For example, if a simple addition formula in cell                 

C1 "=(A1+B1)" is copied to cell C2, the formula would change to "=(A2+B2)" to reflect the                 

new row.  

To prevent this change, cells must be called by absolute referencing and this is 

accomplished by placing dollar signs "$" within the cell addresses in the formula. Continuing the 

previous example, the formula in cell C1 would read "=($A$1+$B$1)" if the value of cell C2 

should be the sum of cells A1 and B1. Both the column and row of both cells are absolute and 

will not change when copied.  
 



 Venus Computers   Unit-4: Microsoft Excel 

 

109 

 

 

Mixed reference 

Mixed referencing can also be used where only the row OR column fixed. For example, 

in the formula "=(A$1+$B2)", the row of cell A1 is fixed and the column of cell B2 is fixed. 
 

Find and Replace  
 To find data or find and replace data: 

 Click the Find & 

Select button on 

the Editing group of 

the Home tab 

 Choose Find or Replace 

 Complete the Find What and 

Replace with text box  

 Click on Options for more 

search options (Optional) 
 

Consolidation 

Example for adding Internal and External Marks 

1. Type the Internal and External Marks in 

two separate columns.  

2. Select Consolidation from Data Tools 

group in Data Tab.  

3. Now the select the column to store the 

consolidated result. 

4. Choose the function Sum.  

5. Click in the Reference box, select the 

range of internal marks from the 

workbook and click Add.  

6. Then, add the External marks as it was 

done in step 5 and Click OK.  

7. Check Top row, Left column and Create 

links to source data. 

Note: if you don't check Top row and Left column, Excel sums all cells that have the same 

position. For example, cell B2 (in distric1.xls) + cell B2 (in district2.xls) + cell B2 (in district3.xls). 

Because our worksheets are not identical, we want Excel to sum cells that have the same labels. 

If you check Create links to source data, Excel creates a link to your source data (your 

consolidated data will be updated if your source data changes) and creates an outline. 

8. Click OK. 

http://www.excel-easy.com/examples/outlining-data.html
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Spell Check 

 On the Review tab, in 

the Proofing group, click Spelling. 

 The Spelling dialog box 

appears, and the first 

suggested correction is 

highlighted. 

 Use the following buttons to 

check your spelling: 

 

Note:   It checks the spelling 

mistakes in the active sheet only 

 

Options Uses 

Ignore Once     Ignore this word once, but check it again. 

Ignore All     Ignore this word throughout the sheet. 

Add to Dictionary     Include this word in the program's dictionary. 

Change  Use the suggested word in the Suggestions pane. 

Change All     Use the suggested word to change all instances of this word. 

AutoCorrect     Use the first suggested word each time you click AutoCorrect. 

 
Working with Formula 

 Formula are widely used in simple (like addition, subtraction, multiplication and division) 

and advanced computing.  They provide the power to analyze data extensively, Spreadsheets 

also provide an important feature of auto-recalculation every time a change is made in the cells.  

Any change made in one cell causes a ripple effect in all dependent cells.  There are basically 

two kinds of recalculation.  They are Automatic, Manual. 
 

Automatic 

 This is the default mode in which the change in the value of the cell causes the 

recalculation of the whole worksheet automatically. 
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Manual  

 On selecting this option, the recalculation of the complete worksheet is done only on 

pressing F9 key. This option can be selected choosing Calculation options in Formulas Tab’s 

Calculation Group. 

There are many elements to excel formula. 

References:  The cell or range of cells that you want to use in your calculation 

Constants:  Numbers or text values that do not change 

Functions:  Predefined formulas in Excel 

Operators:  Symbols (+, -, *, /, etc.) that specify the calculation to be performed 
 
Operator in the Order of Precedence 

Operator Description Example 

: Range  B2:B5 

Space Intersection of Cells  

- Negation (single operand) = -10 

% Percentage = 25% 

^ Exponential = 10^2 

* Multiplication = 5*5 

/ Division = 24/3 

+ Addition = 55+80 

- Subtraction = 40-25 

& Joining Text = ―work‖ & ‖book‖ 

= Equal to  = A1=5 

< Less then = B13<1000 

> Greater than = B13>1000 

<= Less than or Equal to = B13<=1000 

>= Greater than or Equal to = B13>=1000 

<> Not Equal to = B13<>1000 

 

To create a basic formula in Excel: 

 Select the cell for the formula 

 Type = (the equal sign) and type the formula and Click Enter 
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Working with Functions 

 A function is a built in formula in Excel.  A function has a name and arguments (the 

mathematical function) in parentheses.  Common functions in Excel: 

Sum:  Adds all cells in the argument 

Average:  Calculates the average of the cells in the argument 

Min:  Finds the minimum value  

Max:  Finds the maximum value 

Count:  Finds the number of cells that contain a numerical value within a range of the argument 

To calculate a function: 

 Click the cell where you want the function applied 

 Click the Insert Function  button 

 Choose the function 

 Click OK 

 

Some sample functions  

SUM (Starting cell address: ending cell address) 

 Returns the sum of some continues cells values 

 Example:  = SUM (C10:C20) 
 

AVG (Starting cell address: ending cell address) 

 Returns the average of some continues cells values 

 Example: = AVG (C10:C20) 
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INT (number) 

 Rounds a number down to the nearest integer.  Number is the real number you want to 

round down to an integer. 

 Example: = INT (6.2) 
 

FACT (number)  

 Returns the factorial of a number.  Number is the non-negative number you want the 

factorial of.  If number is not integer, it is truncated. 

Example: = FACT (5) 
  

MOD (number, divisor) 

 Returns the remainder after number is divided by divisor.  The result has the same sign 

as divisor. 

 Number: It is the number of which you want to find the remainder. 

 Divisor: It is the number by which you want to divide number. 

Example: = MOD (15, 2) = MOD (15, -2) 
 

ROUND (number, num_digits) 

 Rounds a number to a specified number of digits. 

 Number  : It is the number you want to round. 

 Num_digits : It specifies the number of digits to which you want to round number. 

Example:  = ROUND (96.54, 0) 
 

CEILING (number, significance) 

 Returns number rounded u to the nearest multiple of significance. 

 Number  : It is the value you want to round. 

 Significance : It is the multiple to which you want to round. 

Example: = CEILING (97.8,1) 
 

CONCATENATE (text1, text2, …..) 
 Joins several text items into one text item.  The ―&‖ operator can be used instead of 
CONCATENATE to join text items.  Text1, Text2,….are 1 to 30 text items to be joined into a 
single text item can be text strings, numbers or single-cell references. 

Example: = CONCATENATE (―Soft‖, ―ware‖) 
 

LEFT (text, num_chars) 

 Returns the first (or leftmost) character or characters in a text string. 

 Text:  It is the text string containing the characters you want to extract. 



 Venus Computers   Unit-4: Microsoft Excel 

 

114 

 

 Num_chars:  Specified how many characters you want LEFT to return. Num_chars 

   must be greater than or equal to zero. 

Example: = LEFT (―Salesman‖, 5) 
 

RIGHT (text, num_chars) 

 Returns the last (or rightmost) character or characters in a text string. 

 Text :   It is the text string containing the characters you want to extract. 

 Num_Chars:  It specifies how many characters you want to extract. 

Example: = RIGHT (―Salesman‖, 3) 
 

LOWER (text) 

 Converts all uppercase letters in a text string to lowercase. 

 Text:  It is text you want to convert to lowercase.  LOWER does not change 

   characters in text that are not letters. 

Example: =LOWER (―Limit‖) 
 

UPPER (TEXT) 

 Converts text to uppercase.   

Text :  It is the text you want convert to uppercase.   

Text can be a reference of text string. 

 Example: = UPPER (―Limit‖) 
 

DATE (year, month, day) 

 Returns the serial number of a particular date. 

 Year:  It is number from 1900 to 2078 in Microsoft Excel for windows 

 Month:  It is a number representing the month of the year. 

 Day:  It is a number representing the day of the month. 

Example: = DATE (99,2,12) 
 

NOW ( ) 

 Returns the serial number of the current date and time.   

Example: = NOW (  ) 
 

TODAY ( ) 

 Returns the serial number of the current date. 

Example: =TODAY ( ) 
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WORKING WITH MACROS 

Recording a Macro 

To record a Macro: 

 Click the View tab on the Ribbon 

 Click Macros 

 Click Record Macro 

 Enter a name (without spaces) 

 Enter a Shortcut Key 

 Enter a Description 

 Perform the Macro 

 Click Macros 

 Click Stop Recording 
 

Running a Macro 

To run a Macro from the Keyboard shortcut, simply press the keys that you have 

programmed to run the Macro.  Or you can view all macros and run by: 

 Click Macros 

 Click View Macros  

 Select the Macro that you want to run and click Run 
 

Sorting & Filtering 

Sorting and Filtering allow you to manipulate data in a worksheet based on given set of 

criteria. 
 

Basic Sorts 

 To execute a basic descending or ascending sort based on one column: 

 Highlight the cells that will be sorted 

 Click the Sort & Filter button on the Home tab or Data Tab  

 Click the Sort Ascending (A-Z) button or Sort Descending (Z-A) button 
 

Custom Sorts 

 To sort on the basis of more than one column: 

 Click the Sort & Filter button on the Home tab 

 Choose which column you want to sort by first 

 Click Add Level 

 Choose the next column you want to sort 

 Click OK 
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Filtering 

 Filtering allows you to display only data that meets certain criteria. To filter: 

 Click the column or columns that contain the data you wish to filter 

 On the Home tab, click on Sort & Filter 

 Click  Filter button 

 Click the Arrow at the bottom of the first cell 

 Click the Text Filter 

 Click the Words you wish to Filter 

 To clear the filter click the Sort & Filter button 

 Click Clear 
 

Data Validation 

Data validation is can be used to define restrictions on what data should be entered in a 

cell. Data validation is designed to prevent users from entering data that is not valid and allowed 

to enter invalid data with a warning. Show Input Message facility can be used to provide 

messages to define what input can be allowed. 
 

Example 

1. Select cell where the data to be entered. 

2. On the Data tab, click Data Validation. 

On the Settings tab: 

1. In the Allow list, select Whole number. 

2. In the Data list, click between. 

3. Enter the Minimum and Maximum values. 

 



 Venus Computers   Unit-4: Microsoft Excel 

 

117 

 

 
 

  
 

Input Message 

On the Input Message tab: 

1. Check Show input 

message when cell is 

selected 

2. Enter a title. 

3. Enter an input message. 
 

Error Alert 

If users ignore the input 

message and enter a number that is not valid, the error alert is shown. 
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On the Error Alert tab: 

1. Check 'Show error alert after invalid data is entered'. 

2. Enter a title. 

3. Enter an error message. 

4. Click OK. 

 

Data Validation Result 

1. Select cell C4. 

2. Try to enter a number higher than 10. 
 

Subtotals 

Once you have sorted a data range into groups, Excel's Subtotal command can create a 

subtotal for each group, automatically inserting a new row and displaying the total for each line. 

 

Subtotals are added using the Subtotal dialog box, which is accessed from 

the Data command tab. 

1. Sort your data range 

2. Select a cell within the data range 

3. From the Data command tab, in the Outline group, click Subtotal. The Subtotal dialog 

box appears. 

 

http://www.uwec.edu/help/excel07/srtcom.htm
http://www.uwec.edu/help/excel07/srtcom.htm
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4. From the At each change in pull-down list, select the column containing data groups for 

which the subtotal is needed 

5. It is important to have this column sorted into data groups, because 

the Subtotal command subtotals numerical data at every change in the column Day. 

6. From the Use function pull-down list, select the sum that will be used to create subtotals 

7. From the Add subtotal to scroll box, select the column with the numerical data subtotaled 

8. Click OK  

Formula auditing in Excel is allowed to display the relationship between formulas and 

cells.  
 

Trace Precedents 

Trace Precedents is used to show arrows that indicate which cells are used to calculate 

the result. 

1. Select cell where the formula is used. 

2. On the Formulas tab, in the Formula Auditing group, click Trace Precedents. 

3. The arrow is shown to point the result from source data. 
 

Remove Arrows 

To remove the arrows, click Remove Arrows on the Formulas tab, in the Formula 

Auditing group,  

 

Trace Dependents 

Trace dependents is used to show arrows that indicate which cells depend on a selected 

cell. 

1. Select the cell where the data to calculate is entered. 

2. On the Formulas tab, in the Formula Auditing group, click Trace Dependents. 

 

Show Formulas 

By default, Excel shows the results of formulas at the cell where the formula is entered.  

To show the formulas instead of their results,  

1. Click Show Formulas, on the Formulas tab in the Formula Auditing group. 

 

Error Checking 

To check for common errors that occur in formulas, On the Formulas tab, in the Formula 

Auditing group, click Error Checking. 

http://www.uwec.edu/help/excel07/srtcom.htm
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Evaluate Formula 

Errors in the formula can be evaluated by selecting the cell where the formula is entered 

and click Evaluate Formula on the Formulas tab, in the Formula Auditing group and click 

Evaluate. 

Adding a Picture 

 To add a picture 

 Click the Insert tab 

 Click the Picture button 

 Browse to the picture from your files 

 Click the name of the picture 

 Click Insert 

 To move the graphic, click it and drag it to where you want it 

 

Adding Clip Art 

To add Clip Art 

 Click the Insert tab 

 Click the Clip Art button 

 Search for the clip art using the search Clip Art Or press Organize Clips 

 Click the clip art 

 To move the graphic, click it and drag it to where you want it 
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Adding Shapes 
To add Shape 

 Click the Insert tab 

 Click the Shapes button 

 Click the shape you choose 

 Click the Worksheet 

 Drag the cursor to expand the Shape 
 

To format the shapes 

 Click the Shape 

 Click the Format tab 
 

Adding SmartArt 

 SmartArt is a feature in Office 2007 that 

allows you to choose from a variety of graphics, 

including flow charts, lists, cycles, and 

processes.  To add SmartArt 

 Click the Insert tab 

 Click the SmartArt button 

 Click the SmartArt you choose 
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 Select the Smart Art 

 Drag it to the desired location in the worksheet 
 

To format the SmartArt 

 Select the SmartArt 

 Click either the Design or the Format tab 

 Click the SmartArt to add text and pictures. 
 

 
WORKING WITH CHARTS 

Charts are the graphic component of Excel. The data which is entered as tables can be 

viewed in the graphical form as charts which makes the figures of data effective, interesting, easy 

to understand, and easy to analyze and compare data. Charts are inserted when a chart is 

created. It contains only one chart. To create Chart sheets, choose Insert menu, Chart 

command‘s As New sheet option. 
 
Chart components 

An example of a 2-dimenstional chart is……   

 Chart Title - A title given to the whole chart. 

 X axis Title - A title given to the X axis range. 

 Y axis Title - A tile given to the Y axis range. 

 Y axis Value - This is the data range marked to plot the data series. 

 Data Labels - The values of the data series plotted. 

 Legend  - It specifies the color, symbol or pattern used to mark the data series. 

An example of a-3 dimensional chart is……… 

 

 

 

 

 

 

 

 

 

 

 

Wall - This is the background of the potted area. 
Floor - This is the base upon which data series is plotted. 

89

95

85
85

89

75

95

75

95 96

85

74

0

10

20

30

40

50

60

70

80

90

100

MARKS

Madhan Suresh kavitha Sundar

NAME

MARK STATEMENT

tamil

English

Maths

 

Wall  

Legend 

Floor 

X-axis Value 

Y-axis Value 
Chart Title 



 Venus Computers   Unit-4: Microsoft Excel 

 

123 

 

Chart Types 

 MS-Excel offers 14 different major chart types, each of which has at least one sub type, 

or variations.  You can change the chart type to present your data most clearly and effectively.  

Some of the chart types are……. 
Area Chart Pie Chart  

Bar Chart Doughnut Chart 

Column Chart Radar Chart 

Line Chart XY (Scatter) Chart 

 

Creating a Chart 

To create a chart 

 Select the cells that contain the data you want to use in the chart 

 Click the Insert tab on the Ribbon 

 Click the type of Chart you want to create 

 
 

Modify a Chart 

 Once you have created a chart you can do several things to modify the chart.  

To move the chart 

 Click the Chart and Drag it another location on the same worksheet, or 

 Click the Move Chart button on the Design tab 

 Choose the desired location (either a new sheet or a current sheet in the workbook) 
 

 



 Venus Computers   Unit-4: Microsoft Excel 

 

124 

 

To change the data included in the chart: 

 Click the Chart 

 Click the Select Data button on the Design tab 
 

To modify the labels and titles: 

 Click the Chart 

 On the Layout tab, click the Chart Title or the Data Labels button 

 Change the Title and click Enter 
 

 

Chart Tools 

 The Chart Tools appear on the Ribbon when you click on the chart.  The tools are 

located on three tabs:  Design, Layout, and Format.   

 Using Design tab you can control the chart type, layout, styles, and location. 

 With the help of Layout tab you can control inserting pictures, shapes and text boxes, 

labels, axes, background, and analysis. 

 Within the Format tab you can modify shape styles, word styles and size of the chart. 

 

Format Cells Dialog Box 

 In Excel, you can also apply specific formatting to a cell. To apply formatting to a cell or 

group of cells: 

 Select the cell or cells that will have the formatting 

 Click the Dialog Box arrow on the Alignment group of the Home tab 
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There are several tabs on this dialog box that allow you to modify properties of the cell or 

cells.  
 

Number:  Allows for the display of different number types and decimal places 

Alignment:  Allows for the horizontal and vertical alignment of text, wrap text, shrink text, merge 

cells and the direction of the text. 

Font:  Allows for control of font, font style, size, color, and additional features 

Border:  Border styles and colors 

Fill:  Cell fill colors and styles 

 
 

Add Borders and Colors to Cells 

 Borders and colors can be added to cells manually or through the use of styles.  To add 

borders manually: 

 Click the Borders drop down menu on the Font group of the Home tab 

 Choose the appropriate border 

To apply colors manually: 

 Click the Fill drop down menu on the Font group of the Home tab 

 Choose the appropriate color 

To apply borders and colors using styles: 

 Click Cell Styles on the Home tab 

 Choose a style or click New Cell Style 

 

     



 Venus Computers   Unit-4: Microsoft Excel 

 

126 

 

Change Column Width and Row Height 

 To change the width of a column or the height of a row: 

 Click the Format button on the Cells group of the Home tab 

 Manually adjust the height and width by clicking Row Height or Column Width 

 To use AutoFit click AutoFit Row Height or AutoFit Column Width 
 

Hide or Unhide Rows or Columns 

To hide or unhide rows or columns: 

 Select the row or column you wish to hide or unhide 

 Click the Format button on the Cells group of the Home tab 

 Click Hide & Unhide 
 

Merge Cells 

 To merge cells select the cells you want to merge and click the Merge & Centre button 

on the Alignment Group  

 To merge cells select the cells you want to merge and click the Merge & Center button 

on the Alignment Group of the Home tab.  The four choices for merging cells are: 
 

 
 

 
 
 

After Merge and Center 
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Merge & Center: Combines the cells and centers the contents in the new, larger cell. 

Merge Across: Combines the cells across columns without centering data. 

Merge Cells: Combines the cells in a range without centering 

Unmerge Cells: Splits the cell that has been merged 
 

Align Cell Contents 

 To align cell contents, click the cell or cells you want to align and click on the options 

within the Alignment group on the Home tab.  There are several options for alignment of cell 

contents: 
 

Top Align:  Aligns text to the top of the cell 

Middle Align:  Aligns text between the top and 

bottom of the cell 

Bottom Align:  Aligns text to the bottom of the cell 

Align Text Left:  Aligns text to the left of the cell 

Center:  Centers the text from left to right in the cell 

Align Text Right:  Aligns text to the right of the cell 

Decrease Indent:  Decreases the indent between the left border and the text 

Increase Indent:  Increase the indent between the left border and the text 

Orientation:  Rotate the text diagonally or vertically 

 

Set Print Titles 

 The print titles function allows you to 

repeat the column and row headings at the 

beginning of each new page to make 

reading a multiple page sheet easier to read 

when printed.  To Print Titles: 

 Click the Page Layout tab on the 

Ribbon 

 Click the Print Titles button 

 In the Print Titles section, click the box 

to select the rows/columns to be 

repeated 

 Select the row or column 

 Click the Select Row/Column Button 

 Click OK 
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Create a Header or Footer 

 To create a header or footer: 

 Click the Header & Footer button on the Insert tab 

 This will display the Header & Footer Design Tools Tab 

 To switch between the Header and Footer, click the Go to Header or Go to Footer button 

 To insert text, enter the text in the header or footer 

 To enter preprogrammed data such as page numbers, date, time, file name or sheet 

name, click the appropriate button 

 To change the location of data, click the desired cell 
 

Freeze Rows and Columns 

 You can select a particular portion of a worksheet to stay static while you work on other 

parts of the sheet.  This is accomplished through the Freeze Rows and Columns Function.   
 
To Freeze a row or column: 

 Click the Freeze Panes button on the View tab 

 Either select a section to be frozen or click the defaults of top row or left column 

 To unfreeze, click the Freeze Panes button 

 Click Unfreeze.
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OPEN OFFICE – CALC & MATH 
 
Introduction to Calc 

 Calc is a spreadsheet program which can calculate, analyse and visually communicate 

your data quickly and easily. Most of the functions in Microsoft Excel can be done in this 

application and a Microsoft Excel file can be opened in Calc.   
 

Features of Calc 

 Formulas can be created. 

 Data can be stored, sorted, filtered as a database.  

 Like Microsoft Excel Charts can be created in 2D and 3D charts. 

 Recording and executing repetitive tasks are done with the concept of Macros. 

 Import and export of spreadsheets in multiple formats is also possible. 
 

Introduction to Spreadsheets 

Spreadsheet is a sheet containing a number individual sheets and each sheet containing 

cells arranged in rows and columns. A cell can be spotted out separately using its row number 

and column letter.  Text, numbers, formulas, etc. can be put in a cell and make up the data to 

display and manipulate.  

 

 
 

 
Row Header     Name Box          Sheet     Column Header     Cell     Active Cell 

Menu Bar Function 
Wizard 

Input line Standard 
Toolbar 

Input line Formatting 
Toolbar 
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Rows in a worksheet 1 to 65536 

Columns in a worksheet A to AMJ (1024) 

First cell of a worksheet A1 

Last cell of a worksheet AMJ65536 

Total number of cells in a worksheet 67108864 

Maximum characters per cell 255 

 
Menus  

 File, Edit, View, Insert Format, Tools, Data, Window and Help menus are found in Open 

Office Calc application.  

 Like other applications, Writer, Impress, etc. File menu in calc is designed mainly for file 

management and printing processes.  

 Open Office provides three main toolbars by default, which are most frequently used 

they are Menu Bar, Formatting toolbar and Standard Toolbar.  

 
Menu Bar 

 The first toolbar is the Menu Bar that gives access to many of the basic commands used 

in Calc. 
 
Standard Toolbar 

 

The Standard Toolbar contains icons (pictures) to provide quick access to commands 

like New, Open, Print, Copy, Paste, etc. When you place your mouse cursor over any of the 

elements of a toolbar, the name of the tool appears on the screen. 
 
Formatting Toolbar 

 

Another important toolbar is the Formatting Toolbar, which also has some icons with 

drop-down menus that allow you to select a font, font color, alignments, number formats, border 

options and background colors. 
 

Formula Toolbar 

 

The Formula Toolbar contains the Name Box drop-down menu and a long white box 

called the Input Line. 
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Understanding Sheets 

 By default, there are three sheets in Open Office Calc but more sheets can be added. It 

can be done with the support of Inserting Sheet dialog box.  Inserting sheet dialog box is opened 

by clicking on the space after the sheet3 in the Sheet Tab, or by selecting Sheet in the Insert 

Menu, or by right clicking on any sheets in the sheets tab and select Insert sheet. 

 

Renaming a Sheet 

 Just right click on the sheet that needs to rename and select Rename Sheet. Rename 

Sheet window appears, where type the new name and click Ok.  
 

Deleting a Sheet 

  Firstly select the sheet to delete and right click on it, a menu appears. From the menu, 

select the Delete Sheet. After confirmation, it deletes the sheet. Once the sheet deleted from the 

sheet tab, it can be got back only with the help of the immediate action Undo.  
 

Move / Copy Sheets 

 Right click on the sheet that to be copied or moved, select Move/Copy Sheet from that 

menu which appeared after right click. The sheet can be moved or copied into the same file or to 

new document by selecting the drop down under the title To document.  If the location to move is 

the same document, the place to move is selected under Insert Before, where all the sheets are 

listed out.  

 To copy, it is needed to check the Copy Checkbox. 
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Entering Data into the cell 

1. Click on the cell, where you want to type the content. 

2. Notice the heavy black border around the cell. The heavy black border indicates that is 

the active cell.  

3. Type the content and press Enter. 
 

Entering the same data in more than one sheet 

1. Press the Ctrl key at the same select the sheets to type. Then release the ctrl key. 

2. Select the cell to type and enter the data in the active sheet. Now the same data entered 

in the sheets that selected already using ctrl key. 

Using the ctrl key, data entered already can be deleted from the selected sheets. 
 

Delete Data 

1. Select the cell to delete.  

2. Just press the Delete key. 

3. Delete Cell dialog box has some special features to delete only the text, number, etc. 
 

Using AutoFill 

AutoFill automatically generates a data series based on a defined pattern. 

1. On a sheet, click in a cell, and type a number. 

2. Click in another cell and then click back in the cell where you typed the number. 

3. Drag the fill handle in the bottom right corner of the cell across the cells that you want to 

fill, and release the mouse button. 

The cells are filled with ascending numbers. 
 

Using a Defined Series 

1. Select the cell range in the sheet that you want to fill. 

2. Choose Series from Fill of Edit Menu. 

3. Select the parameters for the series.  

If you select a linear series, the increment that you enter is added to each consecutive 

number in the series to create the next value. If you select a growth series, the increment that 

you enter is multiplied by each consecutive number to create the next value. If you select a date 

series, the increment that you enter is added to the time unit that you specify. 
 
Working with formulas 

Like Microsoft Excel, all formulas begin with an equal sign. The formulas can contain 

numbers, text, arithmetic operators, logic operators, or functions. Nesting Formulas is also 

possible which is supported by a wizard 
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Entering formulas can be done in several ways: using the icons, or by typing on the 

keyboard, or by a mixture of both methods. 

1. Click the cell in which you want to enter the formula. 

2. Click the Function icon on the Formula Bar. 

An equal sign will be shown in the input line and where the select the formula and then 

select the values to which the formula to be calculated. 

3. After entering the required values, press Enter or click Accept to insert the result in the 

active cell. To clear entry in the input line, press Escape or click Cancel. 
 
Entering Formulas 

1. Click in a cell, and type a number and press Enter. 

The cursor moves down to the next cell. 

2. Enter another number. 

3. Press the Tab key. 

The cursor moves to the right into the next cell. 

4. Type in a formula, for example, =A9 * A8 / 100 and press Enter. 

The result of the formula appears in the cell. If you want, you can edit the formula in the 

input line of the Formula bar. When you edit a formula, the new result is calculated automatically. 
 

Filtering 

1. One use for the AutoFilter function is to quickly restrict the display to records with 

identical entries in a data field. 

2. In the Standard Filter dialog, you can also define ranges which contain the values in 

particular data fields. You can use the standard filter to connect the conditions with either 

a logical AND or a logical OR operator. 

3. The Advanced filter allows up to a total of eight filter conditions. With advanced filters 

you enter the conditions directly into the sheet. 
 

Auto Filter 

The AutoFilter function inserts a combo box on one or more data columns that lets you 

select the records (rows) to be displayed. 

1. Select the columns you want to use AutoFilter on. 

2. Choose Data  Filter  AutoFilter. The combo box arrows are visible in the first row of the 

range selected. 

3. Run the filter by clicking the drop-down arrow in the column heading and choosing an item. 

Only those rows whose contents meet the filter criteria are displayed. The other rows are 

filtered. You can see if rows have been filtered from the discontinuous row numbers. The column 

that has been used for the filter is identified by a different color for the arrow button. 



 Venus Computers   Unit-4: Open Office –Calc 

 

134 

 

When you apply an additional AutoFilter on another column of a filtered data range, then 

the other combo boxes list only the filtered data. To display all records again, select the "all" 

entry in the AutoFilter combo box. If you choose "Standard", the Standard Filter dialog appears, 

allowing you to set up a standard filter. Choose "Top 10" to display the highest 10 values only.  

 

Chart Creation 

 To create a chart, select the data to be included in the chart.  

 Next, open the Chart Wizard dialog using one of two methods.  

 Choose Insert, then select Chart from the menu bar (or) click the Chart icon on the main 

toolbar 

 Either method inserts a sample chart on the worksheet, opens the Formatting toolbar, and 

opens the Chart Wizard 

The Chart Wizard includes a sample chart with your data. This sample chart updates to 

reflect the changes you make in the Chart Wizard.  

The Chart Wizard has three main parts: a list of steps involved in setting up the chart, a 

list of chart types, and the options for each chart type. At any time the user can go back to a 

previous step and change selections.   

On the Choose a chart type page, select a type by clicking on its icon. The preview 

updates every time to select a different type of chart, and provides a good idea of what the 

finished chart will look like. The current selection is highlighted on the Choose a chart type page. 

The chart‘s name is shown just 
below creating a chart.  
 
Types of Charts 

There are 10 basic chart 

types are in Open Office Calc.  

 Column 

 Bar 

 Pie 

 Area 

 Line 

 XY (Scatter) 

 Bubble 

 Net 

 Stock 

 Column and Line 
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On the Chart Elements page, title, subtitle, x-axis, y-axis, legend to the chart can be 

given. Confirmation is done by clicking on the Finish button 
 

Editing Charts 

Modifying chart type, Format Area, Title, Legend, etc. 

 Once the chart created the modification can be done by the given steps. 

1. Right click the chart. 

2. The pop-up menu appears. 

3. From the menu, the chart options like, title, legend, axes, gridlines can be modified. 

 
 

Changing Source Data 

 To change the Data for a Chart,  

1. Select the Chart area 

2. Press the right mouse button to get the short-cut menu 

3. Choose Data Ranges option 

4. This opens up the Source Data dialog box.  In this dialog box, you may reselect the 

data range. 
 

Page preview and Print options 

The Page Preview Toolbar allows the user to see what Calc is going to print. Click File, 

and select Page Preview (The Page Preview toolbar appears) 
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There could see four book icons with arrows. With those icons user can preview the 

previous, next, first and last pages of the work sheet. To get back from the page preview more 

just Click Close Preview. 

 Like Microsoft Excel, it is easy to take hard copy of the worksheet  
 
Printing 

 To take printed copy of the sheet, press Ctrl+P or just go to the File Menu and select 

Print option. Print dialog box appears. 

 
 

 With the help of the printer dialog box, number of copies, print range (pages need to 

print), etc. can be modified. In the printer name, the default printer is assigned by default, to 

change the printer just click on the dropdown and choose the printer to print. 
 

Some of the shortcut keys are listed below to work freely with OpenOffice Calc. 
 

Shortcut Keys Purpose 

Ctrl+Home Moves the cursor to the first cell in the sheet (A1). 

Ctrl+End Moves the cursor to the last cell on the sheet that contains data. 

Home Moves the cursor to the first cell of the current row. 

End Moves the cursor to the last cell of the current row. 

Ctrl+Left Arrow Moves the cursor to the left edge of the current data range. If the 
column to the left of the cell that contains the cursor is empty, the 
cursor moves to the next column to the left that contains data. 
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Ctrl+Right Arrow Moves the cursor to the right edge of the current data range. If the 
column to the right of the cell that contains the cursor is empty, the 
cursor moves to the next column to the right that contains data. 

Ctrl+Up Arrow Moves the cursor to the top edge of the current data range. If the row 
above the cell that contains the cursor is empty, the cursor moves up 
to the next row that contains data. 

Ctrl+Down Arrow Moves the cursor to the bottom edge of the current data range. If the 
row below the cell that contains the cursor is empty, the cursor moves 
down to the next row that contains data. 

Ctrl+Shift+Arrow Selects all cells containing data from the current cell to the end of the 
continuous range of data cells, in the direction of the arrow pressed. If 
used to select rows and columns together, a rectangular cell range is 
selected. 

Ctrl+Page Up Moves one sheet to the left. 

In the page preview: Moves to the previous print page. 

Ctrl+Page Down Moves one sheet to the right. 

In the page preview: Moves to the next print page. 

Alt + Page Up Moves one screen to the left. 

Alt + Page Down Moves one screen page to the right. 

Shift+Ctrl+Page Up Adds the previous sheet to the current selection of sheets. If all the 
sheets in a spreadsheet are selected, this shortcut key combination 
only selects the previous sheet. Makes the previous sheet the current 
sheet. 

Shift+Ctrl+Page 
Down 

Adds the next sheet to the current selection of sheets. If all the sheets 
in a spreadsheet are selected, this shortcut key combination only 
selects the next sheet. Makes the next sheet the current sheet. 

Ctrl + / where (/) is the division sign on the numeric key pad 

Selects the matrix formula range that contains the cursor. 

Ctrl+Plus key Insert cells (as in menu Insert - Cells) 

Ctrl+Minus key Delete cells (as in menu Edit - Delete Cells) 

Enter (in a selected 
range) 

Moves the cursor down one cell in a selected range. To specify the 
direction that the cursor moves, choose Tools - Options - 
OpenOffice.org Calc - General. 

Ctrl + `  Displays or hides the formulas instead of the values in all cells. 

Ctrl+F1 Displays the comment that is attached to the current cell 

F2 Switches to Edit mode and places the cursor at the end of the 
contents of the current cell. Press again to exit Edit mode. 

Ctrl+F2 Opens the Function Wizard. 

Shift+Ctrl+F2 Moves the cursor to the Input line where you can enter a formula for 
the current cell. 
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Ctrl+F3 Opens the Define Names dialog. 

F4 Shows or Hides the Database explorer. 

Shift+F4 Rearranges the relative or absolute references (for example, A1, 
$A$1, $A1, A$1) in the input field. 

F5 Shows or hides the Navigator. 

Shift+F5 Traces dependents. 

Ctrl+F5 Traces precedents. 

Shift+Ctrl+F5 Moves the cursor from the Input line to the Sheet area box. 

F7 Checks spelling in the current sheet. 

Ctrl+F7 Opens the Thesaurus if the current cell contains text. 

Ctrl+F8 Highlights cells containing values. 

F9 Recalculates changed formulas in the current sheet. 

Ctrl+Shift+F9 Recalculates all formulas in all sheets. 

Ctrl+F9 Updates the selected chart. 

F11 Opens the Styles and Formatting window where you can apply a 
formatting style to the contents of the cell or to the current sheet. 

Shift+F11 Creates a document template. 

Shift+Ctrl+F11 Updates the templates. 

F12 Groups the selected data range. 

Ctrl+F12 Ungroups the selected data range. 

Alt + Down Arrow Increases the height of current row. 

Alt + Up Arrow Decreases the height of current row. 

Alt + Right Arrow Increases the width of the current column. 

Alt + Left Arrow Decreases the width of the current column. 

Alt+Shift+Arrow Key Optimizes the column width or row height based on the current cell. 
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MATH 

Like the Equation support in Microsoft Word, Math in Open Office provides the facility to 

write mathematical formulas in symbolic form.  It provides 

numerous operators, functions and formatting assistants 

to create formulas. These are all listed in a selection 

window, in which the user can clicked the required 

element with the mouse to insert the object into the work. 

The lower area of the Formula Elements window 

displays the individual operators. The context menu of the 

Commands window also contains a list of these 

operators, as well as additional operators. If any operator 

is found in the Formula Elements window, it can be 

inserted by context menu or typed directly in the 

Commands window. The categorized group of Operators, 

Functions, Formats, etc. are explained and listed below. 
 

Unary/Binary Operators 

 Unary refers to operators that affect one placeholder. Binary refers to operators that 

connect two placeholders.  
 

Commands Meaning 

- Subtraction 

- - Sign 

-+ Minus/Plus 

/ Division 

* Multiplication 

+ Addition 

+ + Sign 

+- Plus/Minus 

and or & Boolean AND operation 

boper A user-defined symbol follows, which is used as a binary operator. 

uoper A user-defined symbol follows, which is a used as a unary operator. 

cdot Multiplication, small multiply symbol 

circ Concatenate symbols 

div Division 

neg Boolean NOT 

odivide Slash / in circle 

odot Small multiply symbol in circle 

ominus Subtract symbol in circle 

oplus Add symbol in circle 

or or | Boolean OR operation 

vnd.sun.star.help://shared/text/shared/00/00000001.xhp?Language=en-US&System=WIN&UseDB=no&DbPAR=smath#kontextmenue
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otimes Multiply symbol times in circle 

over Division/Fraction 

times Multiplication 

widebslash Backslash \ between two characters, of which the right is superscript, 
the left subscript 

wideslash Slash / between two characters, of which the left is superscript, the 
right subscript 

 
Relations 

Relations are used to structure the formula. Mostly the comparisons are done using 

these relational operators. 

 

Command Meaning 

< or lt  Less than 

<< or ll  Much less than 

<= or le  Less than or equal to 

<> or neq  Not equal 

=  Equation 

> or gt  Greater than 

>= or ge  Greater than or equal to 

>> or gg  Much greater than 

approx  Is approximately 

def  is defined as/by definition equal to 

divides  divides 

dlarrow  Arrow with double line to the left 

dlrarrow  Arrow with double line to the left and the right 

drarrow  Arrow with double line to the right 

equiv  Is equivalent/congruent to 

geslant  Greater than-equal to 

leslant  Less than-equal to 

ndivides  does not divide 

ortho  Is orthogonal to 

parallel  Is parallel to 

prop  Is proportional to 

sim  Is similar to 

simeq  Is similar or equal to 

toward  Toward 

transl  Correspondence symbol image of 

transr  Correspondence symbol original of 

vnd.sun.star.help://smath/text/smath/01/03090200.xhp?Language=en-US&System=WIN&UseDB=no&DbPAR=smath
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Set Operations 

Assign different set operators to the characters in your OpenOffice.org Math formula. 

The individual operators are shown in the lower section of the Formula Elements window. Call 

the context menu in the Commands window to see an identical list of the individual functions. 

Any operators not found in the Formula Elements window have to be entered directly in the 

Commands window. You can also directly insert other parts of the formula even if symbols 

already exist for them. 

 

Command Meaning 

aleph  Cardinal number 

emptyset  Empty set 

in  is contained in 

intersection  Intersection of sets 

notin  is not contained in 

nsubset  Not subset to 

nsubseteq  Not subset or equal to 

nsupset  Not superset 

nsupseteq  Not superset or equal to 

owns or ni  Contains 

setc  Complex number 

setminus or bslash  Difference between sets 

setn  Natural number 

setq  Rational number 

setr  Real number 

setz  Integer 

slash  Slash / for quotient set (slash) between characters 

subset  Subset 

subseteq  Subset or equal to 

supset  Superset 

supseteq  Superset or equal to 

union  Union of sets 

 

Functions 

Choose a function in the lower part of the window. These functions are also listed in the 

context menu of the Commands window. Any functions not contained in the Formula Elements 

window need to be typed manually in the Commands window. 
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Commands Meaning 

abs  Absolute amount 

arccos  Inverse cosine or arccosine 

arccot  Inverse cotangent or arccotangent 

arcosh  Inverse hyperbolic cosine 

arcoth  Inverse hyperbolic cotangent 

arcsin  Inverse sine or arcsine 

arctan  Inverse tangent or arctangent 

arsinh  Inverse hyperbolic sine 

artanh  Inverse hyperbolic tangent 

backepsilon  Back epsilon 

cos  Cosine 

cosh  Hyperbolic cosine 

cot  Cotangent 

coth  Hyperbolic cotangent 

exp  General exponential function 

fact  Factorial 

func e^{}  Natural exponential function 

ln  Natural logarithm 

log  General logarithm 

nroot  n-th root of x 

sin  Sine 

sinh  Hyperbolic sine 

sqrt  Square root 

sub  x with subscript n 

sup  n-th power of x 

tan  Tangent 

tanh  Hyperbolic tangent 

 

Operators 

You can choose among various operators to structure your OpenOffice.org Math 

formula. All available operators appear in the lower part of the Formula Elements window. They 

are also listed in the context menu of the Commands window. All operators not contained in the 

Formula Elements window or in the context menu must be typed manually in the Commands 

window. 

Commands Meaning 

coprod  Coproduct 

from  Lower limit of an operator 

from to  Range from ... to 

iiint  Triple integral 

iint  Double integral 

vnd.sun.star.help://smath/text/smath/01/03090300.xhp?Language=en-US&System=WIN&UseDB=no&DbPAR=smath
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int  Integral 

liminf  Limes inferior 

limsup  Limes superior 

lint  Curve integral 

llint  Double curve integral 

lllint  Triple curve integral 

oper  Placeholder, user-defined operator 

prod  Product 

sum  Sum 

to  Upper limit of an operator 

lim  Limes 

Attributes  

You can choose from various attributes for OpenOffice.org Math formulas. Some 

attributes are displayed in the lower part of the Formula Elements window. These attributes are 

also listed in the context menu of the Commands window. All attributes not contained in the 

Formula Elements window or in the context menu must be typed manually in the Commands 

window. 

Commands Meaning 

acute  Accent to top right above a character 

bar  Horizontal bar above a character 

bold  Bold 

breve  Top open arc above a character 

check  Upside down roof 

circle  Circle above a character 

color  The color command changes the character color; first enter 
the color command directly in the Commands window. Then 
enter the color name (black, white, cyan, magenta, red, blue, 
green, or yellow). Then enter the characters to be changed. 

dddot  Three dots above a character 

ddot  Two dots above a character 

dot  Dot above a character 

grave  Accent to bottom right above a character 

hat  "Roof" above a character 

ital  Italics 

nbold  Remove the Bold attribute 

nitalic  Remove the Italics attribute 

overline  Horizontal bar above a character 

overstrike  Horizontal bar through a character 

phantom  Phantom character 

tilde  Tilde above a character 

vnd.sun.star.help://smath/text/smath/01/03090600.xhp?Language=en-US&System=WIN&UseDB=no&DbPAR=smath
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underline  Horizontal bar below a character 

vec  Vector arrow above a character 

widehat  wide roof, adjusts to the character size 

widetilde  wide tilde, adjusts to the character size 

widevec  wide vector arrow, adjusts to the character size 

 

Brackets 

You can choose among various bracket types to structure a OpenOffice.org Math 

formula. Bracket types are displayed in the lower part of the Formula Elements window. These 

brackets are also listed in the context menu of the Commands window. All brackets that are not 

contained in the Formula Elements window or in the context menu can be typed manually in the 

Commands window. 

Commands Meaning 

(...)  Normal round left and right bracket 

[...]  Left and right square bracket 

ldbracket ... rdbracket  Left and right square double bracket 

lline ... rline  Left and right vertical line 

ldline ... rdline  Left and right double vertical lines 

lbrace ... rbrace  Left and right curly brackets, set bracket 

langle ... rangle  Left and right pointed bracket 

langle ... mline ... rangle  Left and right pointed operator bracket 

{...}  Left and right group bracket. They are not displayed in 
the document and do not take up any room. 

left( ... right)  Brackets, scalable 

left[ ... right]  Square brackets, scalable 

left ldbracket ... right rdbracket  Double square brackets, scalable 

left lbrace ... right rbrace  Braces, scalable 

left lline ... right rline  Single lines, scalable 

left ldline ... right rdline  Double lines, scalable 

left angle ... right angle  Angle brackets, scalable 

left langle ... mline ... right rangle  Scalable left and right pointed operator bracket 

overbrace  Scalable curly set bracket on top 

underbrace  Scalable curly set bracket below 

lfloor ... rfloor  Left and right line with lower edges 

lceil ... rceil  Left and right line with upper edges 

\lbrace \rbrace or \{ \}  Left curly bracket or right curly bracket 

\( \)  Left and right round bracket 

\[ \]  Left and right square bracket 

\langle \rangle  Left and right pointed bracket 

\lline \rline  Left and right vertical line 

vnd.sun.star.help://smath/text/smath/01/03090500.xhp?Language=en-US&System=WIN&UseDB=no&DbPAR=smath
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\ldline \rdline  Left and right double line 

\lfloor \rfloor  Left and right line with lower edges 

\lceil \rceil  Left and right line with upper edges 

none  Qualifier to suppress one bracket, as in right none  

 

Format 

You can choose among various options for formatting a OpenOffice.org Math formula. 

The format options are displayed in the lower half of the Formula Elements window. These 

options are also listed in the context menu of the Commands window. 

Commands Meaning 

lsup  Left exponent 

csup  Exponent directly above a character 

^ or sup or rsup  Right exponent 

binom  Binom 

newline  New line 

lsub  Left index 

csub  Index directly below a character 

_ or sub or rsub  Right index 

stack{...}  Stack 

`  Small space/small blank 

alignl  Align left 

alignc  Align to horizontal center 

alignr  Align right 

matrix{...}  Matrix 

~  Wide space/gap 

 
Other Symbols 

Some other mathematical symbols 

Commands Meaning 

<?>  Placeholder 

dotsaxis  Math-axis ellipsis 

dotsdown  Downward diagonal ellipsis 

dotslow  Ellipsis 

dotsup or dotsdiag  Upward diagonal ellipsis 

dotsvert  Vertical ellipsis 

downarrow  Down arrow 

exists  Existential quantifier, there is at least one 

forall  Universal quantifier, for all 

hbar  h with line over it 

im  Imaginary part of a complex number 

infinity or infty  Infinite 
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lambdabar  Lambda with line over it 

leftarrow  Left arrow 

nabla  Nabla vector 

partial  Partial derivative or set margin 

re  Real part of a complex number 

rightarrow  Right arrow 

uparrow  Up arrow 

wp  p function, Weierstrass p 

Creating Formula 

As with charts and images, formulas are created as objects within a document. Inserting 

a formula into a document automatically starts OpenOffice.org Math. The formula is easy to 

create, edit with symbols, and functions. 

 The formula can be created and saved in the Math application of OpenOffice by the 

following two methods and it could be created and inserted in any other open office applications. 

By the  

 

Launch the Open Office Math 

1. Right-click on the equation editor and select the symbol from the context menu.  

2. Select a symbol from the Formula Elements toolbox. 

 

 
  

Symbols 

Symbols 
Category 

Formula 
Elements 

Context Menu 
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Entering a Formula 

There are three main ways of entering a formula: 

 Type markup in the equation editor. 

 Right-click on the equation editor and select the symbol from the context menu. 

 Select a symbol from the Selection toolbox. 

The context menu and the Selection toolbox insert the markup corresponding to a 

symbol. Incidentally, this provides a convenient way to learn the OOoMath markup. When you 

select a symbol from the Selection toolbox, it will show up like this in this equation editor: 

 <?> times <?> 

And it will display on screen like this: 

 

While editing in the equation editor, it is required to remove <?> and replace it with the 

terms of the equation. For example, ―9 times 3‖ produces 9×3. Below is a short list of common 
equations and their corresponding markup. 

The equation editor knows nothing of order of operation. Complex formulas can be made 

using brackets. To get the square root formula, the command to be given is :  

x = { -b +- sqrt { b^2 - 4ac } } over { 2a } 
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Some other samples 
 

Typed Commands Output 

int from a to b { x^2 + 1 over x dx } 

 

 

{df(t)} over {dt} = {partial f} over {partial x} {dx } over 
{dt} + {partial f} over {partial y} {dy } over {dt} 

 

matrix { 

S_n #{}={}# alignl 1 + r + r^2 + dotsaxis + r^n ## 

rS_n #{}={}# alignl r + dotsaxis + r^n + r^{n+1} ## 

(1-r)S_n #{}={}# alignl 1 - r^{n+1} ## 

S_n #{}={}# alignl {1 - r^{n+1} } over {1-r}  } 

 

 

 
Customizing the interface 

There are a few ways to customize the equation editor's interface to make you more 

productive. Here are some suggestions: 

 The selection tool can be shown or hidden by, View  Selection. 

 To improve the speed, AutoUpdate can be turned on or off with ViewAutoUpdate display.  

 The formula can be updated manually by pressing F9 or through View  Update. 

 The editor can be turned into a floating window: 

 Hover the mouse above the border of the equation editor. 

 Hold down the Control key. 

 Drag the editor away from the main window. 
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QUESTIONS AND ANSWERS 

I. Fill in the blanks 

1. The first cell in Excel worksheet is labeled as A1. 

2. In Microsoft Excel current date and time can be displayed using the function now(). 

3. Extension of Excel workbook is .xlsx. 

4. Microsoft Excel worksheet has 1048576 rows and XFD columns. 

5. Ctrl + Spacebar is used to select the column in Microsoft Excel. 

6. Calling cells by their column and row label is called relative reference. 

7. Shortcut to edit the active cell in Excel is F2. 

8. The extension for Open Office Calc file is .ods. 

9. In Open Office Calc, Spelling and Grammar tool is in Tools Menu. 

10. In Open Office Calc, the data organized as Rows and Columns. 

   

II. Choose the best answer 

1. How many default worksheets can a workbook have? 

a)  4  b) 8  c)  3  d) 1 

2. Excel displays the current cell address in  

a) Name box b) Status bar c) Formula bar d) Formula bar 

3. How do you display current date only in Microsoft Excel? 

a) date()  b) now() c) today() d) time() 

4. Shortcut key to select a row in Excel is  

a) Shift + Spacebar b) Ctrl + A c) Ctrl + R d) Ctrl + Spacebar 

5. In Open Office Calc, the arithmetic operator for multiplication in a spreadsheet is  

a) +   b) *  c) @  d) % 

6. Which of the following file extensions is not compatible with Open Office Calc? 

a) .sdw  b) .dbf  c) .sxc  d) .xls 

7. What function  displays row data in a column or column data in a row? 

a)   Hyperlink b)   Index c)   Transpose d)   Rows 

8. Except for the …… function, a formula with a logical function shows the word ―TRUE‖ or 

―FALSE‖ as a result 

a)   IF  b)   AND c)   OR  d)   NOT 

9. Macros are run or executed from    menu. 

a)   Tools  b)   Format c)   Data d)   Insert 

 



 Venus Computers   Unit-4: Excel, Calc, Math 

 

150 

 

III. Say true or false 

1. Worksheet can be added or deleted in Open Office Calc.   (T) 

2. Gridlines may be turned on or off for printing in both Excel and Calc.  (T) 

3. Escape key (ESC) is used to enter data in a cell.    (F) 

4. F2 is the shortcut to edit a cell in both Excel and Calc.   (T) 

5. Data Validation is used to ensure correct data is entered in a cell.   (T) 

 

IV. Write answer in two or three lines 

1. What are the applications of Microsoft Excel? 

2. Write the steps to inserting a row or column in Microsoft Excel. 

3. How do you change the page orientation in Excel? 

4. What are the applications of Ms-Excel? 

5. List out the different types of charts available in Excel. 

6. Write the steps to edit the formula in a cell. 

7. What is the use of Open Office Math? 

 

V. Write answer in brief 

1. Write the steps to enter a formula in Excel. 

2. Write any six functions in Excel with examples.  

3. Write about consolidation. 

4. Write the steps to make a chart in Open Office Calc. 

5. Explain about the Formula Tool bar in Calc. 

6. How do you draw a formula in Open Office Math? 

7. How do you same data in more than one sheet  

8. Write the steps to insert a chart in Ms-Excel. 
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MICROSOFT ACCESS 
 

Introduction 

Microsoft Access is a Relational Database Management System (RDMS) that allows a 

user to store, retrieve and organize data in graphical form.  Data stored in the any other 

applications or databases can be shared, imported and linked to Access.  It allows user to query 

data and produce reports. Access enables sharing data with other suites of Microsoft Office, 

Microsoft SQL Server and documents in XML, HTML, XPS and PDF formats. A significant benefit 

of Access, for a programmer, is its compatibility with SQL. To work in access, a user need not be 

an expert to develop or create a sophisticated database application(s). 

 

Relational Database 

 A relational database utilizes two or more tables, containing data arranged in rows and 

columns to cross-reference and define relationships between the data. 

 A relational database splits up the information into more manageable small pieces.  A 

relationship among these pieces of information is made in order to achieve. 

 fast data entry 

 provide speed 

 flexibility in managing data 

 flexibility in locating data 

 flexibility to make reports 

 easy sorting of information 

 facility to avoid duplication of data etc., 

The above advantages can be achieved with the help of the database organization in a 

relational database. A relational database comprises of several objects such as Tables, Forms, 

Queries, Reports, etc. 

The standard file name extension for databases in the Microsoft Office Access 2007 is 

.accdb. In the earlier versions of Access the .mdb file name extension is used. 
 

Tables:  A table is a collection of records.  A table is the basic object and element of the 

Database. A database can contain several tables. A table organizes information 

into rows and columns. It can be used to both store and display data in a structured 

format.  

Forms:  A form is a type of database object that is primarily used to enter or display data in a 

database.  It is just a data entry window just like normal forms.  The data entry can be 

done easily in a form than in a table.   Most forms are bound to one or more tables and 

http://techterms.com/definition/row
http://techterms.com/definition/column
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Queries in the database.  A form‘s record source refers to the fields in its underlying 
tables and queries.  This focuses on one record at a time.  We can design our forms to 

provide an attractive look. We can place windows controls such as Command button, 

list box, combo box etc., in order to help the user to enter the data easily.  The most 

important help we get from forms is that we can calculate the data at the data entry 

time dynamically.   

Queries: Queries are the questions asked about the information stored in the tables.  The result 

of a query is a table like structure called dynaset.  A dynaset contain the extracted 

data.  A query can extract data from more than one table also.   This is one of the 

major features present in a relational database. Query can Append (Add), Update, 

Delete records at the same time and perform various calculations on the data. 

 Select Query is used to extract the information from table(s) as per the need. 

 Update Query is used to add / modify the information in the fields of the table. 

 Append Query is used to add records from various tables or queries.  

 Delete Query is used to remove unwanted records permanently from the table.  

Reports: A report is the final statement of the data present in the database.  We can make 

reports from tables, queries.  To print all the data in the table, it is better to use table, 

no need for query. To print selective records or columns based on the need, the user 

should use queries.  

Macros: A macro is a set of sequence operations.  Macros in Access can be thought of as a 

simplified programming language which you can use to add functionality to your 

database. For example, you can attach a macro to a command button on a form so that 

the macro runs whenever the button is clicked. Macros contain actions that perform 

tasks, such as opening a report, running a query, or closing the database. Most 

database operations that you do manually can be automated by using macros, so they 

can be great time-saving devices. 

Modules: Like macros, Modules are objects used to add functionality to the database. Whereas 

to create macros in Access by choosing from a list of macro actions, modules are 

written in Visual Basic for Applications (VBA) programming language. A module is a 

collection of declarations, statements, and procedures that are stored together as a 

unit. A module can be either a class module or a standard module. Class modules are 

attached to forms or reports, and usually contain procedures that are specific to the 

form or report they're attached to. Standard modules contain general procedures that 

aren't associated with any object. 
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Steps in designing a database 

The steps needed to design a database is 

1. Determine the purpose of your database 

2. Determine the tables you need in the database 

3. Determine the fields you need in the tables 

4. Identify fields with unique values in each record 

5. Determine the relationships between tables 

6. Refine your design 

7. Enter data and create other database objects. 
 

Planning a Database 

 As explained already a database can have many tables (collection of tables), though a 

database should have a separate table for every major subject. 

A table is a set of columns and rows. Each column is called a field. Within a table, each 

field must be given a name and no two fields can have the same name. Each value in a field 

represents a single category of data. Each row in a table is called a record. 

To understand these concepts, let us plan a database for school.  To maintain Students‘ 
personal Information and Mark Details; planned to create these tables in a single database.  

 

 
 

All of the data in a table should refer to the same subject. For example, all of the data in 

the Students table should refer to Students‘ Information and all of the data in the Marks table 

should refer to Mark details of the students. 

 

Table -1 Students 
 
 

Reg_No Studentname Fathername Phone_no 

1252 Vinayagi .R Raju .S 9025986332 

1253 Vimala .S Suresh .K 8425698541 

1254 Dharshan .S Sundar .P 8542369821 

 
Table -2 Marks  
 

Reg_No Studentname Tamil English Maths Science Social 

1252 Vinayagi .R 95 86 95 85 96 

1253 Vimala .S 95 95 98 85 98 

1254 Dharshan .S 98 98 96 94 93 

 

Rows 
Or 

Records 

Columns or Fields 

D
a
t
a
b
a
s
e 
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Steps to create a Database 

Database can be created in different ways. First Go To the Microsoft Office Button and 

Select New.  

On the Getting Started with Microsoft Office Access page, under New Blank 

Database, click Blank Database. 

In the Blank Database pane, type a file name in the File Name box.  To change the 

location of the file from the default, click Folder Icon, browse to the new location, and then click 

OK. 

Then Click Create. 
 

 
 
Creating a Table 

Microsoft Access database provides an empty table named Table1 in Datasheet view. A 

new table can be created by using Design View or Datasheet View or Templates. But it is better 

to create a table using Design View while comparing with other two ways. Because using the 

Design View, needed field name and data type can be chosen properly.  

Before creating table you should know the data types. Data types decide the data to be 

stored in a field.  The data types are listed below. 

 

 

To Create Blank 
Database Click Here 

To select location 
Click Folder Icon 
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Data Type Description 

AutoNumber Access automatically fills in a consecutive number for each record. The 
AutoNumber field is primarily used for Primary Keys in Access. 

Text Allows values that are text, numeric or alphanumeric up to 255 
characters. 

Memo As same as text but allows 2 GB of data. 

Number Allows storing numeric values of 16 bytes. 

Date/Time Allows storage of date and time information with Auto Calendar.  

Currency Currency data type stores values in a financial (money) format.  

Yes/No Accepts Yes or No (It means True or False, On or Off) 

OLE Object Stores images, documents, graphs etc with maximum data size of 2GB. 

Hyperlink Used to store web addresses.  

Attachment Used to store images, spreadsheet files, documents, charts and other 
types of supported files to the records. This is a new feature in this 
version. 

 
Each data type has some special properties: Using this user can change the size, 

format, etc.  

A primary key is a field or combination of fields that uniquely identify each record in a 

table. A field that is assigned as a primary key can‘t have same values.  
 

Steps to Create Table in Design View 

1. Click Table Design, in the Create Tab of the Tables Group.   

2. For each field in your table, type a name in the Field Name column, then select a data 

type from the Data Type list. 

3. If you want, you can type a description for each field in the Description column. The 

description is then displayed on the status bar when the cursor is in that field in 

Datasheet view. 

4. To set a Primary Key to any filed, just Right Click on field and select Primary Key (or) 

Select the field and click the Primary Key button in Design Tab. 

5. After you have added all of your fields, save the table by Clicking Save Option in the 

Microsoft Office Button or press CTRL+S. 

6. You can begin typing data in the table at any time by switching to Datasheet view and 

clicking in the first empty cell. You can also paste data from another source.  
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Entering data into the table 

 Double click the table you just created in the Navigation Pane. 

 Now a Data sheet is opened with the Field Names you just created. Place the mouse 
pointer in the first cell just below the Name header. 

 Type the data and press Enter key or Right Arrow key to move to the next field.  Now the 
text cursor is moved to the second cell just below Addresses.   In a similar manner 
complete the row. 

 After completing the first row, type Enter key to create the second row and start keying. 

 Each row can be termed as record.   

 After keying all the data press Close button of the data sheet window. 

Creating table using template     

Access provides templates for commonly-used types of tables. With a single mouse 

click, a complete table structure can be created with fields already configured. If needed, fields 

can be added or removed as per the need. 

1. On the Create tab, in the Tables group, click Table Templates and then select one of the 
available templates from the list. 

2. To add data, begin typing in the first empty cell or paste data from another source, as 
described in the section. 

   

Primary Key 
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3. To delete a column, Right-click the column heading, and then click Delete Column. 

4. To add a new column, On the Datasheet tab, in the Fields & Columns group, click New 
Field.   

5. Access displays the Field Templates pane, which contains a list of commonly used field 
types. If you double-click or drag one of these fields into your datasheet and save the 
Table.  

 

Creating and Working with Forms 

Forms are used to enter, modify and view the data. It is as like the forms used in day to 

day activities. Forms can be created in many methods such as basic forms (simple selecting a 

table or query), using Wizard (step by step method to create form with more than one table or 

queries) and using Design (complete form is designed with the help of controls to any number of 

tables and queries) 

Access 2007 has several automatic tools for creating forms. These tools are located in 

the Forms group on the Create tab in the Ribbon. 
 

 
 
 
 
 
 

Navigation Pane 

Navigation Bar 
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Creating Form in basic method 

To create a Form for a Table or Query:  

1) From the Navigation Pane, select the table you want to create the form  

2) Click Create on the Ribbon and Click Forms. 
 

Creating Form using Wizard 

1) From the Create Tab, Click More Forms Button 

2) Select Form Wizard, the step by step methods helps to design the form. 

 Select the table or query that is needed to design the form 

 Select the fields for the form 

 Select the layout to the form (Columnar is better to create form) 

 Select the style and give suitable name and finish the form 
 
Modify the Form Design 

 To modify the Form just right click on the form in Navigation Pane and select the Design 

View. Using the Format and Arrange Table under Format Layout Tools you can modify the form. 

Now with the help of this form, enter the data and move to the next field by Enter key or 

Tab key, once all the fields completed it creates a new record automatically.  

With the help of the navigation bar you can create a new record and navigate to any 

record. The data entered through the form is automatically added to the appropriate table. 
 
Preview a form 

 Many ways are available to preview a form from various views. But it is simple to select 

the print preview in the Print of the Office Button. Using this method you can print the form by 

giving appropriate options in the print dialog box. 

Print selected records in a form or datasheet 

1. Open the form. And select the record you want to print by clicking the record selector  

2. On the Office Button, click Print. 

3. In the Print dialog box under Print Range, click Selected Record(s). 

Sort records in Form or Datasheet view 

In Form view or Datasheet view, click the field you want to use for sorting records. 

 To sort in ascending order, click Sort Ascending icon in the toolbar. 

 To sort in descending order, click Sort Descending icon in the toolbar. 

 

 

 

 

In a form, you can sort on only one field at a time. 
When you save the form or datasheet, Microsoft Access saves the sort order 
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Searching Records 

 The records can be searched with the help of a field data.  For example, if you want to 

find the record containing ―Suresh‖ in the name field, you can search for the record, 

1. Open the Form by double clicking on it. 

2. Place the cursor in the name field. 

3. Select Find in Find Menu. 

4. Type ―Suresh‖ in the Find What combo box. 
5. Select name field in the Look in list box. 

6. Click Find Next button. 

7. Access searches the table or query for the record with ―Suresh‖ in its name field and 
moves the record pointer to the record in the form. 

 

Working with Queries 

Queries are the primary mechanism for retrieving information from a database based on 

the questions presented to the database in a predefined format.  Tables hold the information, 

queries contain stored questions.  

 Queries can be created in two different ways; Using Query Design and Using Query 

Wizard. 
 
Creating a Query 

 

A query can be based on tables or on other queries. To create a query, you open the 

tables or queries on which you are going to base your query in Query Design view, and then use 

the options in Design view to create your query. You then click the Run button to display the 

results. You can save queries for later use. 
 

1. From the Create tab click the Query Design button in the Other group. The Show Table 
dialog box appears. 

2. Activate the Tables tab if you want to base your query on tables, activate the Queries tab if 
you want base your query on queries or activate the both tab if you want to base your query 
on both tables and queries. 

3. Click to choose the table or query on which you want to base your query. 

4. Click Add. The table appears in the window. 
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5. Click to choose the next table or query on which you want to base your query. 

6. Continue clicking tables or queries until you have all the tables and queries you plan to use. 

7. Click Close. Access changes to Query Design view 

 

 
 

Display All Records and All Fields 

In Query Design view, each table has an option which will allow you to display all the 

fields in a table. It can be done by selecting the asterisk (*) followed by the table name 

(tablename.*).    
 

To change to Query Design view: 

1. From the Home Tab, Click the down-arrow below View in the Views group.  

2. Click Design View. Access changes to Query Design view to modify your query. 
 

Steps to retrieve selective Columns 

1. Open a table or query in Query Design view. 

2. Double click the field names that you want to display in the field line. 

3. Click the Run button.  
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Sort a Query 

Sort in Query Design view helps to arrange the rows in ascending or descending order. 

1. Open a table or query in Query Design view. 

2. Choose the field names that you want to sort. 

3. Under the field you want to sort, click the down-arrow and then choose Ascending or 

Descending. 

4. Click the Run button.  

Note: Like that you can sort multiple columns with the same method. 
 

Retrieve particular Records 

 Using the following steps one can view specific records from the table or query. 

1. Open a table or query in Query Design view. 

2. Choose the field names that you want to assign the criteria. 

3. Click the Run button. 

Criteria are used to sort out the data of a record(s) from a field(s) through a condition 

provided. Some of the most frequently used operators in criteria are given below: 

 

Operator Meaning 

= Equal to 

<> Not equal to 

> Greater than 

>= Greater than or equal to 

< Less than 

<= Less than or equal to 

In Equal to any item in a list 

Not In Not equal to any item in a list 

Between Brings the values between a range 

Not Between Not between two values 

Is Null Checks whether the field has no value 

Is Not Null Checks whether the field has any value  

Like Searches a value that is similar to the specified pattern 
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Creating Reports 

Report displays all the selected records. You can include summary data such as totals, 

counts, and percentages in a detail report. A summary report does not list the selected records 

but instead summarizes the data and presents totals, counts, percentages, or other summary 

data only. Access has several report generation tools that you can use to create both detail and 

summary reports quickly.  
 

Creating Report with simple method 

1. Open the Navigation pane. 

2. Click the table or query on which you want to base your report. 

3. Select the Create tab. 

4. Click the Report button in the Reports group and save it. 

5. The report lists in the navigation pane. 
 
Creating Report using Report Wizard 

Generating report using Wizard is better than other ways. The Report Wizard provides 

more flexibility than by using the Report button. You can choose the tables and fields, group the 

data, sort the data, summarize the data, choose a layout and orientation, apply a style, and title 

your report. Follow the steps shown here to create a report by using the Report Wizard: 

1. Click Report Wizard in the Reports group of Create Tab.  

2. Click the down-arrow next to the Table/Queries field and then select the table from which you 

want to select fields. And add the required fields. 

3. The Report Wizard moves to the next page. Click to select the field by which you want to 

group your data (Grouping puts all the values in a field into a group based on the field‘s 
value.)  and Click Next.  

4. Click the fields that you want to group by (it is optional) and Click Next.  

5. By using the Report Wizard, you can create up to four levels of sort.  This is also optional if 

you need to sort any field just select the field and Click Next. 

6. If you want to summarize, click to select the summary data you want. 

7. Click Next. The Report Wizard moves to the next page Layout and Orientation. 

8. Click Next to select the Style to display the Report, and click next. 

9. Give a suitable title to the Report and Click Finish 
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These are the sections of the Report. You can modify the report using Design View. 

Report Header : Appears at the top of the first page and displays the report title. 

Page Header : Appears at the top of every page and displays the headings (field labels) for 

each column. 

Page Footer : Appears at the bottom of every page and displays the page number and 

total number of pages. 

Detail Section : Appears between the page header and page footer and displays the 

records from the table or query. 

Report Footer : This section is optional. Appears on the last page of the report and displays 

summary information such as grand totals. 

Printing a Report 

Irrespective of the view, the user is in, any report can be printed out using the following 

steps: 

1. Open your report and Go to the Home Tab. 

2. Activate the Home tab. 

3. Click the down-arrow under the View button. A menu appears. 

4. Click Print Preview. Access changes to Print Preview.  You can make changes in this 

view using several options found here. 

5. Then click the print option in the Print Group. 
 

Importing Data from Other Databases 

 Importing data creates a copy of its information in a new table in your Access database 

or Access project. The source table or file is not altered in this process. 
 

Import data into an existing table 

1. Click the Microsoft Office Button, and then click Open. 

2. In the Open dialog box, select and open the database. 

3. On the External Data tab, in the Import group, click the command for the type of file that 

you are importing. For example, if you are importing data from an Excel worksheet, 

click Excel. If you don't see the program type that you need, click More. The Get External 

Data dialog box appears. 

4. In the Get External Data dialog box, click Browse to find the source data file, or type the 

full path of the source data file in the File name box. 
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5. Click the option that you want under Specify how and where you want to store the data in 

the current database. You can create a new table that uses the imported data, append 

the data to an existing table, or create a linked table that maintains a link to the data 

source. 

6. Follow the instructions on the next few pages of the wizard. The exact process will 

depend on the import options that you choose. 

7. On the last page of the wizard, click Finish. 

8. On the last page of the wizard, you might be prompted to save the details of these import 

steps. If you think that you will be performing this same import operation again in the 

future, select the Save Import Steps check box, and then enter the details and click Save 

Import. You can then easily repeat the operation at a later time by clicking Saved 

Imports in the Import group on the External Data tab. If you don't want to save the details 

of the operation, click Close. 
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OPEN OFFICE – BASE 
Introduction  

Open Office Base is a fully featured desktop database management system, designed to 

meet the needs of a broad array of users.  Base offers wizards to help users new to database 

design to create Tables, Queries, Forms and Reports, along with a set of predefined table 

definitions for student‘s records, Employee Management, ticket booking, patient record 
management, tracking Assets, Customers, Sales Orders, Invoices and much more.  

MySQL, Microsoft Access, Microsoft SQL Server, Oracle are some of the databases. 

Like Microsoft Access, Base offers a choice of using Wizards, Design Views, or SQL Views for 

beginners, intermediate, and advanced users.   
 

The main features of BASE are:  

 Creating new tables and modifying existing ones 

 Maintaining indices 

 Viewing tables in an editing grid 

 Adding, modifying, and deleting records 

 Report Wizard (to produce impressive reports) and Form Wizard ( to create database 

applications) 

 Simple (single column) or complex (multi-column) data sorts 

 Simple (one-click) or complex (logical query) filters for viewing data 

 Powerful queries to show data in new ways, including summaries and multi-table views 

 Supplying address book data for mail merge 

 Creating linked data ranges in Calc files for data pilot analysis or as the basis for charts. 

Nowadays all sorts of works are occupied by databases.  Without knowing about the 

database tools, most of the processes are done by applications. It is not necessary to know 

whether the user should understand the database, by entering the data in the designed forms, it 

stores the data into the database.   

The user does not have to understand the entire database system. The maintenance, 

technical implementation and integration of databases are ensured by specialists. Administrators 

of the service using the data system are able to establish the user‘s access level to the database.  
The term database is used to refer to both the software and the integrated data storage 

mechanism at the same time. Open Office Base uses the Tables, Forms, Queries and Reports 

as objects for data management:  
 

Tables  

Data in a database are stored in a table or multiple interlinked tables. The table is the 

fundamental structure of a database, so it is important to understand how it works.  A table is 
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organized in horizontal and vertical termed as rows and columns respectively.  The column which 

contains information is defined as field. Fields are normally given a name in the column header 

based on the data. 

Each field is assigned by a data type like, numbers, text, etc. The helps to disallow the 

data which doesn‘t match data type of the field. Length limitations, format to the field is given at 

the properties. Row of the table is defined by the name of Record.   

Though, it is possible to create a database with a single large table, it is better to store 

data in separate tables.  
 

Primary key  

A primary key is a field or combination of fields that uniquely identify each record in a 

table. No two records in a table should have the same values in every field. The primary key is 

usually marked with a little key symbol.  
 

Forms  

 Forms are used to create, display and modify the records in the table. Entering the data 

into the table using Form is more easy and simple than entering directly into the Table. Forms 

may contain fields for data entry, action buttons, menus, pictures, and design elements.  
 
Queries  

Query is an important object in all databases, which is used to store and accumulate 

information, and ensure information retrieval according to specific criteria with or without 

Mathematical, logical actions. Once created, a query can be saved and later reused. Also that, a 

query can be designed to retrieve result from more tables. The result of a query is displayed in 

data table, form and report views. 
 
Reports  

A report is the final paper statement of the data present in the database.  We can make 

reports from tables, queries.  To print all the data in the table, it is better to use table, no need for 

query. To print selective records or columns based on the need, the user should use queries. 

The layout of reports can be modified. 
 
Creating a Database  

In Open Office Base, a database can be created by using the steps given below. 

 In Linux, Go to Applications  Office  OpenOffice.org Base. 

 In Windows, Go to Start  Programs  Office  OpenOffice.org Base. 

 In the Database Wizard, make sure that Create a New Database is selected and click 

Next and click Finish. 

 Enter the name to save the file and the location can be changed as user needs. 
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Creating Table using Wizard 

1. In the Database pane, select the object type Table. 

2. In the Tasks pane, click on Use Wizard to create Table. 

3. Select the database category, from which choose a table from the Sample tables list. 

4. Select the necessary fields in the table sample for the creation of the table. 

5. Click the respective button to insert the selected fields in the new table and click Next. 

6. Set the data type of the selected fields as required. 

7. Select a field in the selected field pane. 

8. In the field information pane, change the field properties and Click Next.  

9. Set primary to required field or check Automatically add a primary key and Click Next.  

10. Enter the table name and click Finish, to complete the table wizard:  
 
Creating Table using Design View 

1. In the Database pane, select the object type Table. 

2. In the Tasks pane, click on Create Table in Design View. 

3. Type the fieldname and select field type. (Fieldname should not have space, special 

symbols except underscore ‗_‘). 
4. Set primary to required field and Click Next.  

5. After entering the fields with datatypes press Ctrl+s to save the table. 
 
Creating a form by using a wizard  

 Like Table, Forms also can create by both Wizard and Design View. But using Wizard is 

better than Design. 

1. In the Database pane, select Forms. 

2. In the Tasks pane, click on Use Wizard to Create Form. 

3. In the Tables or queries menu, select the database table. 

4. In the Available fields menu, select the fields for the form. 

5. Move the selected fields or all fields to the pane Fields in the form 

6. Click Next.  (If necessary, add a sub form) 

7. Choose the Arrangement of the main form and click Next.  

8. Make sure that the form is to display all data is selected and click Next.  

9. In the Apply styles pane, select any style for the form background and choose border 

type and click Next. 

10. Enter the name to the form in the corresponding box.  

11. Make sure that Work with the form has been selected and click Finish. 
 
Entering, Modifying and Sorting Data  

Databases store data in tables and changes in the data can be made both by directly 

entering them in the table and by using forms linked directly or indirectly (with a query).  
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Entering Data in a Database  

To enter (modify) data in a table:  

1. Select a table. 

2. Open the table in data view. 

3. Select a data field in a record. 

4. Enter the data into the corresponding cells.  
 
To enter (modify) data in a form:  

1. Select a form. 

2. Open the form in data view. 

3. To select a record, enter the number of the record in the Absolute Record field. 
(navigation buttons also supports to go particular record). 

4. Press Enter on the keyboard;  

5. Click inside the corresponding field and type the data. 
 
Creating a New Record  

Like Microsoft Access it is possible to create a new record in table and also in form.  In 

Open Office Base, to create a new record, click on the buttonwhich is just before save icon in 

the navigation button. 

To create a new record while using a table in data view, no additional actions are 

required.  

 Open a form in data view 

 Go to the last record 

 Click the navigation button Next Record 
 
To sort table records in ascending order by a selected field:  

 Open a database table (form, query) in data view. 

 Select the field by which to sort. 

 Click the Sort Ascending button.  

 Save the changes in the table.  
 
To sort table records by several fields:  

 Open a database table in data view. 

 Click the Sort button. 

 In the first Field Name menu, select the first field by which to sort. 

 In the Order menu, choose the sort order: Ascending for alphabetical order, 
Descending for reverse alphabetical order. 

 Repeat the steps for the following sort conditions. 

 Confirm by clicking OK. 
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Record Search  

Following steps is very useful method to search the specific data in large tables for 

viewing, modification or replacement with a different value.  

 Open a table in data view;  

 Click the Find Record button in the toolbar:  

 In the Record Search dialogue box, enter the value to search for and the search settings;  

 Click Search;  

 View the result marked in the table with a red border, perform the necessary actions;  

 To continue searching, click Search again;  

 Stop searching by clicking Close in the Record Search dialogue box.  
 
Creating a New Query With the Query Wizard 

In OpenOffice.org you can create a new query using the Query Wizard 

1. Open the database file where you want to create the new query. 

2. In the left pane of the database window, click the Queries icon. 

3. Click Use Wizard to Create Query. 

4. Specifies the table to create query, and specifies which fields you wish to include in query. 

5. Specifies the sorting order for the data records in your query. 

6. Specifies the search conditions to filter the query.  

7. Specifies whether to display all records of the query, or only the results of aggregate 
functions.  

8. This page is only displayed when there are numerical fields in the query that allow the use of 
aggregate functions. 

9. Specifies whether to group the query. The data source must support the SQL statement 
"Order by clauses" to enable this page of the Wizard. 

10. Specifies the conditions to group the query. The data source must support the SQL 
statement "Order by clauses" to enable this page of the Wizard and click Finish. 

11. Applies all changes and closes the wizard. 
 
Creating a New Report With the Report Wizard 

1. Open the database file where you want to create the new report. 

2. In the left pane of the database window, click the Reports icon. 

3. Click Use Wizard to Create Report. 

4. Specifies the title that is printed at the title line of each page. 

5. Saves the report as a static report. When you open a static report, it will always display the 
data from the time the report was created. 

6. Saves the report as a template. When you open a dynamic report, it will display with the 
current data contents. 

7. When you click Finish, the report will be saved and opened for edit. 

8. Create report now 

9. When you click Finish, the report will be saved. 

vnd.sun.star.help://shared/text/shared/explorer/database/querywizard00.xhp?Language=en-US&System=WIN&UseDB=no&DbPAR=swriter
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QUESTIONS AND ANSWERS 

I. Fill in the blanks 
1. Expansion of RDBMS is Relational Data Base Management System. 

2. The extension of Microsoft Access 2007 database file is .accdb. 

3. A table is the basic object of Microsoft Access. 

4. A Primary Key is a field or combination of fields that uniquely identify each record in a table. 

5. Update Query is used to add / modify the information in the fields of the table. 

6. Hyperlink data type is used to store web addresses. 

7. Report is a final paper statement of the data present in the database. 

8. Each field in a table is assigned by a data type.  

9. Forms are used for Easy Data Entry. 
   

II. Choose the best answer 
1. Which of the following is not a valid data type in  

a)  Date  b) Auto Number  c) Text  d) Currency 

2. In Base, Macros is found in  
a)  File Menu b) Tools Menu  c) Data Menu d) Insert Menu 

3. Table structure can be modified using  
a)  Form  b) Report  c) Design View d) Preview 

 
III. Match the Following 

1.  .accdb   - Microsoft Access 2003   (5) 

2.  Wizard   - Structured Query Language  (4) 

3.  Templates   - Microsoft Access 2007   (1) 

4.  SQL    - Step by Step Method   (2) 

5.  .mdb   -  Built-in Format    (3) 

III. Say true or false 

1. A database can have only one table.      (F) 
2. More than one field in a table can have same field name.   (F) 
3. A macro is a set of sequence of operations.     (T) 

IV. Write answer in two or three lines 

1. What are the data types supported by Ms-Access? 

2. What is a Table? 

3. What are the types of queries in Microsoft Access? 

4. List the steps to design database in Ms-Access. 

5. Write the steps to create form using Wizard. 

6. What are the sections of report in Microsoft Access? 

7. How do you print a form? 

8. Define Primary Key. 

V. Write answer in brief 

1. How will you find, add or delete a record in Microsoft Access? 

2. Write in detail about adding objects to records in Access. 

3. What is Report? Write the steps to create a report in simple method in Excel. 

4. How do you create a form by using a Wizard in Open Office Base? 

5. Write the steps to sort records in Base.
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MICROSOFT POWERPOINT 
Introduction  

Microsoft PowerPoint is an application that is used to design computer-based 

presentation consisting of multiple slides with images, text, video clips, and related types of 

information. Slide shows can also be created with the help of Power Point. These presentations 

are helpful in teaching a class, advertising products, explaining anything, etc. The presentation 

can run automatically or can be controlled by a presenter. 

 In Microsoft PowerPoint 2007, there are many new features are added while comparing 

with the earlier versions. Like other applications like Word, Excel and Access, PowerPoint tools 

are also designed with Groups and Tabs which are grouped by the Ribbon.  
 

Opening a New Presentation  

 Click Start Button  select All Programs  Microsoft Office  Microsoft PowerPoint 

2007.  The PowerPoint application opens with a New PowerPoint Presentation which is as 

shown below.  

 

All the slides added in the presentation are listed in the Slides Tab in left side. The 

working slide appears in the Slide Pane. 

 
 

 Slides & Outline Tab 

Ribbon 

Slide Pane Working Slide  
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         Some of the available built-in 

layouts like Title Slide, Title & 

Content, Two Content, Comparison, 

Title Only, Blank, Picture with 

Caption, etc. can be added from the 

drop down list of New Slide.  

 

Tools to change 

Colors, Fonts and 

Effects of the 

chosen Theme 

The Ribbon in the Microsoft PowerPoint has seven Tabs. They are Home, Insert, 

Design, Animations, Slide Show, Review and View. These Tabs also have several options 

organized into groups. They are listed below: 
 

Home : Clipboard, Slides, Font, Paragraph, Drawing, Editing 

Insert  : Tables, Illustrations, Links, Text, Media Clips 

Design : Page Setup, Themes, Background 

Animations : Preview, Animations, Transition to This Slide 

Slide Show : Start Slide Show, Set Up, Monitors 

Review : Proofing, Comments, Protect 

View  : Presentation Views, Show / Hide, Zoom, Color/Gray Scale, Window, Macros 
 

CREATING A NEW SLIDE  

PowerPoint provides a single slide by default as 

shown above, further more slides with different layouts can 

be added by pressing the short cut Ctrl+m or by any of the 

three given methods:  

 On the Home tab, in the Slides group, click New Slide.  

 Right-click on the slide from the Slides Tab and select 

New Slide on the pop-up menu. 

 Click on a slide from the Slides tab and hit the enter 

key. 
   

 Any slide can be duplicated by using the short cut 

Ctrl+D.  

 

 

Formatting Slides 

 Slides can be 

designed with the help of 

predefined formats found in 

the Themes Group of Design 

Tab either to all the slides in 

the Presentation or only to 

selected slide(s) by right 

clicking on the design and 

giving the required choice as in the figure. 
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 Every slide appears in Landscape mode, but it can be also changed to Portrait mode if 

necessary using Page Setup Group of Design Tab. 
 

Designing a Slide 

 Pictures, Tables, Clip Arts, Text Box, Shapes, Charts, Symbols, etc. can be inserted as it 

is done in other Microsoft applications like Word, Excel. In addition to this, Photo Album, Movie 

and Sound are the exclusively available tools in PowerPoint.  

 Contents can be typed into the Textbox that usually appears whenever a new slide is 

created.  Additionally, contents can be fed in the slide with the help of Textbox.  

To insert a movie / sound click on the Movie / Sound in the Media Clips group of Insert 

Tab. As soon as, it is clicked a dialog box appears through which the location of the necessary 

movie / sound can be given to add in the working presentation.   
 

Animations 

 It is possible to animate any objects of slides, like textbox, pictures, shapes, SmartArt, 

etc. in PowerPoint with different styles.  

 To animate the required object, first select the object and then click Custom Animation in 

Animations group of Animations tab. Now the Custom Animation Pane appears in the right of the 

presentation. With the help of this pane, the necessary effects are added to the selected object. 

Starting mode, Duration, Direction and Speed of the effects can also be altered.  

 

 

Custom Animation Pane - where effects are added 
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A dialog box that appears, after clicking the effect options, to set direction, 
sound, time, sound, speed, etc. 

 
 

A popup menu appears after right 
clicking an added effect 

 

 
 

To insert sound click on Sound and then click 
Sound from File. 

 

 

 

 
 

Select Automatically, to run the sound on its own or  
select When Clicked to run the sound  

whenever it is clicked 

 

 
The above shown symbol appears  

after adding an audio file. 

 

 
A video file after it is added 



 Venus Computers   Unit-6: Microsoft PowerPoint 

 

179 

 

Slide Transitions 

 To run a slide show automatically with constant time interval between slides, check 

Automatically After in Transition To This Slide group of Animation tab.  If it is to be run after 

mouse clicks or enter presses, check the On Mouse Click which is above Automatically After. 

 If necessary, sound can be given between slide transitions and transition speed can also 

be set using Transition Sound and Transition Speed respectively. 
 

Slide Show (F5) 

 Slide show is a presentation of the prepared slides. It can be run in different ways, such 

that, from beginning and from current slide. To run a presentation from beginning click From 

Beginning in Start Slide Show group of Slide Show tab. Click From Current Slide found in the 

same tab and group to run the presentation from the current slide. 

 Custom Slide Show in Start Slide Show group of Slide Show tab, is used to run only the 

selected slides 

  
View and its kinds 

 Whenever the prepared slides are to be displayed other than the way that is displayed 

usually, views are useful in that case.   Views are of four types, namely,  

 Normal: This tool provides the normal display where slides and outline tabs are on the 

left side and the slide pane appears next to those tabs.  

 Slide Sorter: This tool is used to list all the prepared slides at a time and to arrange the 

slides as per the necessity.  

 Notes Page: This tool is helpful whenever notes are to be added for a slide.  

 Slide Show: This tool is used to run the presentation in full screen view. 
 
Slide Master 

 To have a specific layout for all the slides, Slide Master is used. 
 
Making PowerPoint Show File 

 PowerPoint Show is basically a presentation that is programmed to automatically launch 

in Slide Show mode. It can‘t be edited. To make a PowerPoint show file, save the presentation 
file as PowerPoint Show. 

Some of the shortcut keys to work with Microsoft PowerPoint 

Purpose Key 

Bold Ctrl-B 

Close Ctrl-W 

Close Ctrl-F4 

Copy Ctrl-C 

Cut Ctrl-X 

Find Ctrl-F 

Italics Ctrl-I 
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Menu bar F10 

Move to the end of the entry End 

New (slide) Ctrl-N 

Next window Ctrl-F6 

Open Ctrl-O 

Paste Ctrl-V 

Print Ctrl-P 

Repeat Find Shift-F4 

Repeat/Redo Ctrl-Y 

Replace Ctrl-H 

Save Ctrl-S 

Select all Ctrl-A 

Slide Show:  Begin the slide show F5 

Slide Show:  Black screen show/hide B 

Slide Show:  End Esc 

Slide Show:  Erase annotations E 

Slide Show:  Go to next hidden slide H 

Slide Show:  Hide pointer and button always Ctrl-L 

Slide Show:  Hide pointer and button temporarily Ctrl-H 

Slide Show:  Mouse pointer to arrow Ctrl-A 

Slide Show:  Mouse pointer to pen Ctrl-P 

Slide Show:  Next slide N 

Slide Show:  Previous slide P 

Slide Show:  Set new timings while rehearsing T 

Slide Show:  Stop/restart automatic slide show S 

Slide Show:  Use mouse-click to advance (rehearsing) M 

Slide Show:  Use original timings (rehearsing) O 

Slide Show:  White screen show/hide W 

Spelling and Grammar check F7 

Switch to the next presentation window Ctrl-F6 

Switch to the next tab in a dialog box Ctrl-Tab / Ctrl-Page Down 

Switch to the previous presentation window Ctrl-Shift-F6 

Switch to the previous tab in a dialog box Ctrl-Shift-Tab / Ctrl-Page Up 

Turn character formatting on or off Num / 

Underline Ctrl-U 

Undo Ctrl-Z 
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OPEN OFFICE – IMPRESS 
Introduction  

OpenOffice Impress is a presentation application which does the same job as what 

Microsoft Office PowerPoint does. Impress produces presentations and slide shows through 

graphical approach in a simple way. Unlike Microsoft Office PowerPoint 2007 it has Menus 

instead of Ribbon.   

A PowerPoint file can be opened and used through Impress. An Impress made 

presentation can be saved as PDF, HTML, PowerPoint formats.  

 

Starting with Open Office Impress 

 In Linux: Applications  Office  OpenOffice Impress 

In Windows: Start  Programs  OfficeOffice.org3.2  OpenOffice.org 3.2 Impress 

 As soon as Impress is opened, Presentation Wizard appears as shown below, containing 

three stages which are discussed below: 

Stage 1: 

 Here type of the presentation is to be chosen from three choices which are as shown 

below. 
 

Empty Presentation To open a fresh blank presentation 

From Template    To open an already designed presentation from the 
templates  provided by Open Office Impress 

Open existing presentation To open an existing Presentation 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Stage 2 & 3 will not appear if an existing presentation is opened. 
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Stage 2: 

In stage 2, the wizard shows a list of Slide designs and output medium which should be 

chosen for the presentation. 

 

 

Stage 3: 

In stage 3, Transitions and its types for the presentation are chosen here.  

 

 

 

Saving Presentation 

 Saving a presentation is similar to saving a file in other suites of Open Office and can be 

saved in various formats and versions of Microsoft Office, Open Office and Start Office Suites. 
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Inside Open Office 
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 As told previously, unlike PowerPoint 2007, Impress does not have any tabs or groups, 

but instead it has menus in the place of tabs. There are nine menus available which are File, 

Edit, View, Insert, Format, Tools, Slide Show, Window and Help.  Usually, Slide Pane appears on 

the left side and Task Pane appears on the right.  The working slide appears at the centre. 
 
Slide Pane 

 Slide Pane lists out the all the slides present in the presentation. A new slide can be 

added to the presentation by just right clicking on the slide pane and clicking New Slide. 
 
Task Pane 

 Task pane consists of five sections, which can be opened by clicking the triangle near 

the name of the Section.  Only one section can be opened at a time.  The five sections available 

in the task pane are listed and discussed below: 
 
Master Pages 

 Master Pages gives a list of designs to the slides which can be applied either to all the 

slides or only the selected slide(s).   
 
Layouts 

 Layouts section has different predesigned formats of slides which shall be given to a 

selected slide or a new slide can be inserted with the preferable layout.  

 
Table Design 

 Table Design is helpful in inserting a new table with necessary style. As soon as a table 

is inserted, Table tool bar also appears, which provides tools for editing and modifying the table 

further, like split cells, merge cells, add row / column, delete row / column, etc.  
 
Custom Animation 

 Custom Animation adds an animation to individual elements like, title chart, image, 

bullets, of a slide.  Animation effects need to be applied from normal view, so that individual 

objects on the slide can be selected.  
 

Adding an effect to an object 

 First, ensure that the working slide is in normal view. 

 Select the object to which effect is to be given.  

 Go to Custom Animation section in the Task Pane and click Add. 

 Custom Animation dialog box appears with five tabs, Entrance, Emphasis, Exit, Motion 

Paths and Misc Effects, by which required effect can be added to the selected object. 

Preview of an effect can be seen, before adding, by just clicking on the effect once. 
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Added effects can be changed or removed. Timing and Sound can also be set for an 

effect. More than one effect can be applied to an object. 
 
Slide Transition 

 Like individual objects have effects, slides can also have transitions. Transition, set here, 

can be applied either to all the slides or only to selected slide(s). Like Microsoft PowerPoint, 

Transitions shall be run in different ways; one is to run the transition after mouse clicks, or enter 

presses. The other one is to run the transition automatically.  
 
Templates 

 Templates are the pre-designed slides with different layouts, instead of creating new 

layouts for the working presentation, and can be modified as per the need. 
 
Making a presentation using templates 

FileNew Templates and Documents.     

 After Templates and Documents is clicked, Templates and Documents dialog box 

appears.  Go to Templates and enter into Presentation folder.  A list of pre-designed templates is 

shown and any templates can be chosen. 
 
Working with Master Slide 

 Master Slide helps in adding any object(s) to all the slides in the presentation. To set a 

master slide, Go to View menu and click Slide Master in Master. After working with the master 

slide, click Close Master View in the Master View tool bar.  
 
Printing Handouts 

 After the presentation is prepared, Handouts is useful to print more than one slide in 

single page. It can be done by the following steps. 

 Go to File menu‘s Print. 

 Select Handouts from the drop down of Print Content Section, Slides per page will be 

enabled. 

 Select, number of slides per page to be printed. 

 Press OK. 
 
Working with Ms-PowerPoint Files 

It is possible to work Microsoft PowerPoint file in Open Office Impress and vice verse.  

The Presentation created in Microsoft PowerPoint can be opened, viewed and modified in Open 

Office Impress as in usual methods. Saving an Impress file in PowerPoint can be done by simply 

changing the File type to Microsoft PowerPoint 97/2000/XP(.ppt) in the Save dialog box with the 

confirmation.  
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QUESTIONS AND ANSWERS 

I. Fill in the blanks 

1. The keyboard shortcut to run the presentation is F5. 

2. Themes to the presentation can be changed from the Design tab. 

3. Shortcut to insert a new slide is Ctrl +M. 

4. A file which contains built-in styles that can be used for a presentation is called Template. 

5. The extension of Open Office Impress is .odp. 

6. An animation is a special visual and audio effect applied in PowerPoint to text or content. 

7. The file created by PowerPoint is called Presentation. 

8. Slide transition is feature that adds special effects to modify the appearance of the slides 

and the timing between each slide. 
 

II. Choose the best answer 

1. What tab on the Ribbon would you find slide background? 

a)  Design  b) Animations  c) Slideshow  d) Insert 

2. The arrangement of elements such as title, text, pictures, tables, etc. in PowerPoint is called  

a) Wizard  b) Layout  c) Menu  d) Ribbon 

3. In which view the slide sequences can be arranged in PowerPoint? 

a) Slide Sorter b) Normal   c) Notes Page  d) Slide show 

4. In Ms-PowerPoint which master allows the user to change the background, color and size of 

the slides? 

a) Notes Master b) Handout Master c) Slide Master  d) None of the above 

III. Say true or false 

1. Short cut to create a new Presentation is Ctrl + C.     (F) 

2. Microsoft Access is an application used to create a Presentation.   (F) 

3. Shortcut to view Side show is F7.       (F) 

IV. Write answer in two or three lines 

1. Write the uses of Microsoft PowerPoint and the steps to launch. 

2. What are the views found in Microsoft PowerPoint? 

3. What is Slide Transitions? 

4. How do you add effects to the Presentation? 

5. Write the steps to animate an element in PowerPoint. 

6. Explain about the Master Slides. 

7. Write about Custom Animation. 

8. What are the views found in Microsoft PowerPoint? 

9. How do you add a slide in a presentation? 

V. Write answer in brief 

1. Write the steps to insert an image and a sound file in Microsoft PowerPoint. 

2. How do you create a presentation in Open Office Impress? 

3. Write about the Handout in Presentation. 
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INTERNET & ADVANCED COMMUNICATION 
 

INTERNET AND WEB BROWSERS 

Definition  

 The Internet is a worldwide collection of computer networks. It provides access to 

communication service and information resources to millions of users around the globe. Internet 

is also called as the network of networks. It is a group of two or more networks that are 

interconnected, capable of communicating and sharing data with each other, and able to act 

together as a single network. 

The computers on one network can communicate with computers on other networks and 

send data, files and other information back and forth. For this it follows a set of rules called 

TCP/IP Protocol (Transmission Control Protocol/Internet Protocol). The Internet covers the globe 

and includes large, international network as well as many smaller, local area networks (LANs).            

It is not owned by any individual, company or country. 
 

Uses of Internet 

1) Email:  Email and chat facilities are possible with the help of internet. Anybody can 

communicate with anyone who is at anywhere in the world at any time.  There are plenty 

messenger services and email services offering this service for free.  

2) Information: The biggest advantage that internet offering is information. This means that 

millions of web sites include various data in the shape of text, images and text on every subject, 

which can be easily collected by the users. For this facility, special sites, called search engines 

can be found on the Internet. 

3) Business: It is possible to carry out financial transactions online. Internet users can transfer 

funds, pay taxes and utility bills or book movie tickets over the Internet in the comfort of user‘s 
location. The growth of e-commerce has made it possible for people to shop for most things 

online with attractive advertisements`.  

4) Social Networking: Today social networking sites have become an important part of the 

online community. Almost all users are members in Social Networking and use it for personal 

and business purposes. It's an awesome place to network with many entrepreneurs who come 

here to begin building their own personal and business brand. Ex: Facebook, Twitter … 

5) Entertainment: On internet, users can find all forms of entertainment like watching films, 

playing games online. When people surf the Web, there are numerous things that can be found. 

Music, news and more can be found and shared on the Internet. There are numerous games that 

may be downloaded from the Internet for free. 



 Venus Computers   Unit-7: Internet & Advanced Communications 

 

 190 

6) Services: Many services are now provided on the internet such as online banking, job 

seeking, purchasing tickets for your favorite movies, and guidance services on array of topics in 

the every aspect of life, and hotel reservations and bills paying. Often these services are not 

available off-line and can cost you more. 
 

Web Addressing 

The World Wide Web is a set of protocols that allows user to access any document on 

the net through a naming system based on URLs (Uniform Resource Locators). A web 

address identifies particular file on the internet, usually consisting of the protocol as http followed 

by the domain name.  Every computer connected to the internet has its unique web address, 

without which it cannot be reached by other computers.  
 

URL 

 URL, Uniform Resource Locator, is the generic term for all types of names and 

addresses that refer to objects on the World Wide Web.  It is a pointer to information on the 

WWW. It is the format which HTTP uses to find a web page. The term "Web address" is a 

synonym for a URL. 
 

DIFFERENT TYPES OF INTERNET CONNECTIONS 

Dial –up connection 

 In this connection, user can connect to the ISP using a telephone line and a MODEM. In 

this connection, the user computer is connected to the telephone line via MODEM. The MODEM 

converts the computer data into modulated signals that the telephone line can transmit. These 

signals are received by a MODEM at the ISP computer and demodulated into computer data. 

 To establish a dial-up connection to the Internet, user needs the following: 

1. An account with an Internet Service Provider (ISP). In India VSNL, Dish net, Satyam Online 

and some other ISPs are available. 

2. A telephone line connection. 

3. A computer with serial port for connecting external MODEM or an expansion slot for 

connecting Internal MODEM. 

4. A MODEM (external/internal). 

5. A browser software such as Microsoft Internet Explorer, Netscape navigator, etc. and an e-

mail software such as Microsoft Internet Mail, Netscape Messenger, Eudora Pro, etc. For 

shell account holders the browser software Lynx and the e-mail software Pine are available 

on the VSNL server and can be accessed using the shell account menu. 
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Broadband connection 

The term broadband commonly refers to high-speed Internet access that is always on 

and faster than dial-up access.  It is a wide bandwidth data transmission that can simultaneously 

transport multiple signals and traffic types.  The medium can be coaxial cable, optical fiber, 

twisted pair etc. In this telecommunication, there is a wide band of frequencies available to 

transmit information.  Since there is a wide band of frequencies available, information can be 

multiplexed and sent on many different frequencies or channels within the band concurrently, 

allowing more amount of information to be transmitted simultaneously. 
 

Wireless  

In networking, wireless is a network connection which does not require any physical 

wired connection between the sender and the receiver. It is connected by radio waves and/or 

microwaves to maintain communications. 
 

Wi-fi (Wireless Fidelity) 

With wifi user can access or connect to a network using radio waves, without using 

wires. 
 

Wi-max (Worldwide Interoperability for Microwave Access) 

WiMAX is one of the hottest broadband wireless technologies around today. WiMAX 

systems are expected to deliver broadband access services to residential and enterprise 

customers in an economical way. WiMAX would operate similar to WiFi but at higher speeds 

over greater distances and for a greater number of users. 

 

Satellite Connection 

Satellite Connection is a telecommunications network provided by orbital communication 

stations. Signals from these satellites allow a user with a dish to have a high speed internet 

connection. 

 

BROWSER 

Browser is an application used to locate, retrieve and display content on the World Wide 

Web, including Web pages, images, video and other files. As a client/server model, the browser 

is the client run on a computer that contacts the Web server and requests information. The Web 

server sends the information back to the Web browser which displays the results on the 

computer or other Internet-enabled device that supports a browser. 

 Examples of Web browsers are:  Google chrome, Internet explorer, Mozilla Firefox 

 
 

http://www.webopedia.com/TERM/W/World_Wide_Web.html
http://www.webopedia.com/TERM/W/World_Wide_Web.html
http://www.webopedia.com/TERM/W/web_page.html
http://www.webopedia.com/TERM/C/client_server_architecture.html
http://www.webopedia.com/TERM/C/client.html
http://www.webopedia.com/TERM/S/server.html
http://www.webopedia.com/TERM/W/Web_server.html
http://www.webopedia.com/TERM/W/Web_server.html


 Venus Computers   Unit-7: Internet & Advanced Communications 

 

 192 

Search Engine  

Search Engine is a software program that searches the database then gathers and 

reports information that contains or is related to specified terms. It is also a website whose 

primary function is providing a search engine for gathering and reporting information available on 

the internet or a portion of the internet. 
 

Portal 

A Web portal or public portal refers to a Web site or service that offers a broad array of 

resources and services, such as e-mail, forums, search engines, and online shopping malls. The 

first Web portals were online services, such as AOL, that provided access to the Web, but by 

now most of the traditional search engines have transformed themselves into Web portals to 

attract and keep a larger audience.  
 

Social Networking Sites 

A social networking website is an online platform that allows users to create a public 

profile and interact with other users on the website. Social networking websites usually have a 

new user input a list of people with whom they share a connection and then allow the people on 

the list to confirm or deny the connection. After connections are established, the new user can 

search the networks of his connections to make more connections. Ex: Facebook, Twitter, … 
 

Blog 

A blog (short for weblog) is a frequently updated online personal journal or diary. Blogs 

are defined by their format: a series of entries posted to a single page in reverse-chronological 

order. It is a place to share your thoughts and your passions. In simple, Blog is user‘s own 

website that user can update on an ongoing basis. 
 

FTP  

The File Transfer Protocol (FTP) is the Internet facility for downloading and uploading 

files. While uploading a file to another site, user must usually have permission in advance to 

access the site and the directory where the file is to be placed. 

  

Uploading  

Uploading is the transmission of a file from one computer system to another, usually 

larger computer system. Uploading is opposite to downloading, from a network user's point-of-

view, to upload a file is to send it to another computer that is set up to receive it.  

 

 

 

http://www.webopedia.com/TERM/W/Web_site.html
http://www.webopedia.com/TERM/E/e_mail.html
http://searchsoa.techtarget.com/definition/weblog
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Downloading files 

There are millions of files, utilities and applications across the internet that you can try 

out free of charge. We can download those files or transfer them to your PC using a protocol 

called File Transfer Protocol(FTP). 

 To transfer files using FTP, you need to have an FTP program or FTP client installed on 

our computer. 

 There are many ways of logging on to FTP sites and downloading files. The two most 

common methods are to use an FTP client like Cute FTP or ftp explorer or to use your web 

browser. If we want to access the Microsoft corporation‘s ftp site you should key in the url as 
ftp://ftp.microsoft.com. 
 

E-mail 

Electronic Mail (e-mail) is an electronic message sent from one computer to another via 

communication links. The messages sent may be personal or business-related with attachments 

like pictures or other documents. 

Just as a letter or document makes stop at different postal stations along its way, an e-

mail is also passed from one computer to another as it travels along the network. Each computer 

reads the e-mail address and routes it to another computer until it reaches the destination. It is 

then stored in an electronic mailbox. With the Internet, this whole process takes a few minutes 

which makes the communication so quickly and easily around the world anytime. 

We can send e-mail to anyone for those having an e-mail address anywhere in the 

world. Initially e-mail was good for only short textual information. Now-a-days, after the invention 

on Multipurpose Internet Mail Extension (MIME), we can also send formatted documents, photos, 

sound files and video files as attachments. 
 

Components of an e-mail 

One piece of an e-mail has three main parts: 

1. Headers 

2. Message body 

3. Signature 
 

Contents of a Header 

1. Date  : date of writing the e-mail 

2. From  : the sender‘s e-mail address 

3. To  : e-mail address of the recipient 

4. Subject  : brief narration about the content of the e-mail 

5. Cc  : list of other recipients known to receiver 

6. Bcc  : list of recipients to be disclosed to receiver 
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7. Attachments : name of the other objects such as Programs / image files sent  

    along with the e-mail documents. 

8. Reply to : Sender‘s email-id will appear in this by default.  
 

Message body 

 This is the actual content of the e-mail. We can type in the contents manually or we can 

copy it from an already typed or stored document. Also we can insert graphic elements and 

pictures in the body of the message itself. It is possible to send blank e-mail with only the header. 

Signature 

 The signature is not the signed name but a sequence of lines usually giving some 

information about the person who sent the e-mail. It is optional and it is made up of anything the 

user wants to include usually a postal mail address. We need not to type in the signature each 

time. E-mail software will automatically append the contents of a specified file to each outgoing 

e-mail. 
 

Attachments 

 We can attach computer files to the e-mail messages. When the recipient gets an e-mail 

with an attached file, recipient will get a message that a file is attached and the recipient can 

download the file to the computer. 
 

Reading E-mail 

 To read the received E-mail, mail window must be opened first. Then e-mail program 

contacts ISP server that delivers mail. Received messages can be viewed at Inbox. The list of 

mails in the Inbox folder is displayed in the Message List pane. We can read any message by 

clicking on the mail and the corresponding message is displayed in the message display area. 

We can move from message to message by either selecting one from the message list and 

clicking on it with the mouse, clicking on the icons PREVIOUS and NEXT from the Toolbar, or 

choosing an item from the Go pull down menu that takes displays another message. 
 

Saving Messages 

 We can save a message into a file or onto a folder. To save an e-mail message as a file, 

go to the message list and select the entry for the message you want to save by clicking on it. 

Then click on FILE on the Menu bar and select SAVE AS or press Ctrl+S. A SAVE AS …. Dialog 
box pops up and type in the name of the file to hold the message. Saving a message to a file is 

useful if we want to use the body of the message with some other program. More than one 

message can be saved into a folder by highlighting a group of messages. Click on Message in 

the Menu Bar and choose either MOVE or COPY. Choosing either one brings up a menu from 

which we can choose the folder in which we want to save the message. 
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Printing Messages 

 To print a message, select it by clicking on its entry in the message list and then click on 

the print icon. A window pops up, we can select a printer, set options and finally click on the 

button OK. 
 
Deleting Messages 

 Deleting messages is necessary to keep the amount of e-mail in the inbox and other 

folders under control. Select the entries in the message list and press the DELETE key on the 

keyboard or press the icon DELETE. Deleting a message sends it to the folder TRASH. To 

delete the mail permanently go to trash folder and delete it. 
 
Composing and sending E-Mail 

Composing e-mail means creating e-mail which is done by following the steps given below.  

1) Open the compose mail window. 

2) Fill in the header which should contain the recipient‘s address. 

3) Compose/type the message body. 

4) Send it by clicking on the icon labeled Send. 

 We can move to header to header by pressing the tab key. It contains three parts  

Send To : addresses of primary receiver(s) 

Cc  : addresses where copies of the e-mail will be sent  

Subject  : What the message is about (brief description) 

Attachments : Files to be attached along with the message.  
 
Composing the Message Body’s 

 Type the message to be sent into the message body or compose the message using any 

other word processor and copy it to the message body. The e-mail software will align the 

message accordingly. 
 
Including attachments 

 Anything that is not in plain text format has to be an attachment if it is sent in e-mail. 

Click on the icon Attachment to attach a file to the message and choose the file to be attached. 
 
Replying to a Message 

 We can reply to the current message by clicking on the icon labeled REPLY.  We can 

reply while we are reading a message or by clicking on the reply icon. Clicking on the REPLY 

icon brings up a mail composing window just like the one for new message. But send to address 

is automatically filled. If the address list in the original one includes several people you can send 

a reply to everyone on the To : or Cc : list by pressing the icon labeled Reply All. The message 

window is now filled with the original message with an indication symbol > in all the lines of the 

original message.  
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Forwarding E-mail 

Forwarding e-mail means passing the e-mail we have received to another address. We 

can do it by selecting one or many e-mails from the message list and then clicking on the icon 

labeled forward. 

When we select the message to be forwarded, a message composing window will 

appear. The Subject: field is filled with [Fed: ―subject of original message‖] and the message or 
the messages being forwarded are included as attachments. Any attachments to the original 

message are included with the forwarded message. 

Note: The above steps may vary for email accounts in different email service providers 

like gmail, yahoomail, rediffmail, etc.  
 

Electronic Gadgets 

 Electronic gadgets are small electronic or mechanical devices. The availability of 

electronic gadgets has exploded over the years, and the technology of these devices has only 

improved. It seems electronic gadgets exist for every facet of life, from entertainment to 

education, from work to play. Entertainment gadgets include mp3 players, book e-readers, 

portable movie players, cell phones, and digital cameras. Gadgets for work include cell phones, 

portable computers and tablets, digital watches, and many more. Gadgets seem to be available 

to suit any need in the modern age. 

 The general purpose of most electronic gadgets is to make life easier, more fun, or more 

efficient. Computers are perhaps the most sought-after electronic gadgets that fall into just about 

any category. Tablets are thin, small computers that are touch-screen activated and navigated. 

They are useful as an e-reader, as a portable communications device, as a creative tool, and so 

on. The technology changes rapidly, and these tablets tend to get thinner, smaller, and more 

functional with each new iteration.  
 
Tablet  

A tablet is a wireless, portable personal computer with a touch screen interface. The 

tablet form factor is typically smaller than a notebook computer but larger than a smartphone. It is 

not very heavy, smaller in size with / without flexible screen.   
 

Advantages of Tablet 

1. It is portable 

2. It can be used as an e-book reader 

3. It is comfortable to use 

4. It is very functional 

5. It uses a reliable OS 

6. It has powerful social networking tools 

7. It is better than a smartphone 

http://searchcio-midmarket.techtarget.com/definition/touch-screen
http://whatis.techtarget.com/definition/form-factor
http://searchmobilecomputing.techtarget.com/definition/smartphone
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Smartphone 

Mobile phone which includes functions similar to those found on personal computers is 

smartphone. Smartphones provide a one-stop solution for information management, mobile 

calls, email sending, and Internet access. Smartphones are compact in size and often only 

slightly bigger than standard mobile telephones.   

 Smart phones have the ability to browse full websites with large amount of data and it 

will appear the same way as it is in the desktop browser. 

 Also has QWERTY keyboard which is similar to the computer keyboard.  

 Smart phones have applications that can help you create and edit Microsoft office 

documents. 

 Smart phone also has a GPS which can be used to locate places. 

 When it comes to messaging, a smart phone will send messages and also emails. A 

smart phone can synchronize your personal and most likely your professional email 

account. Some smart phone can support multiple accounts depending on the make and 

model. 
 

Applications used by Tablets and Smartphones 

An app is a software application developed specifically for use on small, wireless 

computing devices, such as smartphones and tablets, rather than desktop or laptop computers. 

There are thousands of applications available in Google Play Store.  WhatsApp, UC Browser, 

Maps, YouTube, Google+, Drive, Facebook, etc. are some of the apps which user can download 

and install in the tablet or smartphone.  

 
Facebook 

Facebook is a popular free social networking website that allows registered users to 

create profiles, upload photos and video, send messages and keep in touch with friends, family 

and colleagues.  
 
UB browser 

 UC Browser is an application designed to browse the sites in mobile or smartphone. 
 
WhatsApp 

WhatsApp is a cross-platform messenger which allows the smartphone or tablet to pass 

the message in the form of text, image, video and audio instantly for free. 

 

 

 

 

http://www.businessdictionary.com/definition/mobile-phone.html
http://www.businessdictionary.com/definition/function.html
http://www.businessdictionary.com/definition/personal-computer-PC.html
http://www.businessdictionary.com/definition/provide.html
http://www.businessdictionary.com/definition/electronic-mail-email.html
http://www.businessdictionary.com/definition/internet.html
http://www.businessdictionary.com/definition/access.html
http://www.businessdictionary.com/definition/compact.html
http://www.businessdictionary.com/definition/standard.html
http://www.businessdictionary.com/definition/telephone.html
http://whatis.techtarget.com/definition/social-networking


 Venus Computers   Unit-7: Internet & Advanced Communication 

 

 198 

QUESTIONS AND ANSWERS 

I. Fill in the blanks 

1. Internet is a network of networks. 

2. Expansion of WWW is World Wide Web. 

3. Microsoft Internet Explorer is an Internet Browser. 

4. Facebook is a social networking site 

5. E-mail is an electronic mail sent from one computer to another. 

6. Receiver‘s e-mail address is entered in CC box. 

7. Transmission of a file from one computer to another is called Uploading. 

8. Downloading is receiving a file from a computer to the user‘s computer. 
9. Attachments are the additional object(s) or file(s) that is sent along with e-mail. 
 

II. Match the following  

1. Wifi   - File Transfer Protocol   ( 2 ) 

2. FTP  - Uniform Resource Locator  ( 4 ) 

3. HTTP  - Wireless Fidelity   ( 1 ) 

4. URL  - Transmission Control Protocol  ( 6 ) 

5. MIME  - Hyper Text Transmission Protocol ( 3 ) 

6. TCP  - Multipurpose Internet Mail Extension ( 5 ) 

 
V. Write answer in two or three lines 

1. What are the uses of Internet? 

2. What is an E-mail? 

3. What are the components of an E-mail? 

4. Define Portal. 

5. What is Browser? 

6. Define Search Engine. 

7. What is Social Networking? 

8. Define Wireless? 

9. What are the advantages of Tablet? 

 

VI. Write answer in brief 

1. Write about the different types of internet connections? 

2. Write the steps to creating and sending E-mail. 

3. What is uploading and downloading? 

4. What are the applications used by Tablet and Smartphone? 
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SYLLABUS – PRACTICAL 
 

1  Starting the Windows 
 Starting a program, running a program 
 Running multiple programs and switching between windows 
 Customizing the Task bar 
 Recycle bin, restoring the deleted files 

 
2  Creating and removing folders 

 Making the taskbar wider, arranging icons on the Desktop 
 Displaying and hiding the taskbar clock 
 Controlling the size of start menu options 
 Creating Shortcuts 

 
3  Installing a screen saver 

 Assigning a wallpaper to Desktop 
 Adding a program to the start menu  
 Adding a program shortcut in the Desktop 
 Customizing the mouse settings 

 
4  Expanding and collapsing a folder 

 Recognizing File types using icons 
 Running a program from explorer 
 Renaming a file or  folder 

 
5  Displaying the properties for a file or folder 

 Using cut and paste operations to move a file 
 Using copy of paste operations to copy a file 
 Moving and copying files with mouse 
 Searching a file or folder by suing search command 

 
6  Finding a file or folder, by name 

 Defragmenting the disk, using disk defragmenter 
 Controlling the speaker volume 
 Recording and saving an audio file 
 Connecting a printer to the PC 

 
7  Booting Linux, Maintaining user accounts 

 Creating folders, renaming folders and files 
 Copying, moving, deleting files 
 Taking backups and restoration of files 
 Practicing the commands like passwd, who, whoami, kill, write etc. 

 
8  Preparing a Govt. Order / Official Letter / Business Letter / Circular Letter 

 Covering formatting commands – font size and styles – bold, underline, upper 
case, superscript, subscript, indenting paragraphs, spacing between lines and 
characters, tab settings etc. 
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9  Preparing a news letter 
 To prepare a newsletter with borders, two columns text, header and footer and 

inserting a graphic image and page layout. 
 

10  Creating and using styles and templates 
 To create a style and apply that style in a document 
 To create a template for the styles created and assemble the styles for the 

template. 
 

11  Creating and editing the table 
 To create a table using table menu 
 To create a monthly calendar using cell editing operations like inserting, 

joining, deleting, splitting and merging cells. 
 To create a simple statement for math calculations viz. totaling the column. 

 
12  Creating numbered lists and bulleted lists 

 To create numbered list with different formats (with numbers, alphabets, 
roman letters) 

 To create a bulleted list with different bullet characters. 
 

13  Printing envelopes and mail merge. 
 To print envelopes with from addresses and to addresses 
 To use mail merge facility for sending a circular letter to many persons. 
 To use mail merge facility for printing mailing labels. 

 
14  Using the special features of word 

 To find and replace the text 
 To spell check and correct 
 To generate table of contents for a document 
 To prepare index for a document. 

 
15  Create an advertisement 

 Prepare a resume 
 Prepare a Corporate Circular letter inviting the share holders to attend the 

Annual Meeting. 
 

16  Using formulas and functions: 
 To prepare a worksheet showing the monthly sales of a company in different 

branch officers (Showing Total Sales, Average Sales). 
 Prepare a Statement for preparing Result of 10 students in 5 subjects (using 

formula to get Distinction, I, Class, II Class and Fail under Result column 
against each student). 
 

17  Operating on the sheets: 
 Finding, deleting and adding records, formatting columns, row height, merging, 

splitting columns etc. Connecting the worksheets and enter the data. 
 

18  Creating a Chart: 
 To create a chart for comparing the monthly sales of a company in different 

branch offices. 
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19  Using the data consolidate command: 

 To use the data consolidate command to calculate the total amount budgeted 
for all departments (wages, travel and entertainment, office supplies and so 
on) or to calculate the average amount budgeted for – say, department office 
expenses. 
 

20  Sorting Data, Filtering Data and creation of Pivot tables. 
 

21  Creating Student‘s address Database and then list the data on the screen in 
alphabetical order. 
 

22  Performing various queries. 
 

23  Generating in Access. 
 

24  Generating the Report from Database. 
 

25  Importing and exporting data. 
 

26  Creating a new Presentation based on a template – using Auto content wizard, 
design template and Plain blank presentation. 
 

27  Creating a Presentation with Slide Transition – Automatic and Manual with 
different effects. 
 

28  Creating a Presentation applying Custom Animation effects – 
 Applying multiple effects to the same object and changing to a different effect 

and removing effects. 
 

29  Creating and Printing handouts. 
 

30  Searching for a web site / application / text documents viewing and 
downloading. 
 

31  Create an E-mail account, Retrieving messages from inbox, replying, attaching 
files filtering and forwarding 
 

32  Operating on a Tablet / Smart Phone – browsing and practising on some 
important applications (UcBrowser, Skype) – operating on internet – creating 
and sending messages / mails using the applications like WhatsApp and 
WeChat etc.  – downloading text and media files and video conferencing using 
Skype. 

 

 


